Solid-State Memory 3D Camcorder

Operating Instructions
Before operating the unit, please read this manual thoroughly and retain it for future reference.

PMW-TD300

© 2011 Sony Corporation
Important Safety Instructions

- Read these instructions.
- Keep these instructions.
- Heed all warnings.
- Follow all instructions.
- Do not use this apparatus near water.
- Clean only with dry cloth.
- Do not block any ventilation openings. Install in accordance with the manufacturer's instructions.
- Do not install near any heat sources such as radiators, heat registers, stoves, or other apparatus (including amplifiers) that produce heat.
- Do not defeat the safety purpose of the polarized or grounding-type plug. A polarized plug has two blades with one wider than the other. A grounding-type plug has two blades and a third grounding prong. The wide blade or the third prong are provided for your safety. If the provided plug does not fit into your outlet, consult an electrician for replacement of the obsolete outlet.
- Protect the power cord from being walked on or pinched particularly at plugs, convenience receptacles, and the point where they exit from the apparatus.
- Only use attachments/accessories specified by the manufacturer.
- Use only with the cart, stand, tripod, bracket, or table specified by the manufacturer, or sold with the apparatus. When a cart is used, use caution when moving the cart/apparatus combination to avoid injury from tip-over.
- Unplug this apparatus during lightning storms or when unused for long periods of time.
- Refer all servicing to qualified service personnel. Servicing is required when the apparatus has been damaged in any way, such as power-supply cord or plug is damaged, liquid has been spilled or objects have fallen into the apparatus, the apparatus has been exposed to rain or moisture, does not operate normally, or has been dropped.

WARNING

To reduce the risk of fire or electric shock, do not expose this apparatus to rain or moisture.

To avoid electrical shock, do not open the cabinet. Refer servicing to qualified personnel only.

CAUTION

Danger of explosion if battery is incorrectly replaced. Replace only with the same or equivalent type recommended by the manufacturer. When you dispose of the battery, you must obey the law in the relative area or country.

When installing the installation space must be secured in consideration of the ventilation and service operation.

- Do not block the ventilation slots at the left side and right side panels, and vents of the fans.
- Leave a space around the unit for ventilation.
- Leave more than 40 cm of space in the rear of the unit to secure the operation area.

When the unit is installed on the desk or the like, leave at least 4 cm of space in the left and right sides. Leaving 40 cm or more of space above the unit is recommended for service operation.

CAUTION

The apparatus shall not be exposed to dripping or splashing. No objects filled with liquids, such as vases, shall be placed on the apparatus.

WARNING

Excessive sound pressure from earphones and headphones can cause hearing loss.
In order to use this product safely, avoid prolonged listening at excessive sound pressure levels.

Batteries shall not be exposed to excessive heat such as sunshine, fire or the like.

**For the customers in the U.S.A.**
This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference when the equipment is operated in a commercial environment. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instruction manual, may cause harmful interference to radio communications. Operation of this equipment in a residential area is likely to cause harmful interference in which case the user will be required to correct the interference at his own expense.

You are cautioned that any changes or modifications not expressly approved in this manual could void your authority to operate this equipment.

All interface cables used to connect peripherals must be shielded in order to comply with the limits for a digital device pursuant to Subpart B of Part 15 of FCC Rules.

This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) this device may not cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.

**For the customers in Canada**
This Class A digital apparatus complies with Canadian ICES-003.

**For the customers in Europe**
This product with the CE marking complies with the EMC Directive issued by the Commission of the European Community.

Compliance with this directive implies conformity to the following European standards:
- EN55103-1: Electromagnetic Interference (Emission)
- EN55103-2: Electromagnetic Susceptibility (Immunity)

This product is intended for use in the following Electromagnetic Environments: E1 (residential), E2 (commercial and light industrial), E3 (urban outdoors), E4 (controlled EMC environment, ex. TV studio).

The manufacturer of this product is Sony Corporation, 1-7-1 Konan, Minato-ku, Tokyo, Japan.
The Authorized Representative for EMC and product safety is Sony Deutschland GmbH, Hedelfinger Strasse 61, 70327 Stuttgart, Germany. For any service or guarantee matters please refer to the addresses given in separate service or guarantee documents.

**For the State of California, USA only**
Perchlorate Material - special handling may apply, See [www.dtsc.ca.gov/hazardouswaste/perchlorate]
Perchlorate Material : Lithium battery contains perchlorate.

**For the customers in Taiwan only**
廃電池請回收
# Table of Contents

Foreword .......................................................................................................................... 10
Before Use ....................................................................................................................... 10

## Chapter 1: Overview

Features ......................................................................................................................... 11
3D Images ....................................................................................................................... 13
Using the Software .......................................................................................................... 17
Reading the CD-ROM Manuals ...................................................................................... 17
Locations and Functions of Parts and Controls ............................................................... 18
  - Power Supply ........................................................................................................... 18
  - Accessory Attachments .......................................................................................... 19
  - Operating and Connectors Section .......................................................................... 20
  - Monochrome LCD Panel ......................................................................................... 31
  - Viewfinder ............................................................................................................. 32
Viewfinder Screen Display .............................................................................................. 33

## Chapter 2: Preparations

Preparing a Power Supply .............................................................................................. 37
  - Using a Battery Pack .............................................................................................. 37
  - Using AC Power ...................................................................................................... 38
Attaching the Viewfinder ............................................................................................... 38
  - Attaching the Supplied Viewfinder ....................................................................... 38
  - Adjusting the Viewfinder Position ......................................................................... 39
  - Adjusting the Viewfinder Angle ............................................................................. 39
  - Lifting Up the Viewfinder Barrel and Eyepiece .................................................... 39
  - Adjusting the Viewfinder Focus and Screen ......................................................... 41
  - Using the BKW-401 Viewfinder Rotation Bracket ................................................ 41
  - Attaching a CBK-VF01 Viewfinder ....................................................................... 42
  - Attaching a 5-inch Electronic Viewfinder ............................................................. 43
Setting the Area of Use .................................................................................................. 44
Setting the Date/Time of the Internal Clock .................................................................. 45
Preparing the Audio Input System .................................................................................. 45
  - Connecting a Microphone to the MIC IN Connector ............................................ 45
  - Connecting Microphones to the AUDIO IN Connectors ...................................... 46
Chapter 3: Adjustments and Settings

Setting the Video Format ................................................................. 51
  Changing the Video Format ......................................................... 52
Selecting 3D or 2D Mode ................................................................. 52
  Selecting 3D or 2D ................................................................. 52
Adjusting the Black Balance and the White Balance .................... 53
  Adjusting the Black Balance ......................................................... 53
  Adjusting the White Balance ......................................................... 54
Setting the Electronic Shutter .......................................................... 56
  Shutter Modes ............................................................................. 56
  Selecting the Shutter Mode and Shutter Speed ......................... 56
Adjusting the Iris ............................................................................. 58
  Changing the Adjustment Mode ...................................................... 58
  Adjusting the Iris using the IRIS Dial ........................................... 58
  Adjusting the Iris using Automatic Iris Adjustment .................. 58
  Changing the Reference Value for Automatic Iris Adjustment .... 58
Zooming ......................................................................................... 59
  Using the ZOOM Dial ................................................................. 59
  Using the Zoom Lever ............................................................... 59
Adjusting the Focus ........................................................................ 60
  Adjusting in MF Mode ............................................................... 60
  Adjusting in AF Mode ............................................................... 61
Adjusting the Convergence ............................................................... 61
  Adjusting using the CONVERGENCE Dial ............................... 61
  Adjusting using the AUTO CONVERGENCE Button ................. 62
  Adjusting using the Assignable Switches ................................. 62
Changing the Viewfinder Display .................................................... 62
Adjusting the Audio Level ............................................................... 63
  Manually Adjusting the Audio Levels of the Audio Inputs from the
    AUDIO IN CH-1/CH-2 Connectors ........................................... 63
  Manually Adjusting the Audio Level of the MIC IN Connector ... 63
  Recording Audio on Channels 3 and 4 ..................................... 64
### Setting the Time Data
- Setting the Timecode ................................................................. 65
- Setting the User Bits ...................................................................... 66
- Synchronizing the Timecode .......................................................... 66

### Checking Camcorder Settings and Status Information
(Status Screens) .............................................................................. 68

### Chapter 4: Shooting

#### Handling SxS Memory Cards ......................................................... 70
- About SxS Memory Cards ................................................................ 70
- Loading and Ejecting SxS Memory Cards ...................................... 71
- Selecting the SxS Memory Card to Use ......................................... 72
- Formatting (Initializing) SxS Memory Cards .................................. 73
- Checking the Remaining Recording Time ..................................... 73
- Restoring SxS Memory Cards ....................................................... 74

#### Basic Operations ............................................................................. 75
- Playing Recorded Clips ............................................................... 76
- Deleting Recorded Clips ............................................................... 77

#### Advanced Operations ................................................................ 77
- Recording Shot Marks ................................................................. 77
- Setting OK Marks ........................................................................ 77
- Starting to Record from Pre-stored Video (Picture Cache Function)
  (2D mode only) ........................................................................... 78
- Recording Time-lapse Video (Interval Rec Function) .................. 79
- Shooting Stop Motion Animations (Frame Rec Function) ............ 80
- Shooting with Slow & Quick Motion .......................................... 82
- Framing Shots with the Freeze Mix Function ............................... 83

#### Planning Metadata Operations ..................................................... 84
- Loading a Planning Metadata File into Camcorder’s
  Internal Memory ........................................................................ 84
- Defining Clip Names in Planning Metadata .................................. 85
- Defining Shot Mark Names in Planning Metadata ....................... 86

#### 3D Shooting Guide Function ......................................................... 87
- Displaying the Subject Distance Range ...................................... 87
- Displaying 3D Depth Warning .................................................... 87
- Displaying the Grid ..................................................................... 88
Chapter 5 : Clip Operations

Clip Playback ........................................................................................................... 89
   Thumbnail Screen ........................................................................................... 89
   Playing Clips ............................................................................................... 91
   Using Thumbnails to Search Inside Clips ...................................................... 92

Thumbnail Operations ....................................................................................... 93
   THUMBNAI Menu Configuration ................................................................... 93
   Basic THUMBNAI Menu Operations ............................................................ 94
   Changing the Thumbnail Screen Type ........................................................... 94
   Displaying Clip Properties .......................................................................... 95
   Adding and Deleting OK Marks .................................................................... 96
   Copying Clips ............................................................................................... 96
   Deleting Clips ............................................................................................... 97
   Displaying the Expand Thumbnail Screen .................................................. 98
   Displaying the Shot Mark Thumbnail Screen .............................................. 98
   Adding and Deleting Shot Marks ............................................................... 99
   Changing Clip Index Pictures ..................................................................... 99

Chapter 6 : Menu and Detailed Settings

Setup Menu Organization and Levels ................................................................. 100
   Setup Menu Organization ........................................................................... 100
   Setup Menu Levels .................................................................................... 100

Basic Setup Menu Operations .......................................................................... 101

Menu List .............................................................................................................. 104
   OPERATION Menu ....................................................................................... 104
   PAINT Menu ............................................................................................... 122
   MAINTENANCE Menu ............................................................................... 127
   FILE Menu .................................................................................................. 140

Assigning Functions to Assignable Switches ...................................................... 142
   Functions that can be Assigned to the ASSIGN. 0 Switch ......................... 142
   Functions that can be Assigned to the ASSIGN. 2 Switch ......................... 143
   Functions that can be Assigned to the ASSIGN. 1 and 3 Switches,
   the ASSIGNABLE 4 and 5 Switches, and the COLOR TEMP.
   Button ......................................................................................................... 143
   Functions that can be Assigned to the ASSIGN. 6 Switch ......................... 145
   Functions that can be Assigned to the RET Button ................................... 145

Assigning Functions to the Lens Dials ................................................................ 146
   Functions that can be Assigned to the Lens Dials ...................................... 146
Chapter 7: Saving and Loading User Setting Data

Saving and Loading Settings ................................................................. 147
  Saving Setting Data ........................................................................ 147
  Loading Setting Data .................................................................... 148
  Resetting a File after Changing Its Contents .................................. 148

Saving and Loading Scene Files ...................................................... 149
  Saving Scene Files ....................................................................... 149
  Loading Scene Files .................................................................... 149

Chapter 8: Connecting External Devices

Connecting External Monitors ............................................................... 151

Operating Clips with a Computer ..................................................... 153
  Using the ExpressCard Slot of a Computer .................................. 153
  USB Connection with a Computer ................................................ 153

Editing 3D Clips using MPES-3D01 ............................................... 155

Chapter 9: Maintenance

Testing the Camcorder ....................................................................... 156

Maintenance ..................................................................................... 156
  Cleaning the Viewfinder .............................................................. 156
  Note about the Battery Terminal .................................................. 156

Adjusting Left/Right Lens Errors ..................................................... 157
  Correcting at a Single Point ......................................................... 157
  Correcting at Multiple Points ....................................................... 157
  Adjusting the Flange Focal Length ................................................ 158

Operation Warnings .......................................................................... 159
  Error Indication .......................................................................... 159
  Warning Indication ...................................................................... 160

Appendix

Important Notes on Operation ......................................................... 166

Exchanging the Battery of the Internal Clock ................................. 168

Specifications .................................................................................. 169
  General ..................................................................................... 169
  Camera Block ............................................................................. 169
  Audio Block .............................................................................. 170
Foreword

Before Use

After purchasing the PMW-TD300 Solid-State Memory 3D Camcorder, before operating, it is necessary to set the area of use. (Unless this setting is made, the camcorder will not operate.)

For details of these settings, see “Setting the Area of Use” (page 44).

Note

Before attaching/removing optional components or accessories to/from the PMW-TD300 (referred to as “the camcorder”), be sure to turn the power of the camcorder off.

Viewing 3D Video

• Viewing 3D video shot using this camcorder on a 3D monitor can cause symptoms of discomfort, such as eye fatigue, tiredness, or nausea. It is recommended that you take regular rest breaks when watching 3D video. The duration and frequency of required rest breaks will vary from person to person, so each person must judge for themselves. If discomfort occurs, stop watching 3D video until the symptoms subside, and consult your doctor if necessary. Also, please follow the instructions provided with the software or the hardware connected to the camcorder. Furthermore, the sense of vision of young children (especially children less than 6 years of age) is still in a development stage. Before allowing young children to view 3D video, please consult a pediatrician or ophthalmologist. A responsible adult should always supervise any children to observe the above-mentioned precautions.

• The perception of 3D video varies depending on the individual.
Chapter 1  Overview

Features

The camcorder is a shoulder-mount HD memory camcorder featuring independent Left/Right, 1/2-type (diagonal 8 mm (11/32 inches)), full-HD (1920 × 1080) “Exmor” 3CMOS image sensors.

Dual, fixed lens system

Employs a dual, fixed-type lens that requires no Left/Right-lens optical axis, angle of view, or image quality adjustments, so you can start shooting straight away.

Convergence control

The all-important convergence point can be adjusted between approximately 1.2 m (lens surface reference) and infinity for 3D image representation. When shooting, you can align the convergence point with the focus position using one-button control. Also, the inter-axial distance is a fixed 45 mm, allowing wide-scope 3D images to be captured.

Unique triple dial operation

The camcorder employs a unique triple dial for adjusting zoom, iris, and convergence, and which synchronizes the operation of both the left and right lens. The function assigned to each dial can also be customized.

3D shooting guide function

This displays a guide in the viewfinder of the appropriate distance to the subject in order to avoid viewer discomfort due to the parallax between the left and right lenses becoming too large. It can also display a warning if the parallax at the subject becomes too large. These allow the shooting of more natural 3D images that can be viewed comfortably.

Also, you can view 3D images in the viewfinder using the naked eye, and the camcorder supports various display formats for checking anaglyph and other parallax.

3D image output to external devices

It is equipped with dual HD-SDI outputs, and can output individual Left/Right image signals. Furthermore, one output also supports 3G-SDI for output of both left and right image signals paired together. 3D images can also be output in side-by-side format from HDMI and HD-SDI connectors.

SxS memory cards as recording media

The camcorder employs the high-performance SxS memory cards used in XDCAM EX-series equipment as the storage media. The left and right images are synchronized and recorded onto two SxS memory cards. There are four memory card slots, two each on both the left and right, allowing recording across two memory cards. Approximately 6 hours of 3D images can be recorded when loaded with four 64 GB SxS memory cards.

Light weight, low power consumption

Design features such as CMOS image sensors, custom video signal processing ICs, and SxS memory card recording enable operation at power consumption of 32 W or less. The camcorder’s light weight (5.5 kg (12 lb 2 oz)) and low center of gravity make it easy to carry on the shoulder while ensuring superior stability.

HD recording using the “MPEG-2 Long GOP” codec

The camcorder records 1920 × 1080, 1440 × 1080, and 1280 × 720 HD images using “MPEG-2 Long GOP” codec compression. It offers a choice of bit rates: either 35 Mbps (HQ mode) or 25 Mbps (SP mode). By utilizing an efficient compression format, the camcorder records high-quality HD images for long recording time of approx. 200 minutes at
35 Mbps (HQ mode) or approx. 280 minutes at 25 Mbps (SP mode) on a single 64-GB SxS memory card.

**Multi-format support**

The camcorder supports interlace format recording (1080/59.94i or 1080/50i), progressive format recording (1080/29.97P, 1080/23.98P, 720/59.94P, 720/29.97P, 720/23.98P, or 1080/25P, 720/50P, 720/25P), thus offering the flexibility needed for worldwide HD recording. (For 23.98P, native frequency recording is possible.)

It also can output HD signals down-converted to SD.

**A variety of functions for improved performance under various shooting conditions**

- Optical ND filters and electrical CC filters
- Hyper gamma
- Slow shutter function
- Frame Recording function
- Time lapse function (interval recording)
- Slow & quick motion function
- Freeze mix function
- Focus magnification function
- Assignable switches
- 3.5-inch high-resolution color LCD viewfinder
- Remote control
- 2D shooting mode

**Wireless LAN support**

You can connect this camcorder to a computer over a wireless LAN (Wi-Fi connection) by connecting the optional CBK-WA01 Wi-Fi Adapter to the external device connector. A Wi-Fi connection allows you to transfer planning metadata from a computer to this camcorder, and to transfer clips and other files from this camcorder to a computer. You can also use the Live Logging function to transfer proxy AV data to a computer as you shoot, for logging of the video currently being shot.

---

**Inherits unique features of XDCAM EX series**

The camcorder inherits the workflow features of the XDCAM EX series, including thumbnail display and metadata management, and improves them by introducing an improved man-machine interface.

**XDCAM EX web sites**

For information on XDCAM EX, visit the following web sites:

- **United States**
  http://www.sony.com/xdcamex

- **Canada**
  http://www.sony.ca/xdcamex

- **Europe, Middle East, Africa, and Russia**
  http://www.sonybiz.net/xdcamex

- **Latin America**
  http://www.sonypro-latin.com/xdcamex

- **Australia**

- **Asia (except Korea, China, and Japan)**
  http://pro.sony-asia.com

- **Korea**
  http://bp.sony.co.kr/xdcamex

- **China**
  http://pro.sony.com.cn/minisite/XDCAMEX

- **Japan**
  http://www.sony.co.jp/XDCAMEX
When people look at objects, the left eye and right eye view the object at a slightly different angle, and hence the images projected in the left and right eye are different. The difference in images seen by the left and right eye is called parallax. By composing a picture in the head from the left and right eye images, people gain an awareness of depth and stereoscopic effect.

3D images utilize this technique to display subjects in three dimensions. When shooting 3D images, lenses substitute for the left eye and right eye to shoot subjects at a slightly different angle. During playback, the right lens image is viewed by the right eye only and likewise for the left lens image, and hence a three-dimensional subject is recognized in the minds of the viewers.
Convergence Point

When shooting using individual left and right lenses, the point where the optical axes of the left lens and right lens intersect is called the convergence point. The difference (parallax) between left and right images for subjects at the convergence point is zero. During playback, subjects at the convergence point appear to viewers to be positioned right on the screen. Subjects in front of the convergence point appear to pop out of the screen, while subjects behind the convergence point appear to recede into the distance. Accordingly, it is essential to set the convergence point appropriately when shooting in order to effectively create the popping out and receding sensation during playback.

The camcorder convergence point can be adjusted in the range 1.2 m (4 ft) to \( \infty \) (infinity). You can set the convergence point to the focus position using a single button push, store multiple convergence points, and recall convergence points when shooting. (see page 61)

![Diagram showing convergence point and parallax](image)

Comfortable 3D Images

For subjects displaced from the convergence point, the parallax becomes larger as the distance from the convergence point becomes larger. In other words, the closer the subject the more it will appear to pop out, and the further away the more it will appear to recede into the distance. If the parallax becomes too large, it becomes difficult for the viewer to combine the left and right images, and not only will the 3D image appear unnatural but it may also cause eye fatigue and discomfort while viewing. Therefore, in order to shoot comfortable 3D images for the viewer, it is essential to keep the size of parallax within an appropriate range.
Parallax Guidelines

To shoot comfortable 3D images, we recommend the following points as parallax guidelines.

**Parallax angle should be less than 1°**

The parallax angle ($\theta$) is obtained by subtracting the angle ($\alpha$ or $\beta$) between the left/right lenses at the subject position from the angle ($\gamma$) between the left/right lenses at the convergence point, where the optical axes of the left/right lenses intersect. The parallax angle is negative for subjects that appear to pop out of the screen, and positive for subjects that appear to recede into the distance. The parallax angle for comfortable 3D images is less than ±1°.

Since measuring the parallax angle is difficult when shooting, it is common to display an overlay of the left and right images on a screen and check the size of the image mismatch (amount of parallax). When images are viewed from a distance approximately 3 times the height of the screen, the amount of parallax on the screen due to a parallax angle of 1° is roughly 3% of the screen width. When shooting, this guideline translates into keeping the amount of parallax within 3% of the viewfinder screen width in order to produce natural stereoscopic images.

**Amount of parallax on the screen should not exceed space between eyes**

When the amount of parallax on the screen exceeds the distance between the eyes of the viewer, it becomes impossible to form the left and right images into a single image, making the viewer feel discomfort. Since the space between the eyes is an individual trait, a rule of thumb is to keep amount of parallax on the screen to less than 5 cm (2 inches). If the screen is small (77-inch type or smaller), maintaining a parallax angle of less than 1° ensures that the amount of parallax cannot exceed 5 cm (2 inches). However, if the screen is large (77-inch type or larger), the amount of parallax on the screen becomes larger as the screen becomes larger, and it becomes easy to exceed the 5 cm (2 inches) guideline. Consequently, it is important to consider the screen size when shooting.
The camcorder displays the subject distance from the camera in the viewfinder as an aid to keeping the parallax within an appropriate range. The viewfinder can also display a colored outline of the subject as a warning when the parallax is large and natural stereoscopic vision of the subject is difficult. You can set the amount of parallax as a percentage of the screen width (near field, far field) or you can specify the maximum screen size as the reference for displaying the guide functions. (see page 87)
The supplied CD-ROM (labeled “Utility Software for XDCAM”) contains application and device driver software required to access to SxS memory cards from a computer and to manage material shot with the camcorder. Information about how to install the software is provided in PDF format.

**Note**
You must install the SxS device driver on your computer if your computer is equipped with an ExpressCard slot and you want to use it to access SxS memory cards.

### Preparations
The following program must be installed on your computer in order to read the documents contained on the CD-ROM.
Adobe Reader Version 6.0 or higher

**Memo**
If Adobe Reader is not installed, you can download it from the following URL:
http://www.adobe.com/
Adobe and Adobe Reader are trademarks of Adobe Systems Incorporated in the United States and/or other countries.

### To read the documents
Do the following:

1. **Insert the CD-ROM in your CD-ROM drive.**
   A cover page appears automatically in your browser.
   If it does not appear automatically in the browser, double-click on the index.htm file on the CD-ROM.

2. **Select and click on the manual that you wish to read.**
   This opens the PDF file.

**Memo**
The files may not be displayed properly, depending on the version of Adobe Reader. In such a case, install the latest version you can download from the URL mentioned in “Preparations” above.

**Note**
If you have lost or damaged the CD-ROM, you can purchase a new one to replace it. Contact a Sony service representative.
## Locations and Functions of Parts and Controls

### Power Supply

<table>
<thead>
<tr>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
</tr>
</thead>
</table>

#### 1 LIGHT switch
Determines how a video light connected to the LIGHT connector *(see page 19)* is turned on and off.
**AUTO:** When the POWER switch of the video light is in the on position, the video light is turned on automatically while the camcorder is recording.
**MANUAL:** You can turn the video light on or off manually, using its own switch.

**Note**
When the camcorder is set for recording in Picture Cache mode, it is not possible to turn on the light before operation to start recording is carried out (or while data is being stored in memory).

#### 2 POWER switch
Turns the main power supply on and off.

#### 3 DC IN (DC power input) connector
(XLR type, 4-pin, male)
To operate the camcorder from an AC power supply, connect an optional DC power cord to this terminal and then connect the cord to the DC output terminal of the BC-L70, BC-L160, or another battery charger.

#### 4 DC OUT 12 V (DC power output)
connector (4-pin, female)
Supplies power for an optional WRR-860C/861/862 UHF Synthesized Diversity Tuner (maximum 0.5 A).

**Note**
Do not connect any equipment other than the UHF synthesized diversity tuner.

#### 5 Battery attachment shoe
Attach a BP-GL95A/L80S/L60S Battery Pack. Alternatively, you can attach an AC-DN2B/DN10 AC Adaptor to operate the camcorder on AC power supply.

For details, see “Preparing a Power Supply” *(page 37).*

For details, see “Attaching a UHF Portable Tuner (for a UHF Wireless Microphone System)” *(page 47).*

**Note**
For your safety, and to ensure proper operation of the camcorder, Sony recommends the use of the following battery packs: BP-GL95A, BP-L60S, and BP-L80S.
1 Shoulder strap fitting
Attach the supplied shoulder strap (see page 49).

2 Accessory fitting shoe
Attach an optional accessory such as a video light (see page 49).

3 Viewfinder front-to-back positioning lever
To adjust the viewfinder position in the front-to-back direction, loosen this lever and the LOCK knob. After adjustment, retighten this lever and the LOCK knob.

4 Viewfinder left-to-right positioning ring
Loosen this ring to adjust the left-to-right position of the viewfinder (see page 39).

5 Viewfinder fitting shoe
Attach the viewfinder.

6 VF (viewfinder) connector (26-pin, rectangular)
Connect the cable of the supplied viewfinder or optional CBK-VF01 viewfinder.

7 VF (viewfinder) connector (20-pin, round)
Connect the cable of the optional DXF-series viewfinder.

8 Viewfinder front-to-back positioning knob (LOCK knob)
Loosen this knob to adjust the front-to-back position of the viewfinder (see page 39).

9 Fitting for optional microphone holder
Fit an optional CAC-12 Microphone Holder (see page 46).

10 Shoulder pad
Raise the shoulder pad fixing lever to adjust the position in the front-to-rear direction. Adjust the position for maximum convenience when operating the camcorder on your shoulder (see page 50).

11 LIGHT (video light) connector (2-pin, female)
A video light with a maximum power consumption of 50 W, such as the Anton Bauer Ultralight 2 or equivalent can be connected (see page 49).

12 MIC IN (microphone input) (+48 V) connector (XLR type, 5-pin, female)
Connect a stereo microphone to this connector. The power (+48 V) is supplied via this connector.

13 Tripod mount
When using the camcorder on a tripod, attach the tripod adaptor (optional).
**VTR button**
Use this to start and stop recording. Press once to start recording, then press once more to stop.

**RET (return video) button**
You can use this as an assignable switch (see page 145).
Use this to check the video when Lens RET is assigned to this button (factory default setting). If you press this during recording pause, the last few seconds recorded appear on the viewfinder screen (recording review) (see page 75).
Pressing this button (single click) during recording or playback records a Shot Mark 1 mark, and double-clicking records a Shot Mark 2 mark (see page 77).

**EXPAND FOCUS button**
When the viewfinder display setting is L, R, or 3D, the displayed image expands, making focusing easier (Expand Focus function).

**Zoom lever**
Press the W end for wide-angle and the T end for telephoto.
Press the lever harder for a faster zoom action.

**IRIS switch**
AUTO: The iris is adjusted automatically.
MANU (manual): Adjust the iris with the IRIS dial.

**PUSH AUTO button**
When the IRIS switch is in the MANU position, press this button for an instantaneous auto adjustment. The iris is automatically adjusted while the button is held down.

**REMOTE FOCUS connector**
Connects to an optional focus demand for focus remote control operation.

**REMOTE ZOOM connector**
Connects to an optional zoom demand for zoom remote control operation.

**REMOTE CONVERGENCE connector**
Connects to an optional convergence demand for convergence remote control operation.
locations and functions of parts and controls

1 AUTO CONVERGENCE button
Press this button to set the convergence distance to the current focus distance (see page 61).

2 CONVERGENCE dial
Turn this dial to adjust the convergence distance. Turn the dial clockwise to move the convergence point closer, and counterclockwise to move the convergence point further away (factory default setting).
You can set the direction of rotation of the dial using OPERATION >Dial Operation >Conv. Clockwise in the setup menu.
You can change the function assigned to the dial using OPERATION >Lens Dial >Inner in the setup menu.

3 FOCUS dial
Turn this dial to adjust the focus. Turn the dial clockwise to focus on closer subjects, and counterclockwise to focus on distant subjects (factory default setting).
You can set the direction of rotation of the dial using OPERATION >Dial Operation >Focus Clockwise in the setup menu.
You can change the function assigned to the dial using OPERATION >Lens Dial >Mid in the setup menu.

4 ZOOM dial
Turn this dial to adjust the zoom. Turn the dial clockwise to zoom out for wide-angle shots, and counterclockwise to zoom in for long-distance shots (factory default setting).
You can set the direction or rotation of the dial using OPERATION >Dial Operation >Zoom Clockwise in the setup menu.
You can change the function assigned to the dial using OPERATION >Lens Dial >Outer in the setup menu.

5 ASSIGN. (assignable) 6 switch
You can assign a function to this switch using OPERATION >Assignable SW in the setup menu (see page 142). The grid function is assigned to this switch by factory default setting.

6 VF DISPLAY SELECT switch
Switches the image displayed in the viewfinder.
L: Displays the left lens image, in color.
R: Displays the right lens image, in color.
L+R: Displays an overlay of the left lens image and the right lens image, in color, by calculating the average for each pixel.
L-R: Displays the image obtained by subtracting the right lens image from the left lens image, in color.
3D: Displays a 3D image, in color.
Anaglyph: Displays an anaglyph. 3D can be displayed in the supplied viewfinder only. Only the left or right image can be displayed in DXF series viewfinders.

7 SHIFT button
Use this button in combination with other buttons.

8 IRIS dial
For manual iris adjustment, set the IRIS switch to the MANU (manual) position, then turn this dial. Turn the dial clockwise to open the iris aperture, and counterclockwise to close the iris aperture (factory default setting).
You can set the direction of rotation of the dial using OPERATION >Dial Operation >Iris Clockwise in the setup menu.

9 ND SELECT (ND filter) switch
Switches between four ND filters built into this camcorder.
When this selector is used, the new setting appears on the viewfinder screen for about three seconds.

<table>
<thead>
<tr>
<th>FILTER selector setting</th>
<th>ND filter</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>CLEAR</td>
</tr>
<tr>
<td>2</td>
<td>1/4 ND (attenuates light to approximately 1/4)</td>
</tr>
<tr>
<td>3</td>
<td>1/16 ND (attenuates light to approximately 1/16)</td>
</tr>
<tr>
<td>4</td>
<td>1/64 ND (attenuates light to approximately 1/64)</td>
</tr>
</tbody>
</table>

You can change a MAINTENANCE menu setting so that different white balance settings can be stored for different FILTER selector positions. This allows you to automatically obtain optimum white balance for the current shooting conditions in linkage with the filter selection.

For details, see “Adjusting the White Balance” (page 54).

10 FOCUS switch

AUTO: The auto focus function is constantly active. Even with the switch in the AUTO position, you can manually adjust the focus by operating the FOCUS dial.

MANU (manual): The manual mode allows focusing adjustment with the FOCUS dial. In manual mode, auto focus adjustment is also possible, by pressing the PUSH AF button.

11 PUSH AF (auto focus) button

When the focus adjustment is in the manual mode, by pressing this button you can use the auto focus for an instantaneous adjustment to the subject. When the button is pressed, the auto focus operates until the image is in focus, then disengages. Even when the FOCUS switch is set to AUTO, by pressing this button, you can restart the auto focus.

Notes on auto focus

- In the following cases, it may be difficult to focus on the subject. If this does happen, use manual focusing.
  - If the subject has no contrast
  - If the subject is moving rapidly
  - When shooting point light sources, under street lighting or at night
  - When there are very bright objects close to the subject
  - When shooting through a glass window
  - If there are a number of objects within the screen at close and far range, the focus may not be on the intended subject. In this case, with the subject on which you want to focus in the center of the screen, press the PUSH AF button.
  - After focusing with the PUSH AF button, if you operate the zoom or adjust the iris, the depth of field may become shallower, losing crisp focus. In such cases, press the PUSH AF button once more.
  - If you focus at wide-angle then zoom to telephoto, the subject may no longer be in focus.
  - It may take time until the image is in focus while using the slow shutter mode.

Note on zoom speed

Depending on the shooting distance, the zoom speed may fall as the lens approaches the telephoto end.

REC START (recording start) button

Press to start recording. Press it again to stop recording. The effect is the same as that of the REC button.

2 SHUTTER selector

Set to ON to use the electronic shutter. Push to SELECT to switch the shutter speed or shutter mode setting. When this switch is operated, the
new setting appears on the viewfinder screen for about three seconds.

For details, see “Setting the Electronic Shutter” (page 56).

3 **MENU knob**
Changes the item selection or a setting within the menu (see page 101).

4 **AUTO W/B BAL (automatic white/black balance adjustment) switch**
Activates the automatic white/black balance adjustment functions.

**WHITE:** Adjust the white balance automatically.
If the WHITE BAL switch (see page 24) is set to A or B, the white balance setting is stored in the corresponding memory. If the WHITE BAL switch is set to PRST, the automatic white balance adjustment function does not operate.

**BLACK:** Adjust the black set and black balance automatically.
You can use the AUTO W/B BAL switch even when the ATW (Auto Tracing White Balance) function is operating.
If you push the switch to the WHITE side once more during the automatic white balance adjustment, the adjustment is cancelled and the white balance setting returns to the original setting.
If you push the switch to the BLACK side once more during the automatic black balance adjustment, the adjustment is cancelled and the black balance setting returns to the original setting.

5 **MIC (microphone) LEVEL control**
Adjusts the input level of audio channels 1, 2, 3 and 4 (see page 63).

---

1 **ASSIGN. (assignable) 1/2/3 switches**
You can assign the desired functions to these switches on OPERATION >Assignable SW in the setup menu (see page 142).
EZ Mode is assigned to the ASSIGN. 1 switch, and Off is assigned to the ASSIGN. 2/3 switches as the factory default setting.
The ASSIGN.1/3 switches are provided with an indicator to show whether a function is assigned to the switch (ON) or not (OFF).

2 **COLOR TEMP. (color temperature) button**
Press to light the button and change the color temperature for shooting (factory default setting).
You can use this as an assignable switch (see page 142).
3 ALARM (alarm tone volume adjustment) knob
Controls the volume of the warning tone that is output via the built-in speaker or optional earphones. When the knob is turned to the minimum position, no sound can be heard. However, if MAINTENANCE > Audio > Min Alarm Volume in the setup menu is set to [Set], the alarm tone is audible even when this volume control is at the minimum position.

4 MONITOR (monitor volume adjustment) knob
Controls the volume of the sound other than the warning tone that is output via the built-in speaker or earphones. When the knob is turned to the minimum position, no sound can be heard.

5 MONITOR (audio monitor selection) switches
By means of combinations of the two switches, you can select audio that you want to hear through the built-in speaker or earphones.

Position of down-side switch: CH-1/2

<table>
<thead>
<tr>
<th>Position of up-side switch</th>
<th>Audio output</th>
</tr>
</thead>
<tbody>
<tr>
<td>CH-1/CH-3</td>
<td>Channel 1 audio</td>
</tr>
<tr>
<td>MIX</td>
<td>Channels 1 and 2 mixed audio (stereo) a)</td>
</tr>
<tr>
<td>CH-2/CH-4</td>
<td>Channel 2 audio</td>
</tr>
</tbody>
</table>

Position of down-side switch: CH-3/4

<table>
<thead>
<tr>
<th>Position of up-side switch</th>
<th>Audio output</th>
</tr>
</thead>
<tbody>
<tr>
<td>CH-1/CH-3</td>
<td>Channel 3 audio</td>
</tr>
<tr>
<td>MIX</td>
<td>Channels 3 and 4 mixed audio (stereo) a)</td>
</tr>
<tr>
<td>CH-2/CH-4</td>
<td>Channel 4 audio</td>
</tr>
</tbody>
</table>

a) By connecting stereo headphones to the EARPHONE jack, you can hear the audio in stereo. (Under MAINTENANCE > Audio in the setup menu, Headphone Out must be set to STEREO.)

6 ASSIGN. (assignable) 0 switch
You can assign the desired function to this switch on OPERATION > Assignable SW in the setup menu (see page 143).
Off is assigned to this switch when the camcorder is shipped from the factory. This is a momentary type switch. Each press of the switch turns the function assigned to this switch on or off.

7 GAIN selector
Switches the gain of the video amplifier to match the lighting conditions during shooting. The gains corresponding to the L, M, and H settings can be selected on OPERATION > Gain Switch in the setup menu (see page 115). (The factory settings are L=0 dB, M=6 dB, and H=12 dB.)
When this switch is adjusted, the new setting appears on the viewfinder screen for about three seconds.

8 OUTPUT/DCC (output signal/dynamic contrast control) switch
Switches the video signal output from the camera module, between the following two.
BARS: Output the color bar signal.
CAM: Output the video signal being shot. When this is selected, you can switch DCC 1) on and off.

1) DCC (Dynamic Contrast Control): Against a very bright background with the iris opening adjusted to the subject, objects in the background will be lost in the glare. The DCC function will suppress the high intensity and restore much of the lost detail and is particularly effective in the following cases.
• Shooting people in the shade on a sunny day
• Shooting a subject indoors, against a background through a window
• Any high contrast scene

9 WHITE BAL (white balance memory) switch
Controls adjustment of the white balance.
PRST: Adjust the color temperature to the preset value (the factory default setting: 3200K). Use this setting when you have no time to adjust the white balance.
A or B: Recall the white balance adjustment settings already stored in A or B. Push the AUTO W/B BAL switch (see page 23) on the WHITE side, to automatically adjust the white balance, and save the adjustment settings in memory A or memory B.
B (ATW \(^1\)): When this switch is set to B and OPERATION >White Setting >White Switch<B> is set to [ATW] in the setup menu, ATW is activated. You can use the AUTO W/B BAL switch even when ATW is in use. When this switch is adjusted, the new setting appears on the viewfinder screen for about three seconds.

1) ATW (Auto Tracing White Balance): The white balance of the picture being shot is adjusted automatically for varying lighting conditions.

10 MENU ON/OFF switch
To use this switch, open the cover. This switch is used to display the menu on the viewfinder screen or the test signal screen. Each time the switch is pushed down, the menu screen is turned on and off. The function of this switch is the same as that of the MENU button in the thumbnail screen operations section.

11 STATUS ON/SEL/OFF (menu display on/page selection/display off) switch

MENU CANCEL/PRST (preset) / ESCAPE switch
When the menu is not displayed, this switch functions as the STATUS ON/SEL/OFF switch. When the menu is displayed, the switch functions as the MENU CANCEL/PRST/ESCAPE switch. (To use the MENU CANCEL/PRST/ESCAPE switch, open the cover.)

Use the STATUS ON/SEL/OFF switch in the following way.

ON/SEL: Each time this switch is pushed upward, a window to confirm the menu settings and status of the camcorder appears on the viewfinder screen (see page 68). The window consists of five pages, which are switched each time the switch is pushed upward. Each page is displayed for about 10 seconds.

OFF: To clear the page immediately after display, push this switch down to the OFF position.

Use the MENU CANCEL/PRST/ESCAPE in the following way.

CANCEL/PRST: Pushing this switch up to this position after a setting is changed in the setup menu displays the message to confirm whether the previous settings are cancelled. Pushing this switch up to this position again cancels the previous settings. Pushing this switch up to this position before a setting is changed in the setup menu or after a setting change is cancelled in the setup menu displays the message to confirm whether the setting is reset to the initial value. Pushing this switch up to this position again resets the settings to the initial value.

ESCAPE: Use this switch when the menu page, which has a hierarchical structure, is opened. Each time the switch is pushed to this position, the page returns to one stage higher in the hierarchy.

12 Cover
Open this cover to use the MENU ON/OFF switch or the MENU CANCEL/PRST/ESCAPE switch.
Right side (near the rear)

1. **Built-in speaker**
The speaker can be used to monitor E-E 1) sound during recording, and playback sound during playback. The speaker also sounds alarms to reinforce visual warnings (see page 159). If you connect earphones to the EARPHONE jack, the speaker output is suppressed automatically.

1) E-E: Abbreviation of “Electric-to-Electric”. In E-E mode, video and audio signals input to the camcorder are output after passing through internal electric circuits only. This can be used to check input signals.

2. **Monochrome LCD panel**
Displays remaining battery capacity, remaining media capacity, audio levels, time data, and so on (see page 31).

3. **WARNING indicator**
Lights up or flashes when an abnormality occurs (see page 159).

4. **ACCESS lamp**
Lights up in blue when data is written to or read from the recording media.

5. **Protection cover of the audio control section**
Open to access the audio control section (see page 27).

6. **Protection cover of the thumbnail screen operations section**
Open to access the thumbnail screen operations section (see page 27).

7. **F REV (fast reverse) button and indicator**
This plays back at high speed in the reverse direction. The playback speed changes in the order ×4 → ×15 → ×24 with each press of the button. The indicator lights during high-speed playback in the reverse direction.

8. **PLAY/PAUSE button and indicator**
Press this button to view playback video images using the viewfinder screen. The indicator lights during playback. Press this button again during playback to pause, outputting a still image. At this time, the indicator flashes at a rate of once per second. Pressing the F REV or F FWD button during playback or pause starts high-speed playback in the forward or reverse direction.

9. **F FWD (fast forward) button and indicator**
This plays back at high speed in the forward direction. The playback speed changes in the order ×4 → ×15 → ×24 with each press of the button. The indicator lights during high-speed playback in the forward direction.

10. **PREV button**
This jumps to the first frame of the current clip. If you press this together with the F REV button, the jump is to the first frame of the first recorded clip on the recording media. If you press this button twice in rapid succession, the jump is to the first frame of the last preceding clip (or the first frame of the current clip when no preceding clips exist).
STOP button
Press this button to stop playback.

NEXT button
This jumps to the first frame of the next clip.
If you press this together with the F FWD button, the jump is to the first frame of the last recorded clip on the recording media.

EXPAND (expand function) button
If you press this button when the thumbnail screen is displayed, the duration of the selected clip is divided into 12, and the first frame of each of the divisions is shown in a further thumbnail display (expand thumbnail screen).
For details about the expand thumbnail screen, see page 98.

HOLD (display hold) button
Pressing this button instantly freezes the time data displayed in the monochrome LCD panel. (The timecode generator continues running.) Pressing this button again releases the hold.
For details of the counter display, see page 31.

RESET/RETURN button
Resets the value shown in the time counter display in the monochrome LCD panel. According to the settings of the PRESET/REGEN/CLOCK switch (see page 28) and the F-RUN/SET/R-RUN switch (see page 28), this button resets the display as follows.

<table>
<thead>
<tr>
<th>Settings of switches</th>
<th>To reset</th>
</tr>
</thead>
<tbody>
<tr>
<td>DISPLAY switch:</td>
<td>Counter to 0:00:00:00</td>
</tr>
<tr>
<td>COUNTER</td>
<td></td>
</tr>
<tr>
<td>DISPLAY switch:</td>
<td>Timecode to 00:00:00:00</td>
</tr>
<tr>
<td>TC</td>
<td></td>
</tr>
<tr>
<td>PRESET/REGEN/CLOCK switch:</td>
<td>PRESET</td>
</tr>
<tr>
<td>F-RUN/SET/R-RUN switch:</td>
<td>SET</td>
</tr>
<tr>
<td>DISPLAY switch:</td>
<td>User bits data (^{a1}) to 00 00 00 00</td>
</tr>
<tr>
<td>U-BIT</td>
<td></td>
</tr>
<tr>
<td>PRESET/REGEN/CLOCK switch:</td>
<td>PRESET</td>
</tr>
<tr>
<td>F-RUN/SET/R-RUN switch:</td>
<td>SET</td>
</tr>
</tbody>
</table>

\(^{a1}\) Of the timecode bits for every frame recorded on the media, those bits which can be used to record useful information for the user such as scene number, shooting place, etc.

For details, see “Setting the Time Data” (page 65).

This button returns to the previous screen when pressed during thumbnail screen display, expand thumbnail screen display, or shot mark thumbnail screen display.

DISPLAY switch
This cycles the data displayed in the time counter display in the monochrome LCD panel through the sequence COUNTER, TC, and U-BIT (see page 31).
COUNTER: Display the elapsed recording/playback time (hours, minutes, seconds, frames).
TC: Display timecode.
U-BIT: Display user bits data.

BACKLIGHT button
Turns the backlight of the monochrome LCD on and off. The backlight of the monochrome LCD panel will be turned on when the camcorder is powered on for the first time after shipped from the factory.

Thumbnail screen operations section and audio control section

THUMBNAIL indicator
This lights when thumbnail screen is displayed.

THUMBNAIL button
Press this button to display the thumbnail screen (see page 89) and to carry out a thumbnail operation.
Press once more to return to the original display.
SET (set) button and arrow buttons
Use these buttons to make timecode and user bit settings, and for thumbnail screen operations (see page 94).
When the menu is displayed, press this button to select an item or to confirm the setting change.

MENU button
Each press of this button turns the setup menu display on and off.
The function of this button is the same as that of the MENU ON/OFF switch.

F-RUN/SET/R-RUN (free run/set/recording run) switch
Selects the operating mode of the internal timecode generator. The operating mode is set as explained below, depending on the position of the switch.
F-RUN: Timecode keeps advancing, regardless of whether the camcorder is recording. Use this setting when synchronizing the timecode with external timecode.
SET: Sets the timecode or user bits.
R-RUN: Timecode advances only during recording. Use this setting to have a consecutive timecode on the recording media.

LEVEL CH1/CH2/CH3/CH4 (audio channel 1/2/3/4 recording level) knobs
Adjust the audio levels to be recorded on channels 1, 2, 3, and 4 when the AUDIO SELECT CH1/CH2 and AUDIO SELECT CH 3-4 switches are set to MANUAL.

AUDIO SELECT CH 3-4 (audio channel 3/4 adjustment method selection) switch
Select the audio level adjustment method for each of audio channels 3 and 4.
AUTO: Automatic adjustment
MANUAL: Manual adjustment

ESSENCE MARK button
By pressing this button when the thumbnail display of a clip is on the screen, you can view the following thumbnail display of the shot-marked frames of that clip, depending on the item selected in a list displayed on the screen.
All: Thumbnail display of all frames marked with essence marks.
Shot Mark1: Thumbnail display of the frames marked with Shot Mark 1.
Shot Mark2: Thumbnail display of the frames marked with Shot Mark 2.
You can also select Shot Mark 0 and Shot Mark 3 to Shot Mark 9.
If you have recorded clips by using planning metadata that defined names for Shot Mark 0 to Shot Mark 9, the defined names are displayed instead of the above item names in the list.

SHIFT button
Use this in combination with other buttons.

PRESET/REGEN (regeneration)/CLOCK switch
Selects the type of timecode to record.
PRESET: Record new timecode on the media.
REGEN: Record timecode continuous with the existing timecode recorded on the media. Regardless of the setting of the F-RUN/SET/R-RUN switch, the camcorder operates in R-RUN mode.
CLOCK: Record timecode synchronized to the internal clock. Regardless of the setting of the F-RUN/SET/R-RUN switch, the camcorder operates in F-RUN mode.

AUDIO SELECT CH1/CH2 (audio channel 1/2 adjustment method selection) switches
Select the audio level adjustment method for each of audio channels 1 and 2.
AUTO: Automatic adjustment
MANUAL: Manual adjustment

AUDIO IN CH1/CH2/CH3/CH4 (audio channel 1/2/3/4 input selection) switches
Select the audio input signals to be recorded on audio channels 1, 2, 3 and 4.
FRONT: Audio input signals from the microphone connected to the MIC IN connector
REAR: Audio input signals from an audio device connected to the AUDIO IN CH-1/CH-2 connectors
WIRELESS: Audio input signals from the UHF portable tuner if it is installed
1 ASSIGNABLE 4/5 switches
You can assign the desired functions to these switches on OPERATION >Assignable SW in the setup menu (see page 143). Off is assigned to these switches when the camcorder is shipped from the factory.

2 USB connector
Used to put this camcorder into USB connection mode and use it as an external storage device for a computer. When a computer without ExpressCard slot is connected to this connector, every memory card inserted in left slots in the camcorder is recognized as a drive for that computer.

3 External device connector
Connect an optional CBK-WA01 Wi-Fi Adapter. Connecting a CBK-WA01 allows Wi-Fi connection (wireless LAN connection) between the camcorder and a computer.

Note
Use this connector only for connecting a CBK-WA01. Do not connect and use a USB hub or similar products. For details on how to use the CBK-WA01, refer to the Supplement supplied in the CD-ROM (labeled “Manuals for Solid-State Memory 3D Camcorder”).

4 SxS memory card slots
These four slots can receive SxS memory cards or other recording media. The left slots (A and B) record the left lens image and the right slots (A and B) record the right lens image. When slot A is being used on the left, slot A is also used on the right. It is not possible to use slot A on the left and slot B on the right, or vice versa (see page 71).

5 ACCESS lamps
Indicate the state of each slot (see page 71).

6 EJECT buttons
To remove the recording media from the slot, press the EJECT button to release the lock, then press the button once more. This makes the media come out of the slot partially (see page 72).

7 Slot cover
Slide to the left and right to open and close.

8 SLOT SELECT (SxS memory card select) button
Press this button to select the slots to use (A or B). The same slots are selected (A or B) for use on both the left and right (see page 72).

9 HDMI output connector
Outputs HDMI signals for video monitoring. When a video monitor provided with an HDMI signal input connector is connected to this
connector, you can monitor picture being shot (camera picture) or playback picture.

10 GENLOCK IN (genlock signal input) connector (BNC type)
This connector inputs a reference signal when the camcorder is to be genlocked or when timecode is to be synchronized with external equipment. Available reference signals vary depending on the current system frequency as shown in the following table.

<table>
<thead>
<tr>
<th>System frequency</th>
<th>Available reference signals</th>
</tr>
</thead>
<tbody>
<tr>
<td>1080/59.94i</td>
<td>1080/59.94i, 480/59.94i</td>
</tr>
<tr>
<td>1080/29.97P</td>
<td>1080/59.94i, 480/59.94i</td>
</tr>
<tr>
<td>1080/23.98P (PsF output)</td>
<td>1080/23.98PsF, 480/59.94i</td>
</tr>
<tr>
<td>1080/23.98P (Pulldown output)</td>
<td>1080/59.94i, 480/59.94i</td>
</tr>
<tr>
<td>720/59.94P</td>
<td>1080/59.94i, 720/59.94P, 480/59.94i</td>
</tr>
<tr>
<td>720/29.97P</td>
<td>1080/59.94i, 720/59.94P, 480/59.94i</td>
</tr>
<tr>
<td>720/23.98P</td>
<td>1080/59.94i, 720/59.94P, 480/59.94i</td>
</tr>
<tr>
<td>1080/50i</td>
<td>1080/50i, 576/50i</td>
</tr>
<tr>
<td>1080/25P</td>
<td>1080/50i, 576/50i</td>
</tr>
<tr>
<td>720/50P</td>
<td>1080/50i, 720/50P, 576/50i</td>
</tr>
<tr>
<td>720/25P</td>
<td>1080/50i, 720/50P, 576/50i</td>
</tr>
</tbody>
</table>

(Genlock for the camera module supports horizontal sync signals only.) Use MAINTENANCE >GENLOCK in the setup menu to adjust the genlock H-phase (phase of horizontal sync signal).

11 TC IN (timecode input) connector (BNC type)
To apply an external lock to the timecode of the camcorder, input the reference timecode. For details, see “Setting the Timecode” (page 65).

12 VIDEO OUT connector (BNC type)
Outputs video signals for monitoring. The output signals can be selected either composite video or HD-Y depending on the setting of OPERATION >Output >Signal Format in the setup menu.

13 TC OUT (timecode output) connector (BNC type)
To lock the timecode of an external VTR to the timecode of this camcorder, connect this connector to the external VTR’s timecode input connector.

Rear

1 TALLY (back tally) indicators (red)
Light up during recording. They will not light if the TALLY switch is set to OFF. These indicators also flash to indicate warnings (see page 26). The tally indicator on the front of the viewfinder and the REC indication on the viewfinder screen light or flash in the same manner. For details, see “Operation Warnings” (page 159).

2 TALLY switch
Set to ON to activate the TALLY indicator function.

3 EARPHONE jack (stereo, minijack)
You can monitor the E-E sound during recording and left-slot playback sound during playback.
When an alarm is indicated, you can hear the alarm sound through the earphone. Plugging an earphone into the jack automatically cuts off the built-in speaker. You can select monaural or stereo on MAINTENANCE >Audio in the setup menu.

4 AUDIO IN selectors
Select the audio source you connect to the AUDIO IN CH-1/CH-2 connectors.
LINE: When connecting a stereo amplifier or other external audio signal source
MIC: When connecting a microphone that does not require 48 V power supply
+48V: When connecting a microphone that requires 48 V power supply

5 HD/SD SDI OUT connector (BNC type)
Outputs 2-system Left/Right HDSDI signals (with embedded audio). The output from this connector can be turned on or off by OPERATION >Output >SDI Output in the setup menu.

6 AUDIO IN CH-1/CH-2 (audio channel 1 and channel 2 input) connectors (XLR type, 3-pin, female)
These are audio input connectors for channels 1 and 2 to which you can connect audio equipment or a microphone.

7 Bottom cover
This is provided for protecting the cables connected to the connectors on the rear panel. By loosening the screws which retain the cover to the bottom of the camcorder, you can adjust the position of the cover depending on the size and shape of the microphone or audio cable plugs. After adjusting the position, tighten the screws to secure the cover.

8 AUDIO OUT connector (XLR type, 5-pin, male)
Outputs the audio signals recorded on audio channels 1 and 2 or audio channels 3 and 4. The audio signals are selected by the MONITOR switch.

9 REMOTE connector (8-pin)
Connect a remote control unit, which makes it possible to control the camcorder remotely.

Note
Before connecting/disconnecting the Remote Control Unit to/from the camcorder, be sure to turn off the camcorder POWER switch.

Monochrome LCD Panel

1 Timecode status
NDF: Appears when non-drop-frame timecode is selected.
EXT-LK: Appears when the internal timecode generator is locked to an external signal input to the TC IN (timecode input) connector.

2 Counter display mode
Shows the type of information selected by the DISPLAY switch to be displayed in the time counter display.
COUNTER: Counter values
TC: Timecode
U-BIT: User bits data

3 Time counter display
Switches displays of time counter values, timecode, and user bits data, depending on the position of the DISPLAY switch.
When the HOLD button is pressed to hold the timecode value, the timecode is displayed in the format shown below. When the HOLD button is pressed again to release the hold, the timecode is displayed in the normal format.

The three dots indicates that timecode is displayed in the hold mode.

4 HOLD indication
Appears when the timecode generator output is displayed in the hold mode.
5 Audio level indicators
Indicate the audio recording or playback levels of channels 1 to 4.

6 Lock icon
Appears when the recording media is write-protected.

7 Remaining media capacity indicator
Shows bar segments indicating the remaining capacity of recording media in the slots.

8 Remaining battery capacity indicator
Shows bar segments indicating the remaining battery capacity.

---

Viewfinder

1 Plug
Connect to the VF connector (26-pin) on the camcorder.

2 Stopper
Prevents the viewfinder from coming off the camcorder when it is slid from side to side.

3 Eyecup

4 Diopter adjustment ring
Allows for optimal focus adjustment.

5 Eyepiece
You can raise this up when required by the situation.

6 Viewfinder barrel
You can raise this up or rotate when required by the situation.

7 Tally indicator
Lights up when recording is started by a press of the REC START button, the VTR button, or the VTR button on the remote control unit.
When an abnormality occurs, the tally indicator flashes to indicate a warning.

8 PEAKING control
Turning this control clockwise adjusts the picture sharpness, and makes focusing easier. This control has no effect on the output signals of the camcorder.

9 CONTRAST control
Adjusts the contrast of the screen. This control has no effect on the output signals of the camcorder.

10 BRIGHT control
Adjusts the brightness of the screen. This control has no effect on the output signals of the camcorder.

11 TALLY switch
Controls the tally indicator located on the front of the viewfinder.
HIGH: The tally indicator brightness is set to high.
OFF: The tally indicator is disabled.
LOW: The tally indicator brightness is set to low.

12 ZEBRA (zebra pattern) switch
Controls the zebra pattern display on the viewfinder screen as follows.
ON: Display a zebra pattern.
OFF: Do not display a zebra pattern.
DISPLAY switch
Turns the display of text information on and off.
ON: Display text information.
OFF: Do not display text information.

MIRROR switch
The image display on the monitor screen becomes reversed horizontally or vertically when the viewfinder barrel is raised up or rotated. Use this switch to control the image display in such situation.
L/R: Reverse the image horizontally.
OFF: Do not reverse the image.
B/T: Reverse the image vertically.

Viewfinder cable
Microphone holder

Viewfinder Screen Display

The viewfinder screen displays not only the video picture but also characters and messages indicating the camcorder settings and operating status, a center marker, a safety zone marker, etc. When the menu screen is not displayed and the DISPLAY switch is set to ON, the items for which an ON setting was made with OPERATION >Super Impose in the setup menu or with related switches are displayed at the top and bottom of the screen. Caution messages are indicated for three seconds when you carry out operations to change camcorder settings. Adjustment execution messages are indicated while adjustments proceed. When adjustments are finished, messages showing the results of adjustments appear for three seconds.
Not only these indications are displayed on the viewfinder screen, but a menu setting enables them to be output as video signals.
All items that can be displayed on the viewfinder screen are shown below.

Note
The distance displayed on the screen should only be used as a guide.

Top of viewfinder screen

1  3D/2D
Indicates the 3D/2D setting. During playback, “PLAY” is displayed after “3D” or “2D”.

Viewfinder Screen Display
2 **Zoom position**
Indicates the zoom position of the zoom lens in the range from 0 to 99.

3 **Focus position**
Indicates the focus position as distance from the lens surface to the subject (in units of m).

4 **Green tally**
Lights when the camcorder is the following states.
- **MAINTENANCE >Camera Config >HD-SDI Remote I/F** is set to [G-Tally] in the setup menu and a recording control signal is output from the HD/SD SDI OUT connector.

5 **Media status**
Displays the name of the currently active media slot (A or B).

6 **Recording mode/operation status**
Indicates the current recording mode-operation status as follows.

<table>
<thead>
<tr>
<th>Indication</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>●REC</td>
<td>Recording in progress</td>
</tr>
<tr>
<td>STBY</td>
<td>Standby for recording</td>
</tr>
<tr>
<td>●CACHE</td>
<td>Standby in Picture Cache mode</td>
</tr>
<tr>
<td>●INT REC</td>
<td>Recording in progress in Interval Recording mode</td>
</tr>
<tr>
<td>●INT STBY</td>
<td>Standby for next recording in Interval Recording mode</td>
</tr>
<tr>
<td>INT STBY</td>
<td>Standby in Interval Recording mode</td>
</tr>
<tr>
<td>●FRM REC</td>
<td>Recording in progress in Frame Recording mode</td>
</tr>
<tr>
<td>●FRM STBY</td>
<td>Standby for next recording in Frame Recording mode</td>
</tr>
<tr>
<td>FRM STBY</td>
<td>Standby in Frame Recording mode</td>
</tr>
<tr>
<td>●S&amp;Q REC</td>
<td>Recording in progress in Slow &amp; Quick Motion mode</td>
</tr>
<tr>
<td>S&amp;Q STBY</td>
<td>Standby in Slow &amp; Quick Motion mode</td>
</tr>
<tr>
<td>●CALL</td>
<td>Being called from a connected device</td>
</tr>
<tr>
<td>▶REVIEW</td>
<td>During recording review</td>
</tr>
</tbody>
</table>

The ● indicator flashes when **OPERATION >Format>3D/2D** in the setup menu is set to 3D and you are recording to either the left slots or right slots only.

7 **Wireless receiver reception level**
When a wireless receiver is installed in the camcorder, “W” appears together with four segment reception level indicators for each of the channels (1 to 4) that can be used by the receiver. The indications are as follows.

**In normal situation:** The number of white segments indicates the strength of the signal level.

**Muting (for an analog receiver) or error rate aggravation (for a digital receiver):** The number of gray segments indicates the strength of the signal level.

**Reception level over peak:** “P” is displayed instead of the indicators. ¹)

**Tuner battery is low:** The channel number and indicator of the corresponding channel flash. ¹)

¹) When an optional DWR-S01D is used

8 **Battery remaining/voltage capacity**
The following is displayed depending on the type of power source.

<table>
<thead>
<tr>
<th>Type of power source</th>
<th>What is displayed</th>
</tr>
</thead>
<tbody>
<tr>
<td>InfoLithium battery</td>
<td>Remaining battery capacity icon and remaining recording time</td>
</tr>
<tr>
<td>Anton Bauer battery</td>
<td>Remaining battery capacity (%) indication</td>
</tr>
<tr>
<td>Other type than above</td>
<td>Input voltage</td>
</tr>
</tbody>
</table>

9 **External power input**
Appears when power is supplied from an external power source connected to the DC IN connector.

10 **Color temperature**
Displays a color temperature calculated from the gain of R and B, in the range 1.5 K to 50.0 K (in steps of 0.1 K). The +/- signs may be displayed depending on the Offset White setting (see page 119).

**No display:** Offset White is OFF

+ : The value of Offset White is greater than 3200K.

→ : The value of Offset White is less than 3200K.

11 **Number of system lines**
Indicates the number of system lines (1080/720/576/480) of video currently being recorded or played back.
**12 Video format**
Indicates the format of video being currently played back or recorded (see page 51).

**13 Depth of field indication**
- **Error/warning indication**
  A bar indicates the depth of field. The display unit is meters or feet, as selected by OPERATION >Display On/Off >Lens Info in the setup menu. An error or warning message is displayed here depending on the situation.

  Under this area, you can also display the name of the next clip to be recorded (see page 121).

**14 Special recording mode indication**
The following is displayed when the camcorder is in a special recording mode.
- Frame Rec (Frame Recording mode)
- Interval Rec (Interval Recording mode)
- S&Q Motion (Slow & Quick Motion mode)

**15 Special recording mode settings indication**
Appears when the camcorder is in a special recording mode.

---

### Bottom of viewfinder screen

---

**1 TLCS iris control mode**
The following icons are displayed to indicate the video level control modes based on the Total Level Control System (TLCS).

---

<table>
<thead>
<tr>
<th>Icon</th>
<th>TLCS control mode</th>
</tr>
</thead>
<tbody>
<tr>
<td>🌞</td>
<td>Backlight mode</td>
</tr>
<tr>
<td>STD</td>
<td>Standard mode</td>
</tr>
<tr>
<td>🌃</td>
<td>Spotlight mode</td>
</tr>
</tbody>
</table>

**2 Focus adjustment mode**
Indicates the current focus adjustment mode of the camcorder.
- AF (Auto Focus mode)
- MF (Manual Focus mode)
- MF* (Manual Focus mode when the MF Assist function is on)

**3 External device control**
“REC2” is displayed when MAINTENANCE >Camera Config >HD-SDI Remote I/F is set to [Chara] in the setup menu and a recording control signal is output from the HD/SD SDI OUT connector.

**4 Video level indication**
An indication is displayed together with an appropriate ND filter position number when the light level of the subject is too high or too low.

**5 Timecode**
- **Caution message**
Indicates the elapsed recording/playback time, timecode, user bits data or other information selected by the DISPLAY switch (see page 27). Also indicates a caution message when caution is required such as when you try to change settings.

**6 Brightness level**
Indicates the average brightness level (%) of the detection area.

**7 Subject distance range (3D) or recording status (2D)**
In 3D record mode, displays the distance range to the subject that produces natural stereoscopic images.
In 2D record mode or in 3D mode when recording to either left slots or right slots only, displays the recording status.
- **Single Rec L:** Recording in 3D mode to left slots only
- **Single Rec R:** Recording in 3D mode to right slots only
2D Rec L: Recording in 2D mode to left slots only
2D Rec R: Recording in 2D mode to right slots only
2D Rec L&R: Recording in 2D mode to both left and right slots
2D L: Can record in 2D mode to left slots only
2D R: Can record in 2D mode to right slots only
2D L&R: Can record in 2D mode to both left and right slots
2D--: Cannot record

8 Convergence distance
Displays the distance from the lens surface to the convergence point in units of meters (m).

9 Electric color temperature filter
Appears when the CC 5600K function is set to on.

10 Filter position
Indicates the currently selected ND filter position number. (see page 21).
When ELECTRICAL CC is assigned to an assignable switch, the electrical filter position (A/B/C/D) appears to the right of the ND filter position (1 to 4), as shown on the previous page.

11 White balance memory
Indicates the currently selected white balance automatic adjustment memory.
ATW: ATW (Auto Tracing White Balance) mode
W:A: Memory A mode
W:B: Memory B mode
W:P: Preset mode
3200: When the assignable switch to which Color Temp SW 3200K has been assigned is on
4300: When the assignable switch to which Color Temp SW 4300K has been assigned is on
5600: When the assignable switch to which Color Temp SW 5600K has been assigned is on
6300: When the assignable switch to which Color Temp SW 6300K has been assigned is on

12 Gain value
Indicates the gain value (in dB) of the video amplifier, as set by the GAIN selector.

13 Shutter
Indicates the shutter speed or the shutter mode.
For details, see “Setting the Electronic Shutter” (page 56).

14 Audio level meters
Indicate the audio levels of channel 1 and channel 2.

15 Remaining media capacity
Indicates the recording time remaining for each of the media loaded in the slots (A or B). The available time for recording with the current video format (recording bit rate) is calculated according to the remaining space of each media and indicated in time units of minutes. A lock icon appears if the media is write-protected.
When media is inserted in both the left and right slots, and the camcorder is recording or can record to both, this indicates the media (left or right) with the lower remaining recording time. When the camcorder is recording or can record to left slots or right slots only, this indicates the remaining recording time for that media.

16 Histogram
Shows a pixel distribution of video luminance.

17 Iris position
Indicates the iris position and the setting for iris override (reference value for the lens iris) (see page 58).
The iris override setting is indicated by four segments indicator as follows.

<table>
<thead>
<tr>
<th>Reference value</th>
<th>Indicator</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>+0.25</td>
<td>■</td>
<td>Lower left segment is lit in grey.</td>
</tr>
<tr>
<td>+0.5</td>
<td>■■</td>
<td>Left two segments are lit in grey.</td>
</tr>
<tr>
<td>+0.75</td>
<td>■■■</td>
<td>Left two segments and lower right segment are lit in grey.</td>
</tr>
<tr>
<td>+1</td>
<td>■■■■</td>
<td>All segments are lit in grey.</td>
</tr>
<tr>
<td>-0.25</td>
<td>■</td>
<td>Lower left segment is lit in white.</td>
</tr>
<tr>
<td>-0.5</td>
<td>■■</td>
<td>Left two segments are lit in white.</td>
</tr>
<tr>
<td>-0.75</td>
<td>■■■</td>
<td>Left two segments and lower right segment are lit in white.</td>
</tr>
<tr>
<td>-1</td>
<td>■■■■■</td>
<td>All segments are lit in white.</td>
</tr>
</tbody>
</table>
Preparing a Power Supply

For safety, use only the Sony battery packs and AC adaptors listed below.
- BP-GL95A/L60S/L80S Lithium-ion Battery Pack
- AC power using the AC-DN2B/DN10 AC Adaptor

**CAUTION**
Danger of explosion if battery is incorrectly replaced. Replace only with the same or equivalent type recommended by the manufacturer. When you dispose of the battery, you must obey the law in the relative area or country.

### Using a Battery Pack

When a BP-GL95A/L60S/L80S Battery Pack is used, the camcorder will operate continuously for the time shown below.

<table>
<thead>
<tr>
<th>Model name</th>
<th>Operating time</th>
</tr>
</thead>
<tbody>
<tr>
<td>BP-GL95A</td>
<td>Approx. 310 minutes</td>
</tr>
<tr>
<td>BP-L60S</td>
<td>Approx. 210 minutes</td>
</tr>
<tr>
<td>BP-L80S</td>
<td>Approx. 270 minutes</td>
</tr>
</tbody>
</table>

**WARNING**
Batteries shall not be exposed to excessive heat such as sunshine, fire or the like.

**Note**
The battery pack operating time depends on the frequency of use of the battery pack, and the ambient temperature when used.

Before use, charge the battery pack with a charger suitable for each battery.

*For details on the battery charging procedure, refer to the battery charger operation manual.*

**To attach the battery pack**

1. Press the battery pack against the back of the camcorder, aligning the line on the side of the battery pack with the matching line on the camcorder.

2. Slide the battery pack down until its “LOCK” arrow points at the matching line on the camcorder.
If the battery pack is not attached correctly, the terminal may be damaged.

To detach the battery pack

Holding the release button in, pull the battery pack up.

CAUTION
When the viewfinder is attached, do not leave the camcorder with the eyepiece facing the sun. Direct sunlight can enter through the eyepiece, be focused in the viewfinder and cause fire.

Notes

• During recording and playback (while the ACCESS lamp on the right-side panel is lit in blue and the ACCESS lamp in the card slot section is lit in orange), be careful never to remove the battery pack.
• Make sure to power the camcorder off before replacing the battery pack.

Using AC Power

Mount an AC-DN2B/DN10 on the camcorder in the same way as a battery pack, then connect to the AC power supply. The AC-DN2B/DN10 can supply up to 100 W of power.

1 Loosen the viewfinder left-to-right positioning ring, 2 attach the viewfinder to the viewfinder fitting shoe, and 3 tighten the viewfinder left-to-right positioning ring.
2 Couple the viewfinder connector to the VF connector (26-pin).

Detaching the viewfinder
You can detach the viewfinder by following the attaching procedure in reverse order, but there is an additional action to take: when detaching the viewfinder from the fitting shoe, pull up the stopper.

Adjusting the Viewfinder Position
To adjust the viewfinder left-to-right position, loosen the left-to-right positioning ring, and to adjust the front-to-back position, loosen the front-to-back positioning knob.

Adjusting the Viewfinder Angle
You can adjust the angle of the viewfinder.

To reverse the display (image/text indication) vertically
The viewfinder can be rotated as much as 180 degrees toward the direction facing the subject. When you do this, the picture and other information displayed in the viewfinder appear upside down. To restore the normal display, set the MIRROR switch on the rear panel of the viewfinder to B/T.

Lifting Up the Viewfinder Barrel and Eyepiece
You can view the LCD screen inside the viewfinder or its mirrored image by lifting up the viewfinder barrel or the eyepiece.
To display 3D images in the viewfinder, lift up the eyepiece to view the image.
This section describes how to lift up the viewfinder barrel and detach it. The eyepiece can also be lifted up and detached in the same way.
To raise up the viewfinder barrel
Push the clip on the bottom to release (①) and flip up the viewfinder barrel (②).
It locks at the 120-degree position.

Normally use it in the locked position.
Although you can open it farther from the lock position, once return it to the closed position to lock it at the 120-degree position again.

To detach the viewfinder barrel

1 Push the clip on the bottom to release.
2 Flip up the viewfinder barrel.
3 Slide the knob on the top to the opposite side of the viewfinder barrel.
4 Detach the viewfinder barrel by horizontally sliding it.

To reverse the display (image/text indication) horizontally
By setting the MIRROR switch on the rear panel of the viewfinder to L/R, you can reverse the picture and other information displayed in the viewfinder horizontally.
To attach the hood

You can detach the viewfinder barrel or eyepiece and attach a hood to make the image on the LCD screen easier to see.

1 Slide the button on top of the viewfinder to release the lock.
2 Align the protrusion on the top of the hood with the groove on the viewfinder, and then slide it horizontally.
3 Lower the hood and lock using the bottom clip.
4 Open the hood and fasten in position.

Adjusting the Viewfinder Focus and Screen

To adjust the viewfinder focus

Turn the diopter adjustment ring until the viewfinder image is sharpest.

To adjust the viewfinder screen

Adjust the brightness, contrast, and peaking of the viewfinder screen with the controls shown below.

Using the BKW-401 Viewfinder Rotation Bracket

By fitting an optional BKW-401 Viewfinder Rotation Bracket, you can rotate the viewfinder out of the way so that your right leg does not hit the viewfinder while you are carrying the camcorder.
1 Loosen the front-to-back viewfinder positioning levers and the front-to-back viewfinder positioning knobs, and then pull the viewfinder slide assembly forward.

2 Using a 2.5 mm diameter hexagonal wrench, detach the viewfinder slide assembly.

3 Attach the BKW-401 with the supplied bolts.

4 Adjust the front-to-back position so that the arm of the BKW-401 does not touch the handle when it is raised.

**Note**
The CBK-VF01 cannot display images in 3D.
Attaching a 5-inch Electronic Viewfinder

You can attach an optional DXF-series (5-inch) Electronic Viewfinder. To attach it, an Accessory Shoe Kit (service part number: A-8274-968-B) is required.

*For details, consult a Sony service representative.*

**Notes**

- The 5-inch viewfinder does not support 3D display or anaglyph display.
- It is not possible to use either the supplied viewfinder or CBK-VF01 viewfinder with the 5-inch viewfinder at the same time.

Remove the cover of the grip, and attach the shoe and stopper screw of the Accessory Shoe Kit.

---

![Diagram of viewfinder attachment](image-url)

a) Supplied with the Accessory Shoe Kit
Setting the Area of Use

When using the camcorder for the first time
The area of use is not factory preset. Before using the camcorder, you need to set this item. (You cannot use the camcorder without setting this item.)

To set the area of use

1 Set the POWER switch to the ON position.
The screen for setting the area of use appears in the viewfinder.

2 Press the MENU knob.
The settings for selectable areas of use are displayed.

3 Turn the MENU knob to select the desired area of use.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Area of use</th>
</tr>
</thead>
<tbody>
<tr>
<td>NTSC Area</td>
<td>NTSC area (for areas other than Japan) a)</td>
</tr>
<tr>
<td>NTSC(J) Area</td>
<td>NTSC area (Japan) b)</td>
</tr>
<tr>
<td>PAL Area</td>
<td>PAL area c)</td>
</tr>
</tbody>
</table>

a) The composite signal output from this camcorder is an NTSC signal with a black setup (7.5 IRE). The system frequency is 59.94i.
b) The composite signal output from this camcorder is an NTSC signal with no black setup. The system frequency is 59.94i.
c) The composite signal output from this camcorder is a PAL signal. The system frequency is 50i.

4 Set the following items.
- Time Zone
- Date/Time

See “Basic Setup Menu Operations” (page 101).

5 Turn the MENU knob to select “Finish”, then press the MENU knob.
The camcorder is now ready for use.
You can set or change the date and time of the internal clock. The date and time set are reflected in the timecode.

For menu operations, see “Basic Setup Menu Operations” (page 101).

1. Select MAINTENANCE > Clock Set > Date/Time in the setup menu.
2. Press the MENU knob. The Date/Time setting window appears.
3. Turn the MENU knob to display the desired value, and press the knob. The selection shifts to the next item on the right.
4. To continue the remaining settings, repeat step 3.
5. Making sure that “SET” is selected, press the MENU knob. The internal clock is set with the date and time set in steps 3 and 4.

To cancel the setting
Before executing step 5, push the MENU CANCEL/PRST/ESCAPE switch up to the CANCEL/PRST side.

Connecting a Microphone to the MIC IN Connector

Attach the supplied microphone to the microphone holder of the supplied viewfinder.

1. Loosen the screw (1) and open the microphone holder clamp (2).
2. Place the microphone in the holder.
   ① Place the microphone in the holder so that “UP” is at the top.
   ② Close the microphone holder.
   ③ Tighten the screw.
3. Plug the microphone cable into the MIC IN connector, then set the AUDIO IN CH1/CH2/CH3/CH4 switch for the
channel on which you want to record the audio from this microphone to FRONT.

4 Secure the microphone cable with the cable clamp.

Connecting Microphones to the AUDIO IN Connectors

You can connect up to two monaural microphones to the AUDIO IN CH1/CH2 connectors, using an optional CAC-12 Microphone Holder.
The following is the procedure for attaching an electret condenser microphone such as the ECM-674/678.
On how to attach the CAC-12, refer to the operation manual for the CAC-12.

1 Attach the electret condenser microphone.

① Loosen the ball joint lock lever.
② Wind the microphone spacer (sheet type, supplied with the microphone) around the microphone, while peeling off the protective sheets on both sides of the microphone spacer.
③ Place the microphone in the holder so that “UP” is at the top.
④ Close the microphone holder.
⑤ Tighten the screw.
⑥ Position so that the microphone does not interfere with the viewfinder and tighten the ball joint lock lever.

2 Connect the microphone cable to the AUDIO IN CH-1 or CH-2 connector.

3 Set the switches as follows.
- Set the AUDIO IN selectors indicated below, depending on the power supply type of the microphone.
  - Internal power supply: MIC
  - External power supply: +48V
- Set the AUDIO IN CH-1/CH-2 switch for the channel to which the microphone is connected to REAR.
Switch the input level to match the sensitivity of the microphone used.
Switch the input level by changing the setting of MAINTENANCE > Audio > Rear MIC CH1/CH2 Ref in the setup menu (factory default setting is –60 dB). For details, see page 129.

Notes

• If the input level on the camcorder is not at an appropriate setting for the microphone sensitivity, loud sounds may be distorted, and the signal-to-noise ratio may be affected.
• In order for the AUDIO IN CH-1 and CH-2 connectors on the camcorder to be able to provide a phantom 48 V power supply, female XLR connectors (3-pin) are fitted. If the microphone cable has a female connector, use an adaptor.
• When you detach a CAC-12 Microphone Holder once you have attached to the camcorder, be careful not to lose the two screws fixing the CAC-12 (in step 1). After detaching the CAC-12, be sure to put the two screws back into their original places.

Attaching a UHF Portable Tuner (for a UHF Wireless Microphone System)

To use a Sony UHF wireless microphone system, power the camcorder off and then fit one of the following UHF portable tuners.
• DWR-S01D Digital Wireless Receiver
• WRR-855S UHF Synthesized Tuner Unit
• WRR-860C/861/862 UHF Synthesized Diversity Tuner

For details of these units, refer to the operation manuals for them.

Note

The optional WRR Mount Bracket (service part number: A-8278-057-B) is required to fit the WRR-862.

For details, contact your vendor or a Sony service representative

To fit the DWR-S01D or WRR-855S

1 Remove the four fixing screws holding the cover of the portable tuner/receiver housing slot located in the rear of the camcorder, to remove the cover.

2 Insert the DWR-S01D or WRR-855S into the housing slot, and fasten the four fixing screws.

DWR-S01D or WRR-855S

3 Set the AUDIO IN selector for the channel to which you want to input audio signal to WIRELESS (see page 28).
Tripod Mounting

1. Attach the optional VCT-14/U14 Tripod Adaptor to the tripod.

2. Mount the camcorder on the tripod adaptor.

To remove the camcorder from the tripod adaptor

Hold down the red button and pull the lever in the direction of the arrow.

Note

The tripod adaptor pin may remain in the engaged position even after the camcorder is removed. If this happens, press the red button and move the lever as shown above until the pin returns to the stowed position. If the pin remains in the engaged position, you will not be able to mount the camcorder on the tripod adaptor.
Connecting a Video Light

With this camcorder, you can use the Anton Bauer Ultralight 2 or equivalent video light (powered by 12 V with maximum power consumption of 50 W).

- If you connect the video light to the LIGHT connector on the camcorder and set the LIGHT switch to AUTO, you can turn the light on and off automatically as you start and stop recording on this camcorder.
- The output of the LIGHT connector on the camcorder is controlled to 12 V even when the camcorder is supplied with over 12 V power (through the DC IN connector or battery pack). The brightness or color temperature of the light will not change according to voltage increase.

Notes
- Do not use a video light with power consumption of over 50 W.
- The brightness or color temperature of the light will change when the voltage (supplied through the DC IN connector or from the battery pack) is under 12 V.

To attach the video light
Fit the video light to the accessory fitting shoe on the camcorder grip, and connect the video light cable to the LIGHT connector.

Note
The accessory fitting shoe on the camcorder is of the \( \frac{1}{4} \)-inch tapped hole type. If you want to replace this with a slide-type shoe, use the supplied cold shoe kit. For information about using the cold shoe kit, refer to the Supplement provided on the “Manuals for Solid-State Memory 3D Camcorder” CD-ROM.

Using the Shoulder Strap

To attach the shoulder strap

1. Fit one of the clips to a shoulder strap fitting.
   Pull up the strap to lock the fitting.

2. Fit the other clip to the shoulder strap fitting on the other side of the grip in the same way as in step 1.
To remove the shoulder strap

Press here and pull in the direction shown by the arrow to release.

Adjusting the Shoulder Pad Position

You can slide the shoulder pad back and forth within a 40 mm range. This adjustment helps you get the best balance for shooting with the camcorder on your shoulder.

1. Raise the lever in the center of the shoulder pad to unlock the shoulder pad.

2. Slide the shoulder pad backward or forward until it is in the most convenient position.

3. Bring down the lever to lock the shoulder pad in the selected position.
Setting the Video Format

The following recording formats can be selected for different combinations of video resolution and system frequency.

<table>
<thead>
<tr>
<th>OPERATION &gt;Format menu settings</th>
<th>Video format (recording format/system frequency)</th>
<th>Frame size</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>HD System Line</strong></td>
<td><strong>Rec Format</strong></td>
<td><strong>System Frequency</strong></td>
</tr>
<tr>
<td>1080</td>
<td>HQ 1920</td>
<td>59.94i</td>
</tr>
<tr>
<td></td>
<td></td>
<td>50i</td>
</tr>
<tr>
<td></td>
<td></td>
<td>29.97P</td>
</tr>
<tr>
<td></td>
<td></td>
<td>25P</td>
</tr>
<tr>
<td></td>
<td></td>
<td>23.98P</td>
</tr>
<tr>
<td></td>
<td>HQ 1440</td>
<td>59.94i</td>
</tr>
<tr>
<td></td>
<td></td>
<td>50i</td>
</tr>
<tr>
<td></td>
<td></td>
<td>29.97P</td>
</tr>
<tr>
<td></td>
<td></td>
<td>25P</td>
</tr>
<tr>
<td></td>
<td></td>
<td>23.98P</td>
</tr>
<tr>
<td></td>
<td>SP 1440</td>
<td>59.94i</td>
</tr>
<tr>
<td></td>
<td></td>
<td>50i</td>
</tr>
<tr>
<td>720</td>
<td>HQ 1280</td>
<td>59.94P</td>
</tr>
<tr>
<td></td>
<td></td>
<td>50P</td>
</tr>
<tr>
<td></td>
<td></td>
<td>29.97P</td>
</tr>
<tr>
<td></td>
<td></td>
<td>25P</td>
</tr>
<tr>
<td></td>
<td></td>
<td>23.98P</td>
</tr>
</tbody>
</table>

a) **59.94i/29.97P/23.98P**: When OPERATION >Format >Country in the setup menu is set to [NTSC Area] or [NTSC(J) Area]

**50i/25P/50P**: When OPERATION >Format >Country in the setup menu is set to [PAL Area]
Changing the Video Format

Refer to the above table and change the settings of the relevant items.

1. Select OPERATION > Format in the setup menu (see page 104).

2. Turn the MENU knob to select the item to change, and press the knob.

3. Turn the MENU knob to change the setting, and press the knob.
   A confirmation message appears.

4. Select [Execute] to execute, or select [Cancel] to cancel, and then press the MENU knob.

5. When the setting of Country was changed, power the camcorder off and on again.

Selecting 3D or 2D Mode

This selects 2D or 3D image recording mode.

Selecting 3D or 2D

Select OPERATION > Format > 3D/2D in the setup menu, and then select 3D or 2D.

When 3D is selected, the images from the left and right lenses are recorded onto memory cards in the left and right slots, respectively.

If one of the memory cards in the slots becomes full during 3D recording, the camcorder either stops recording or continues to record to a single recordable slot only, according to the setting using OPERATION > Format > 3D Single Rec in the setup menu.

When 2D is selected, images are recorded to slots with memory cards inserted. If memory cards are inserted in both the left and right slots, the left and right images are recorded to memory cards in the respective slots. If memory cards are inserted in either the left or right slots only, images are recorded to those memory cards only.
To ensure excellent image quality when using this camcorder, conditions may require that both the black balance and the white balance be adjusted. Black balance and white balance adjustment values that are automatically set by the camcorder and the various settings are stored in the camcorder memory and retained even when the power is turned off.

**Black balance adjustment**

The black balance will require adjustment in the following cases.
- When the camcorder is used for the first time
- When the camcorder has not been used for a long time
- When the camcorder is used under conditions in which the surrounding temperature has changed greatly
- When the GAIN selector (L/M/H/Turbo) values have been changed by using OPERATION >Gain Switch in the setup menu.

It is not usually necessary to adjust the black balance when using the camcorder after it has been off.

**White balance adjustment**

Always readjust the white balance when the lighting conditions change.

**Adjusting the Black Balance**

In automatic black balance mode, adjustments are performed in the following order: black set and black balance. Manual black balance adjustment can be selected from the setup menu.

**Notes**
- During the black balance adjustment, the iris is automatically closed.
- During the black balance adjustment, the gain selection circuit is automatically activated so you may see flickering on the viewfinder screen, but this is not a fault.

**If automatic black balance adjustment cannot be made**

If the black balance adjustment cannot be completed normally, an error message will appear for about three seconds on the viewfinder screen. Possible messages are listed below.

<table>
<thead>
<tr>
<th>Error message</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>NG: Iris Not Closed</td>
<td>The lens iris did not close; adjustment was impossible.</td>
</tr>
<tr>
<td>NG: Timeout</td>
<td>Adjustment could not be completed within the standard number of attempts.</td>
</tr>
<tr>
<td>NG: Out of Range</td>
<td>The difference between the reference value and the current value is so great that it exceeds the range. Adjustment was impossible.</td>
</tr>
</tbody>
</table>

If any of the above error messages is displayed, retry the black balance adjustment. If the error message occurs again, an internal check is necessary.

For information about this internal check, refer to the Maintenance Manual.
Adjusting the White Balance

1. Set the switches and selectors as shown below.
   - GAIN switch: L (set to a gain value that is as small as possible)
   - OUTPUT/DCC switch: CAM
   - WHITE BAL switch: A or B 1)

   1) Adjustment values are saved to memory B only when OPERATION >White Setting >White Switch<B> in the setup menu, is set to [Memory].

2. Set the FILTER selector to suit the lighting conditions as follows.

3. Place a white test card under the same lighting conditions as for the subject to be shot and zoom up to it.
   Alternatively, any white object such as a cloth or a wall can be used.
   The absolute minimum white area is as follows.
   Rectangle centered on the screen. The lengths of the sides are 70% of the length and width of the screen.

   Note
   Make sure there are not bright spots in the rectangle.

4. Set the IRIS switch to AUTO.

5. Push the AUTO W/B BAL switch to WHITE and then release the switch.
   The message “Executing...” appears during execution, and changes to “OK: (color temperature of subject)” when the adjustment finishes.
   The adjustment values are saved automatically in the memory selected in step 1 (A or B).

---

If the automatic white balance adjustment cannot be made
If the white balance adjustment cannot be completed normally, an error message will appear for about three seconds on the viewfinder screen. Possible messages are listed below.

<table>
<thead>
<tr>
<th>Error message</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>NG: Low Light</td>
<td>The white video level is too low. Either open the lens iris or increase the gain.</td>
</tr>
<tr>
<td>NG: Timeout</td>
<td>Adjustment could not be completed within the standard number of attempts.</td>
</tr>
<tr>
<td>NG: High Light</td>
<td>The white video level is too high. Either stop down the lens iris or change the ND filter.</td>
</tr>
</tbody>
</table>

If any of the above error messages is displayed, retry the white balance adjustment. If the error message occurs again, an internal check is necessary.

For information about this internal check, refer to the Maintenance Manual.

If you have no time to adjust the white balance
Set the WHITE BAL switch to PRST.
This makes it possible to automatically set the white balance to 5600K (factory default value) by pressing the COLOR TEMP. button.
The color temperature to which the white balance is set when the COLOR TEMP. button is pressed can be selected from among 3200K, 4300K, 5600K, and 6300K on OPERATION >Assignable SW in the setup menu. You can also assign color temperatures to the ASSIGN. 1/3 switches or ASSIGNABLE 4/5 switches.

To change the color temperature when the ND filter is switched
You can assign electrical CC (color correction) filters to ND filters (see page 21). This allows you to change the color temperature automatically when the ND filter is switched.

1. Set MAINTENANCE >White Filter >ND Filter C.Temp in the setup menu (see page 135) to On.

2. To assign an electrical CC filter to FILTER selector position number 1,
select [ND FLT C.Temp<1>]. To assign it to positions 2 to 4, select [ND FLT C.Temp<2-4>].

3 Turn the MENU knob to select the desired color temperature.
As you turn the MENU knob, the color temperature changes as follows: 3200K ↔ 4300K ↔ 5600K ↔ 6300K.

4 Repeat steps 2 and 3 as required.

To switch between electrical CC filters with an assignable switch

You can assign the function that switches between electrical CC filters to an assignable switch. This allows you to switch between color temperatures (3200K/4300K/5600K/6300K) that have been assigned to up to four positions (A to D) with each press of the assignable switch. Regardless of assignments to assignable switches, you can also switch between the color temperatures assigned to each position from a RM-B150/B750 Remote Control Unit.

1 Select MAINTENANCE > White Filter in the setup menu (see page 135).

2 Select the position to which to assign a CC filter by selecting one of [Electrical CC<A>] to [Electrical CC <D>], and then turn the MENU knob to select the desired color temperature.
As you turn the MENU knob, the color temperature changes as follows: 3200K ↔ 4300K ↔ 5600K ↔ 6300K.

To set no color temperature
Select “-----” with Electrical CC<C> or <D> selected.
When the assignable switch is pressed, the setting for that position is not displayed. For example, if “-----” is set for one position, then switching between the remaining three positions is carried out.

3 Repeat step 2 as required.

4 Assign the electrical CC filter switching function (ELECTRICAL CC) to an assignable switch (see page 144).

White balance memory

Values stored in memory are held until the white balance is next adjusted even when the camcorder power is turned off.
The camcorder has two white balance memories, A and B. You can automatically save adjustment values for each ND filter in the memory that corresponds to the WHITE BAL switch setting (A or B). The camcorder has four built-in ND filters, allowing you to save a total of eight adjustment values (4 × 2). However, the contents of the memories are not linked to ND filter settings in the following cases.
- When the number of memories allocated to each of A and B is limited to one by setting OPERATION > White Setting > Filter White Memory in the setup menu to Off.
- When the electrical CC filter switching function has been assigned to an assignable switch, or when a remote control unit has been connected. (In these cases, the contents of white balance memory are linked to electrical CC filter positions (A to D).)

Also, when OPERATION > White Setting > White Switch <B> in the setup menu is set to [ATW (Auto Tracing White Balance)], and the WHITE BAL switch is set to B, the ATW function is activated to automatically adjust the white balance of the picture being shot for varying lighting conditions.
Setting the Electronic Shutter

Shutter Modes

The shutter modes that can be used with the electronic shutter and the shutter speeds that can be selected are listed below.

Standard mode

Select this mode for shooting fast-moving subjects with little blurring.
You can set the shutter speed in one of two shutter modes: Speed mode, in which the speed is set in seconds, and Angle mode, in which the speed is set in degrees.

Speed mode

<table>
<thead>
<tr>
<th>System frequency</th>
<th>Shutter speed (unit: seconds)</th>
</tr>
</thead>
<tbody>
<tr>
<td>59.94i</td>
<td>1/60, 1/100, 1/120, 1/125, 1/250, 1/500, 1/1000</td>
</tr>
<tr>
<td>59.94P</td>
<td>1/40, 1/50, 1/60, 1/100, 1/120, 1/125, 1/250, 1/500, 1/1000</td>
</tr>
<tr>
<td>50i</td>
<td>1/60, 1/100, 1/120, 1/125, 1/250, 1/500, 1/1000, 1/2000</td>
</tr>
<tr>
<td>50P</td>
<td>1/40, 1/50, 1/60, 1/100, 1/120, 1/125, 1/250, 1/500, 1/1000, 1/2000</td>
</tr>
</tbody>
</table>

Angle mode

180°, 90°, 45°, 22.5°, and 11.25°

ECS (Extended Clear Scan) mode

Select this mode for obtaining images with no horizontal bands of noise when shooting subjects such as monitor screens.

As shown in the following tables, the range of shutter speeds that can be set varies depending on whether the Slow & Quick Motion (S&Q) function is on or off.

System lines: 1080

<table>
<thead>
<tr>
<th>System frequency</th>
<th>Shutter speed (unit: Hz)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>S&amp;Q: Off</td>
</tr>
<tr>
<td>59.94i</td>
<td>60.00 to 3800</td>
</tr>
<tr>
<td>50i</td>
<td>50.00 to 3500</td>
</tr>
<tr>
<td>29.97P</td>
<td>29.99 to 4100</td>
</tr>
<tr>
<td>23.98P</td>
<td>23.99 to 3700</td>
</tr>
<tr>
<td>25P</td>
<td>25.00 to 3900</td>
</tr>
</tbody>
</table>

System lines: 720

<table>
<thead>
<tr>
<th>System frequency</th>
<th>Shutter speed (unit: Hz)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>S&amp;Q: Off</td>
</tr>
<tr>
<td>59.94P</td>
<td>60.07 to 4100</td>
</tr>
<tr>
<td>50P</td>
<td>50.03 to 3900</td>
</tr>
<tr>
<td>29.97P</td>
<td>29.99 to 4100</td>
</tr>
<tr>
<td>23.98P</td>
<td>23.99 to 3700</td>
</tr>
<tr>
<td>25P</td>
<td>25.00 to 3900</td>
</tr>
</tbody>
</table>

SLS (slow speed shutter) mode

Select this mode for shooting subjects in low level lighting conditions.

3D/2D Number of accumulated frames

| 3D   | 2, 3, 4, 5, 6, 7, 8 |
| 2D   | 2, 3, 4, 5, 6, 7, 8, 16, 32, 64 |

Notes

- SLS mode cannot be used when the camcorder is in Slow & Quick Motion mode.
- It is not possible to output the color bar signal, turn the SLS mode on or off, or change the number of accumulated frames when the number of accumulated frames is set to 16, 32 or 64.

Selecting the Shutter Mode and Shutter Speed

Notes

- When the automatic iris is used, the iris opens wider as the shutter speed increases, thus reducing the depth of field.
- The selectable shutter speeds vary depending on the current system frequency.
To switch between Speed mode and Angle mode

1. Select OPERATION > Shutter Select > Shutter Select in the setup menu (see page 119).

2. Turn the MENU knob to select Second or Degree, and then press the knob.

To set the shutter mode and standard-mode shutter speed

Once the shutter speed is selected, it is retained even when the camcorder power is turned off.

1. Push the SHUTTER selector from ON to SELECT.
   The current shutter setting indication appears for about three seconds.

2. Before the shutter setting indication disappears, push the SHUTTER selector down to SELECT again and repeat this until the desired mode or speed appears.
   When all modes and speeds are displayed, the display changes in the following order.

   Speed Mode (with system frequency 59.94i)
   ![Shutter Speed Chart]

   SLS Mode ← ECS Mode

   Note
   Depending on the frame rate setting (see page 82), some shutter speeds cannot be selected in Slow & Quick Motion mode. These speeds are replaced by the slowest selectable shutter speed.

   Example: If you perform Slow & Quick Motion shooting when setting the frame rate to 60 and the video format to HQ1280/29.97P
   The shutter speed is indicated as follows.

   When Slow & Quick Motion mode is off
   1/40 → 1/50 → 1/60 → 1/100 → ...

   When Slow & Quick Motion mode is on
   1/60 → 1/60 → 1/60 → 1/100 → ...

To set the shutter speed in ECS or SLS mode

1. Set the shutter mode to ECS or SLS (see the previous item).

2. Turn the MENU knob to select the desired frequency or number of frames.
Adjusting the Iris

You can use the IRIS dial or the automatic iris adjustment function to adjust the iris aperture.

Changing the Adjustment Mode

Set the IRIS switch to MANU (IRIS dial adjustment) or AUTO (automatic iris adjustment).
Even when the IRIS switch is set to MANU, pressing the PUSH AUTO button automatically adjusts the iris while the button is held down.

Adjusting the Iris using the IRIS Dial

Set the IRIS switch to MANU, and turn the IRIS dial. Turn the dial clockwise to open the iris aperture, and counterclockwise to close the iris aperture (factory default setting).
The direction of rotation of the dial can be changed using OPERATION >Dial Operation >IRIS Clockwise in the setup menu.

Adjusting the Iris using Automatic Iris Adjustment

Set the IRIS switch to AUTO. If the IRIS switch is set to MANU, you can also press the PUSH AUTO button to automatically adjust the iris aperture.

Changing the Reference Value for Automatic Iris Adjustment

The reference value for automatic iris adjustment can be changed to aid the shooting of clear pictures of back-lit subjects, or to prevent blown-out highlights. The reference value for the lens iris can be set within the following range with respect to the standard value.
- 0.25 to 1 (increasing by increments of 0.25): About 0.25 to 1 stop further open
- –0.25 to –1 (decreasing by increments of 0.25): About 0.25 to 1 stop further close
Also you can set the area where light detection occurs.

To change the reference value

1 Set OPERATION >Auto Iris >Iris Override in the setup menu to On (see page 117).
2 Set the MENU ON/OFF switch to OFF.
3 Turn the MENU knob to change the reference value.

Note
Be sure to confirm that the current shutter mode is not ECS.

An indicator of the current reference value is shown at the iris position indication (see page 36) on the viewfinder screen.

To make the iris more open
Turn the MENU knob counterclockwise as seen from the front of the camcorder.
Select one of 0.25, 0.5, 0.75, or 1.

To stop down the iris
Turn the MENU knob clockwise as seen from the front of the camcorder.
Select one of –0.25, –0.5, –0.75, or –1.

The changed reference value is retained until the power of the camcorder is turned off.
Even if the reference value is changed, it reverts to the standard value every time the power is turned on.

To set the automatic iris window

1 Set OPERATION >Auto Iris >Iris Window Indication in the setup menu to On.
The current automatic iris window appears on the viewfinder screen.
If it is not necessary to display the auto iris window on the screen, set to Off.
2 Turn the MENU knob to select Iris Window, and then press the knob.
3 Turn the MENU knob until the desired auto iris window appears, and then press the knob.

If you select “Var”, the following items become effective and you can set the window of the desired size. Set the following items with MAINTENANCE >Auto Iris2.

When you exit the menu, the auto iris window selected in step 3 appears.

Unless you need to keep this window displayed, set OPERATION >Auto Iris >Iris Window Indication in the setup menu to Off.

To counter problems with very bright highlights

If the subject is too bright, the iris may close too much, leaving the overall image dark, or the highlights may be blown out. In such cases, setting the highlight clip function on reduces the luminance range, avoiding problems from the automatic iris correction.

Set OPERATION >Auto Iris >Clip High Light in the setup menu to On.

---

**Zooming**

You can use the ZOOM dial or the zoom lever to operate the zoom.

**Using the ZOOM Dial**

Turn the ZOOM dial clockwise to zoom out for wide-angle shots, and counterclockwise to zoom in for long-distance shots (factory default setting).

The direction of rotation of the dial can be changed using OPERATION >Dial Operation >Zoom Clockwise in the setup menu.

The zoom function can also be assigned to the FOCUS dial or CONVERGENCE dial. The function assigned to the dial can be changed using OPERATION >Lens Dial >Mid or Inner in the setup menu.

**Using the Zoom Lever**

Push to the W (wide) side when you want wide-angle, and push to the T (telephoto) side when you want telephoto. The zoom speed increases when you push the lever deeply, and decreases when you push less deeply. The current lens zoom position appears in the viewfinder, over the range Z00 (wide-angle) to Z99 (telephoto) (see page 34).

The zoom function can also be assigned to the ASSIGNABLE 4/5 switches.

The focal lengths for the lens zoom numbers (Z00 to Z99) displayed in the viewfinder are shown in the following table for reference.
The camcorder allows you to adjust the focus in the following two ways.

**MF (manual focus) mode**
In this mode, focusing is performed using the FOCUS dial. Auto focus is enabled temporarily when you press the PUSH AF button. You can also use the MF assist function.

**AF (auto focus) mode**
In this mode, auto focus is always enabled. The FOCUS dial and the PUSH AF button are also enabled.

**Notes**
- Subjecting the camcorder to severe shocks may cause focus errors that subsist. If this occurs, turn the camcorder power off and then on again.
- The lens is designed with an extra margin at the infinity position (\(\infty\)), to compensate for focus drifting due to variations in temperature. When shooting a subject at infinity in MF mode, check the picture in the viewfinder as you focus.

---

**Adjusting in MF Mode**

When the FOCUS switch is set to MANU (manual), MF mode is selected, in which auto focus can be operated when necessary.

**Adjusting using the FOCUS dial**

Turn the FOCUS dial clockwise to focus on closer subjects, and counterclockwise to focus on distant subjects (factory default setting). The direction of rotation of the dial can be changed using OPERATION >Dial Operation >Focus Clockwise in the setup menu. The focus function can also be assigned to the ZOOM dial or CONVERGENCE dial. The function assigned to the dial can be changed using OPERATION >Lens Dial >Outer or Inner in the setup menu.
**One-push auto focus**
Press the PUSH AF button. Auto focus is enabled temporarily (one-push auto focus).
One-push auto focus ends when the subject is brought into focus.

**MF assist function**
When the MF assist function is on (see page 144), auto focus starts when you stop adjusting with the FOCUS dial, enabling fine adjustments with the subject at the center of the screen.
Auto focusing by the MF assist function ends when the fine adjustments end.

**Peaking**
You can turn the PEAKING knob on the viewfinder to use the peaking function. Edges are emphasized in the monitor picture, which facilitates manual focusing.
The recorded video signals are not affected.

**Adjusting in AF Mode**
When you slide the FOCUS dial forward, and set the FOCUS switch to AUTO, the focus mode becomes AF mode, in which auto focus is always active.

**Focusing in AF mode**
In AF mode, the camcorder monitors the video for changes, and starts auto focus whenever it detects a change. Auto focusing ends when the subject is in focus, but the auto focus function remains on standby.
In AF mode, you can also start auto focusing by pressing the PUSH AF button or by turning the FOCUS dial.

**Adjusting the Convergence**
The camcorder convergence point can be adjusted in the range 1.2 m (4 ft) to ∞ (infinity).
*For details about the convergence point, see page 14.*

When the subject is in focus, you can automatically set the convergence point to the subject distance (auto convergence). Using auto convergence, you can also set the convergence point a fixed percentage (−20% to +20%) beyond or in front of the focus distance.
After setting the convergence point using auto convergence, you can also fine-tune the convergence point by operating the dial or recall convergence points set beforehand.

The camcorder supports the following three methods for adjusting the convergence point distance.

**CONVERGENCE dial**
Turning the dial adjusts the convergence point forward or backward.

**AUTO CONVERGENCE button**
Pressing the button sets the convergence point to the current focus distance.

**Assignable switch**
You can assign a convergence point distance to an assignable switch. Pressing the assignable switch sets the convergence point to the assigned distance. You can assign different distances to several assignable switches in advance, and then easily switch the convergence point distance by pressing each assignable switch when shooting.

**Adjusting using the CONVERGENCE Dial**
Turn the CONVERGENCE dial clockwise to move the convergence point toward you, and counterclockwise to move the point further away (factory default setting).
The direction of rotation of the dial can be changed using OPERATION > Dial Operation > Conv. Clockwise in the setup menu. The convergence function can also be assigned to the ZOOM dial or FOCUS dial. The function assigned to the dial can be changed using OPERATION > Lens Dial > Outer or Mid in the setup menu.

### Adjusting using the AUTO CONVERGENCE Button

Press the AUTO CONVERGENCE button to set the convergence distance to the current focus distance. You can also shift the convergence point so that it is closer or further away than the focus point using OPERATION > Auto Conv. > Adjust Point in the setup menu.

### Adjusting using the Assignable Switches

You can record a convergence point distance in an assignable switch. A convergence point distance can be assigned to the following assignable switches.

- ASSIGN. 1/3 switches
- ASSIGNABLE 4/5 switches
- COLOR TEMP. button

Select an assignable switch using OPERATION > Assignable SW in the setup menu, and then select Convergence to record the current convergence point distance in the switch. To use, press the assignable switch to set the convergence point to the distance recorded in the switch. Assigning different distances to several assignable switches allows you to easily switch between multiple convergence point distances when shooting.

### Changing the Viewfinder Display

You can change the image displayed in the viewfinder using the VF DISPLAY SELECT switch. Each time you press the VF DISPLAY SELECT switch, the display changes in sequence.

- **L**: Displays the left lens image, in color.
- **R**: Displays the right lens image, in color.
- **L+R**: Displays an overlay of the left lens image and the right lens image, in color, by calculating the average for each pixel.
- **L-R**: Displays the image obtained by subtracting the right lens image from the left lens image to emphasize the parallax.
- **3D**: Displays the 3D image, in color.
- **Anaglyph**: Displays a superimposed image obtained by coloring the left lens image red and the right lens image blue.

3D can be displayed in the supplied viewfinder only.

Only left or right images can be displayed in DXF series viewfinders.

In 2D playback mode, the left image is always used when displaying thumbnails.

**Note**

The following functions cannot be used when L-R or Anaglyph is selected.

- Expand focus
- Zebra pattern display
- Peaking display

The following function cannot be used when L+R is selected.

- Expand focus
Adjusting the Audio Level

When you set the AUDIO SELECT switch to AUTO, the input levels of analog audio signals recorded on each channel are adjusted automatically. You can also make manual adjustments.

Note
Even if you set the AUDIO SELECT switch to AUTO, the input levels of digital audio signals are not adjusted automatically.

Target audio level for manual audio level adjustment
Make adjustment using −20 dB as the target level. If the audio level meter shows a maximum level of 0 dB, then it indicates that the input audio level is excessive.

1 To adjust the signal input to the AUDIO IN CH1 or CH2 connector, set the AUDIO IN CH-1 or CH-2 switch to REAR.
To adjust both input signals, set both switches to REAR.

2 Set the AUDIO SELECT switch(es) corresponding to the channel(s) selected in step 1 to MANUAL.

3 With the LEVEL control(s) for the channel(s) selected in step 1, adjust so that the audio level meter shows up to −20 dB for a normal input volume.

Correspondence between recording level adjustments and audio level controls
On MAINTENANCE >Audio in the setup menu, you can select which audio level control controls the audio recording level of the input to each of the AUDIO IN CH-1/CH-2 connectors. The correspondences between the settings of the menu items and the controls are as follows.

Rear1/WRR Level: Channel 1 recording level

<table>
<thead>
<tr>
<th>Setting</th>
<th>Knob</th>
</tr>
</thead>
<tbody>
<tr>
<td>Side1</td>
<td>LEVEL (CH1) knob</td>
</tr>
<tr>
<td>Front</td>
<td>MIC LEVEL control</td>
</tr>
<tr>
<td>Front+Side1</td>
<td>LEVEL (CH1) knob and MIC LEVEL control (linked operation)</td>
</tr>
</tbody>
</table>

Rear2/WRR Level: Channel 2 recording level

<table>
<thead>
<tr>
<th>Setting</th>
<th>Knob</th>
</tr>
</thead>
<tbody>
<tr>
<td>Side2</td>
<td>LEVEL (CH2) knob</td>
</tr>
<tr>
<td>Front</td>
<td>MIC LEVEL control</td>
</tr>
<tr>
<td>Front+Side2</td>
<td>LEVEL (CH2) knob and MIC LEVEL control (linked operation)</td>
</tr>
</tbody>
</table>

Note
When you have operation of the LEVEL (CH1/CH2) knobs and MIC LEVEL control linked together, if the MIC LEVEL control is set to 0, the audio signals on channels 1 and 2 cannot be recorded. Check the position of the MIC LEVEL control before adjusting the LEVEL (CH1/CH2) knobs.

Manually Adjusting the Audio Level of the MIC IN Connector

1 Set either or both of the AUDIO IN switch(es) to FRONT.
2 Set the AUDIO SELECT switch(es) for the desired channel(s) selected in step 1 to MANUAL.

3 Turn the MIC LEVEL control, and adjust so that the audio level meter shows up to –20 dB for a normal input volume.

Correspondence between recording level adjustments and audio level controls
On MAINTENANCE >Audio in the setup menu, you can select which audio level control controls the audio recording level of the front microphone input. The correspondences between the settings of the menu items and the controls are as follows.

**MIC CH1 Level**: Channel 1 recording level

<table>
<thead>
<tr>
<th>Setting</th>
<th>Knob</th>
</tr>
</thead>
<tbody>
<tr>
<td>Side1</td>
<td>LEVEL (CH1) knob</td>
</tr>
<tr>
<td>Front</td>
<td>MIC LEVEL control</td>
</tr>
<tr>
<td>Front+Side1</td>
<td>LEVEL (CH1) knob and MIC LEVEL control (linked operation)</td>
</tr>
</tbody>
</table>

**MIC CH2 Level**: Channel 2 recording level

<table>
<thead>
<tr>
<th>Setting</th>
<th>Knob</th>
</tr>
</thead>
<tbody>
<tr>
<td>Side2</td>
<td>LEVEL (CH2) knob</td>
</tr>
<tr>
<td>Front</td>
<td>MIC LEVEL control</td>
</tr>
<tr>
<td>Front+Side2</td>
<td>LEVEL (CH2) knob and MIC LEVEL control (linked operation)</td>
</tr>
</tbody>
</table>

**Note**
When you have operation of the MIC LEVEL control and LEVEL (CH1/CH2) knobs linked together, if the LEVEL (CH1/CH2) controls are set to 0, the audio signals on channels 1 and 2 cannot be recorded. Check the position of the LEVEL (CH1/CH2) knobs before adjusting the MIC LEVEL control.

**Recording Audio on Channels 3 and 4**

**Selecting the recorded audio**
You can select the audio recorded on audio channels 3 and 4 with the Audio IN CH3/CH4 switches.

<table>
<thead>
<tr>
<th>CH3 switch</th>
<th>Channel 3 recording target</th>
</tr>
</thead>
<tbody>
<tr>
<td>FRONT</td>
<td>Front microphone audio</td>
</tr>
<tr>
<td>REAR</td>
<td>Audio signal input to AUDIO IN CH-1 connector</td>
</tr>
<tr>
<td>WIRELESS</td>
<td>Wireless microphone audio</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>CH4 switch</th>
<th>Channel 4 recording target</th>
</tr>
</thead>
<tbody>
<tr>
<td>FRONT</td>
<td>Front microphone audio</td>
</tr>
<tr>
<td>REAR</td>
<td>Audio signal input to AUDIO IN CH-2 connector</td>
</tr>
<tr>
<td>WIRELESS</td>
<td>Wireless microphone audio</td>
</tr>
</tbody>
</table>

You can have the selection made automatically, as follows.

**To automatically select the same audio as on channels 1 and 2**
Set MAINTENANCE >Audio >Audio CH3/4 Mode of the setup menu to [Ch 1/2].

**Adjusting the audio recording levels**

**To adjust automatically**
Set the AUDIO SELECT CH 3-4 switch to AUTO.

**To adjust manually**

1 Set the AUDIO SELECT CH 3-4 switch to MANUAL.

2 Select the knobs that adjust the audio levels with the Audio CH3 Level and Audio CH4 Level items under MAINTENANCE >Audio in the setup menu.

**Audio CH3 Level**: Channel 3 recording level

<table>
<thead>
<tr>
<th>Setting</th>
<th>Knob</th>
</tr>
</thead>
<tbody>
<tr>
<td>Side3</td>
<td>LEVEL (CH3) knob</td>
</tr>
<tr>
<td>Front</td>
<td>MIC LEVEL control</td>
</tr>
<tr>
<td>Front+Side3</td>
<td>LEVEL (CH3) knob and MIC LEVEL control (linked operation)</td>
</tr>
</tbody>
</table>

**Audio CH4 Level**: Channel 4 recording level
You can now adjust the levels of audio channels 3 and 4 with the knobs selected here.

### Setting the Time Data

<table>
<thead>
<tr>
<th>Setting</th>
<th>Knob</th>
</tr>
</thead>
<tbody>
<tr>
<td>Side4</td>
<td>LEVEL (CH4) knob</td>
</tr>
<tr>
<td>Front</td>
<td>MIC LEVEL control</td>
</tr>
<tr>
<td>Front+Side4</td>
<td>LEVEL (CH4) knob and</td>
</tr>
<tr>
<td></td>
<td>MIC LEVEL control (linked operation)</td>
</tr>
</tbody>
</table>

**Note**

When picture cache mode is enabled, it is not possible to set time data, even if you set the F-RUN/SET/R-RUN switch to SET. If you want to set time data, first exit picture cache mode.

### Setting the Timecode

This sets the recording timecode. In 3D record mode, the same timecode is recorded to both left and right media. The timecode setting range is from 00 : 00 : 00 : 00 to 23 : 59 : 59 : 29 (hours : minutes : seconds : frames).

1. Set the DISPLAY switch to TC.
2. Set the PRESET/REGEN/CLOCK switch to PRESET.
3. Set the F-RUN/SET/R-RUN switch to SET. The first (leftmost) digit of timecode flashes.
4. Use the up and down arrow buttons to change values, and use the left and right arrow buttons to move the flashing digit. Repeat until all digits are set.
   To reset the timecode value to 00:00:00:00 Press the RESET/RETURN button.
5. Set the F-RUN/SET/R-RUN switch to F-RUN or R-RUN.
   - **F-RUN**: Free run. The timecode generator keeps running.
   - **R-RUN**: Recording run. The timecode generator runs only while recording.

**Note**

If recording in 3D with the switch set to R-RUN, recording continues to right media when the remaining capacity in left media runs out. When this occurs, only the right timecode advances. When recording to right media stops, the left timecode is synchronized to the right timecode.
To set the drop frame mode/non-drop frame mode
You can select the drop frame (DF) mode or non-drop frame (NDF) mode on MAINTENANCE >Timecode in the setup menu.

To make the timecode consecutive
When the F-RUN/SET/R-RUN switch is set to R-RUN, recording a number of scenes on the media normally produces consecutive timecode. However, once you remove the media and record on another media, the timecode will no longer be consecutive when you use the original media again for recording. In this case, to make the timecode consecutive, set the PRESET/REGEN/CLOCK switch to REGEN.

Saving the real Time in the Timecode
Setting the PRESET/REGEN/CLOCK switch to CLOCK saves the real time in the timecode. When it is necessary to set the actual time, use MAINTENANCE >Clock Set >Date/Time in the setup menu.

For details, see “Setting the Date/Time of the Internal Clock” (page 45).

Note
If recording in 2D using Slow & Quick Motion mode, the timecode is generated using R-RUN even if the switch is set to CLOCK.

**Setting the User Bits**

By setting the user bits (up to 8 hexadecimal digits), you can record user information such as the date, time, or scene number on the timecode track.

1. **Set the DISPLAY switch to U-BIT.**
2. **Set the F-RUN/SET/R-RUN switch to SET.**
   The first (leftmost) digit flashes.
3. **Use the up and down arrow buttons to change values, and use the left and right arrow buttons to move the flashing digit. Repeat until all digits are set.**
   To reset the user bit data to 00 00 00 00
   Press the RESET/RETURN button.

4. **Set the F-RUN/SET/R-RUN switch to F-RUN or R-RUN, corresponding to the desired operating mode for the timecode generator.**

To store the user bit setting in memory
The user bit setting (apart from the real time) is automatically retained in memory even when the power is turned off.

**Synchronizing the Timecode**

You can synchronize the internal timecode generator of this camcorder with an external generator for the regeneration of an external timecode. You can also synchronize the timecode generators of other camcorders/VTRs with the internal generator of this camcorder.

**Connections for timecode synchronization**

Connect both the reference video signal and the external timecode as illustrated below.

**Example 1: Synchronizing with an external timecode**

1. GENLOCK IN connector
2. TC IN connector
Example 2: Interconnecting a number of camcorders (including one reference camcorder)

To lock the timecode to an external source

1. Turn on the POWER switch.
2. Set the PRESET/REGEN/CLOCK switch to PRESET.
3. Set the F-RUN/SET/R-RUN switch to F-RUN.
4. Set the DISPLAY switch to TC.
5. Supply a timecode signal and a reference video signal complying with the SMPTE standard and in proper phase relationship, to the TC IN connector and to the GENLOCK IN connector, respectively.

This operation synchronizes the internal timecode generator with the external timecode. After about 10 seconds, you can disconnect the external timecode without losing the synchronization.

Notes

- When you finish the above procedure, the internal timecode is immediately synchronized with the external timecode and the counter display will show the value of the external timecode. However, wait for a few seconds until the sync generator stabilizes before recording.
- If the frequency of the reference video signal is not the same as the system frequency of the camcorder, the camcorder cannot be correctly genlocked. In such a case, the internal timecode is not correctly synchronized with the external timecode.

User bit settings during timecode synchronization

When the timecode is synchronized, only the time data is synchronized with the external timecode value.

To release the timecode synchronization

First disconnect the external timecode, then set the F-RUN/SET/R-RUN switch to R-RUN.

To change the power supply from the battery pack to an external power supply during timecode synchronization

To maintain a continuous power supply, connect the external power supply to the DC IN connector before removing the battery pack. You may lose timecode synchronization if you remove the battery pack first.

Camcorder synchronization during timecode synchronization

During timecode synchronization, the camcorder is genlocked to the reference video signal input from the GENLOCK IN connector.
Checking Camcorder Settings and Status Information (Status Screens)

The status screens allow you to check camcorder settings and various types of status information. There are five status screens, listed below.

<table>
<thead>
<tr>
<th>Status screen</th>
<th>Information displayed</th>
</tr>
</thead>
<tbody>
<tr>
<td>CAMERA status</td>
<td>Settings and status information related to shooting</td>
</tr>
<tr>
<td>AUDIO status</td>
<td>Settings and status information related to audio input and output</td>
</tr>
<tr>
<td>VIDEO status</td>
<td>Settings and status information related to recording and playback</td>
</tr>
<tr>
<td>ASSIGN SWITCH status</td>
<td>Names of functions assigned to assignable switches</td>
</tr>
<tr>
<td>BATTERY/MEDIA status</td>
<td>Status of the battery mounted on the camcorder and the media status</td>
</tr>
</tbody>
</table>

To display status screens
With no menu is displayed, push the STATUS ON/SEL/OFF switch up to the ON/SEL side. Each push selects the next status screen, in the order given in the table above.

CAMERA status screen
This screen displays settings and status information related to shooting.

<table>
<thead>
<tr>
<th>White Bal</th>
<th>Gain</th>
<th>Zoom Speed</th>
<th>Skin Detail</th>
</tr>
</thead>
<tbody>
<tr>
<td>B: 12000K</td>
<td>L: 0dB</td>
<td>70</td>
<td>OFF</td>
</tr>
<tr>
<td>A: 4700K</td>
<td>M: 9dB</td>
<td></td>
<td></td>
</tr>
<tr>
<td>PRST: 3200K</td>
<td>H: 18dB</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

White Bal: White balance status
Gain: GAIN switch status
Zoom Speed: Zoom speed set with the lens ZOOM button
Zebra: Zebra status
Skin Detail: Skin details status

AUDIO status screen
This screen displays settings and status information related to audio input and output.

<table>
<thead>
<tr>
<th>CH-1/CH-2/CH-3/CH-4</th>
<th>Wind Filter</th>
</tr>
</thead>
<tbody>
<tr>
<td>CH-1</td>
<td>Front: Off</td>
</tr>
<tr>
<td>CH-2</td>
<td>Front: Off</td>
</tr>
<tr>
<td>CH-3</td>
<td>WRR: On</td>
</tr>
<tr>
<td>CH-4</td>
<td>Rear: On</td>
</tr>
</tbody>
</table>

CH-1/CH-2/CH-3/CH-4: Audio level meters and input sources
Wind Filter: Wind filter settings

VIDEO status screen
This screen displays settings and status information related to recording and playback.

<table>
<thead>
<tr>
<th>Video Format</th>
<th>Rec Mode</th>
<th>Output</th>
<th>SDI Output(L)</th>
<th>SDI Output(R)</th>
<th>HDMI Output</th>
<th>Down Converter</th>
</tr>
</thead>
<tbody>
<tr>
<td>HD 1080/60i</td>
<td>HS/1920</td>
<td>HD</td>
<td>Side By Side</td>
<td>Off</td>
<td>Off</td>
<td>Squeeze</td>
</tr>
</tbody>
</table>

Video Format: Video format
Rec Mode: Recording bit rate
Output: Output signal setting
SDI Output (L): HD/SD SDI OUT(L) connector output setting
SDI Output (R): HD/SD SDI OUT(R) connector output setting
HDMI Output: HDMI connector output setting
Down Converter: SD output down converter setting

ASSIGN SWITCH status screen
This screen displays the names of the functions assigned to assignable switches.

ASSIGN SWITCH

0: Off
1: Freeze Mix
2: Off
3: Color Temp SW3200K
4: Rec Review
5: Off
6: Depth Warning

ASSIGN SWITCH

0: Off
1: Return Video
2: Off
3: Color Temp SW3200K
4: Rec Review
5: Off
6: Depth Warning
**BATTERY/MEDIA status screen**

This screen displays the status of the battery mounted on the camcorder and the media status.

<table>
<thead>
<tr>
<th>BATTERY/MEDIA</th>
<th>S/S</th>
</tr>
</thead>
<tbody>
<tr>
<td>Battery</td>
<td></td>
</tr>
<tr>
<td>HDD A</td>
<td></td>
</tr>
<tr>
<td>HDD B</td>
<td></td>
</tr>
<tr>
<td>Media A</td>
<td>120min</td>
</tr>
<tr>
<td>Media B</td>
<td>60min</td>
</tr>
</tbody>
</table>

**Battery**: The remaining battery capacity

**Charge Count**: The number of times the battery has been charged

**Media A/Media B**:
- Remaining capacity of media
- Recordable time
- Approximate writable lifetime (Life)
  “Life 100%” is shown for unused media.
Handling SxS Memory Cards

This camcorder records video and audio on SxS memory cards (not supplied) loaded into one or both of its memory card slots.

The MEAD-MS01/SD01 Media Adaptor can also be used for recording. For details, refer to the Supplement supplied in the CD-ROM (labeled “Manuals for Solid-State Memory 3D Camcorder”).

About SxS Memory Cards

SxS memory cards that can be used with this camcorder

Use the following Sony SxS memory cards (SxS PRO or SxS-1) with this camcorder.

SxS PRO
- SBP-16 (16 GB)
- SBP-32 (32 GB)

SxS-1
- SBS-32G1A (32 GB)
- SBS-64G1A (64 GB)

Proper operation cannot be guaranteed when memory cards other than SxS PRO and SxS-1 are used.

The memory cards listed above comply with the ExpressCard memory card standard.
- SxS, SxS PRO and SxS-1 are trademarks of Sony Corporation.
- The ExpressCard label and logo are property of the Personal Computer Memory Card International Association (PCMCIA) and are licensed to Sony Corporation. Other trademarks and trade names are the property of their respective owners.

Notes on the use of SxS memory cards

- Recorded data may be lost or corrupted in the following cases.
  - When the camcorder is subjected to shock or vibrations during reading, writing, or formatting of an SxS memory card, and when the camcorder is powered off or an SxS memory card is removed during reading, writing, or formatting
  - When the camcorder is used in an environment subject to static electricity or electric noise
- Do not use or store SxS memory cards in locations that are:
  - Outside the specified environmental ranges
  - Very hot, such in as vehicles parked in the sun during summer, or exposed to direct sunlight, or near heaters
  - Subject to high humidity and corrosion
- When inserting a memory card, insert with the label side facing the correct direction.
- Carry and store SxS memory cards in their cases, and lock the cases securely.

- Guard against accidents and inadvertent data loss by backing up the data stored on SxS memory cards. Sony cannot be responsible for any consequences of damage to or loss of data stored on SxS memory cards.
- Do not attach anything other than the supplied labels in the designated label space. When attaching a label, make sure it does not protrude beyond the label space.
Handling SxS Memory Cards

Chapter 4  Shooting

Use this camcorder to format SxS memory cards that will be used with this camcorder. When memory cards are formatted on another unit, the format is regarded as an invalid format, making it necessary to format the memory cards again.

However, note that the format and delete functions of this camcorder do not completely remove data from memory cards. Before discarding or disposing of a memory card, erase it using commercial data erasure software, or physically destroy it. Sony cannot be responsible for any failure to erase data completely.

Clip operations may not be possible when the remaining capacity of the media is low. In this case, use a computer to delete unneeded files and try again.

Open the memory card case completely before storing a card in the case or removing a card from the case.

Preventing accidental erasure

You can prevent accidental recording, editing, and deletion of data on an SxS memory card by setting the write protect switch to the WP side.

Write protect switch

Lighting of the ACCESS lamp

Insert with the label side facing right.

The ACCESS lamp lights in orange, and then lights in green to indicate that the memory card is usable.

3 Close the cover.

ACCESS lamp status indications

Card slots each have an ACCESS lamp to indicate the slot status.

<table>
<thead>
<tr>
<th>Lamp</th>
<th>Slot status</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lights in orange</td>
<td>Accessing the SxS memory card (lights during data reading and writing)</td>
</tr>
<tr>
<td>Lights in green</td>
<td>Standby (the loaded SxS memory card is ready for recording or playback)</td>
</tr>
<tr>
<td>Not lit</td>
<td>• No SxS memory card is loaded.</td>
</tr>
<tr>
<td></td>
<td>• An unusable card is loaded.</td>
</tr>
<tr>
<td></td>
<td>• An SxS memory card is loaded, but the other slot is selected.</td>
</tr>
</tbody>
</table>

To load SxS memory cards

1 Slide the cover to the left to open.

2 Insert an SxS memory card into a card slot.

3 Close the cover.

Note

Do not touch the write protect switch while an SxS memory card is loaded in a card slot. Eject the card before setting the write protect switch.
To eject SxS memory cards

1 Open the cover, and then press the EJECT button to release the lock and pull the button out.

Note
Data integrity cannot be guaranteed if you power the camcorder off or remove a memory card while the card is being accessed. Doing so may corrupt all data recorded on the card. Always make sure that the ACCESS lamp is lit green or not lit before you power the camcorder off or remove a memory card.

2 Press the EJECT button again to eject the card.

Selecting the SxS Memory Card to Use

Switching using the SLOT SELECT button
You can switch between slot A and slot B using the SLOT SELECT button. Both left and right slots are switched.

Note
If only one memory card is inserted in the left slots (A or B), you cannot switch between slots using the SLOT SELECT button, except under the following conditions.
• When recording to media in the right slots
• When displaying the all clip thumbnails screen for media in right slots

If there is no memory card inserted in either left slots and memory cards are inserted in both right slots (A and B), then pressing the SLOT SELECT button will switch between slot A and slot B on the right side.

Switching when a memory card is full
If a memory card becomes full while recording, the camcorder automatically switches between slots A and B. If recording to both left and right slots, slots A and B are switched on both the left and right sides.

When memory card is full on one side only
When recording to the A slots on both the left and right sides and either of these memory cards becomes full, the camcorder switches and continues recording to the B slots if there is recordable media in both B slots. If either of the memory cards in the B slots on the left or right side is not recordable, then either recording continues on the slot A card that is not full or recording stops on both left and right sides, according to the setting using OPERATION >Format >3D Single Rec in the setup menu.

When recording to memory cards on one side only
When recording to slot A on the left side and the memory card becomes full, the camcorder switches recording to slot B on the left side if the memory card is recordable. If the only recordable memory card is in slot B on the right side, recording stops.
The SLOT SELECT button is disabled during playback. Even when pressed, it does not change the selected slot. Button operations are enabled when a thumbnail screen (see page 89) is displayed.

**Formatting (Initializing) SxS Memory Cards**

When you load an unformatted SxS memory card, or load an SxS memory card that has been formatted to other specifications, a message “Cannot Use Media(A)/Unsupported File System” appears in the viewfinder. In this case, format the memory card in the following way.

**Note**

SxS memory cards must be formatted on an XDCAM EX device. Cards in other formats cannot be used.

**To format (initialize) a memory card**

1. Select OPERATION > Format Media in the setup menu (see page 105).
2. Select the slot to format.
3. Turn the MENU knob to select [Execute], and then press the knob. The confirmation message for formatting is displayed on the viewfinder screen.
4. Turn the MENU knob to select “Execute”, and press the knob. Execution of the format starts.

During execution of the format, a progress indication appears (%), and the ACCESS lamp lights in orange.

**Recording and playback during format execution**

Even during execution of a format, recording and playback are possible using an SxS memory card loaded into the other card slot.

**If the format operation fails**

A format operation may fail because the SxS memory card is write protected, or because it is not the type of card specified for use with this camcorder.

In this case, an error message appears. Following the instructions in the error message and exchange the card for an SxS memory card that can be used with this camcorder.

**Notes**

- All data is erased when you format a memory card, including setup files and all of the recorded video data.
- Use the format function of this camcorder to format SxS memory cards for use on this camcorder. The formats of cards formatted on other devices are not recognized as valid formats, making it necessary to format them again on this camcorder.

**Checking the Remaining Recording Time**

You can check the remaining capacity of the SxS memory cards loaded in the A and B slots by checking the recording media remaining capacity display in the viewfinder.

The camcorder calculates the remaining recording time for the media in each slot on the basis of the current video format (recording bit rate), and displays it in units of minutes. When media is inserted in both the left and right slots, and the camcorder is recording or can record to both, the left or right media with the lower remaining recording time is displayed. When the camcorder is recording or can record to left slots or right slots only, the remaining recording time for that media is displayed.

You can also check the remaining time in the BATTERY/MEDIA status screen (see page 69).

**Note**

The mark appears when a memory card is write protected.

**When to exchange SxS memory cards**

During recording, a “Media Near Full (Left)” or “Media Near Full (Right)” warning message appears, the WARNING indicator and the REC indicator on the viewfinder screen flash, and the buzzer sounds when the remaining recording time of the memory cards falls below five minutes. Exchange the memory card for media with available recording capacity.

If you continue recording, a “Media Full (Left)” or “Media Full (Right)” message appears and

---

**Chapter 4: Shooting**

**Handling SxS Memory Cards** 73
recording stops when the remaining recording time falls to 0.
The method for determining the remaining recording time is different in 3D record mode and 2D record mode.

**3D record mode**
In 3D record mode, the 3D remaining recording time for both slots A and B is first calculated. The warning display when the 3D remaining recording time falls below 5 minutes or when it reaches 0 is based on the remaining recording time of the media in left and right slots.

**2D record mode**
The warning display is based on the calculation of the total of the remaining recording time for both slots A and B on each side (left and right).

**Note**
About up to 600 clips can be recorded on one SxS memory card.
The display of remaining recording time changes to “0” and the message “Media Full” appears when the clip limit is reached.

### Restoring SxS Memory Cards

If for any reason an error should occur in a memory card, the card must be restored before use.
When you load an SxS memory card that needs to be restored, a message appears in the viewfinder to ask whether you want to restore it.

**To restore a card**

Turn the MENU knob to select “Execute”, and then press the knob.
The restoration starts.
During the restoration, a execution message appears, the progress is displayed (%), and the ACCESS lamp lights in orange.
When the restoration finishes, a completion message is displayed for three seconds.

**If restoration fails**
- Write protected SxS memory cards and cards on which memory errors have occurred cannot be restored. A warning message appears for such cards. Follow the instructions in the message and unprotect the card or replace it with another card.
- SxS memory cards on which memory errors have occurred may become usable if they are reformatted.
- In some cases, some clips can be restored while others cannot. The restored clips can be played normally.
- If the message “Could not Restore Some Clips” keeps appearing after repeated attempts at restoration, it may be possible to restore the SxS memory card with the following procedure.

1. Use the camcorder’s copy function *(see page 96)* or the supplied application software *(see page 154)* to copy the required clips to another SxS memory card.
2. Format the unusable SxS memory card on the camcorder.
3. Copy the required clips back to the newly formatted SxS memory card.

**Recording and playback during restoration**

Even while restoration is in progress, you can record and play an SxS memory card in the other card slot.

**Note**

For restoration of media recorded with this camcorder, be sure to use this camcorder. Media recorded with a device other than this camcorder or with another camcorder of different version (even of the same model) may not be restored using this camcorder.
Basic Operations

This section explains the basic shooting and recording procedures. Before starting to shoot, inspect the camera system to verify that it is operating properly.

1. Attach a fully charged battery pack (see page 37).

2. Load one or two SxS memory cards (see page 71).
   - When recording in 3D, insert memory cards in both the left and right slots. If memory cards are inserted in both slots A and B, the camcorder automatically switches to the second card when the first card becomes full.

3. Set the camcorder’s POWER switch (see page 18) to ON.

4. Make the following settings.
   - 3D/2D: 3D or 2D (see page 52)
   - Marker display: On (see page 113)
   - Iris: Auto (see page 58)
   - Zoom: Auto (see page 59)
   - Camera output: Select the picture currently being shot (camera picture), and turn the DCC function on (see page 24)
   - Timecode advance mode: F-RUN (Free Run) or R-RUN (Rec Run) (see page 65)
   - Audio input channel selection: Auto (see page 31)

5. Push the AUTO W/B BAL switch to the BLACK side to adjust the black balance (see page 53).

6. Select a filter according to the lighting conditions, and adjust the white balance (see page 54).

7. Point the camcorder at the subject, and adjust the focus (see page 60) and zoom.

8. When recording in 3D, adjust the convergence (see page 61).

9. If you are using the electronic shutter, select an appropriate shutter mode and speed (see page 56).

10. Do one of the following to start recording.
    - Press the REC START button (see page 22).
    - Press the VTR button (see page 20).
    - Turn on the assignable switch to which the Rec function has been assigned (see page 143).

   During recording, the TALLY indicators, the tally indicator on the front panel of the viewfinder, and the REC indication on the viewfinder screen light. Adjust the zoom and focus as required.

Notes

- Never remove the battery pack while the camcorder is recording (while the ACCESS lamp on the right-side panel is lit in blue and the ACCESS lamp in the card slot section is lit in orange). Doing so risks the loss of several seconds of data before the recording was interrupted, because internal processing will not end normally.
- The playback control buttons (EJECT, F REV, F FWD, NEXT, PREV, PLAY/PAUSE, STOP) do not function during recording.

11. To stop recording, perform one of the operations listed in step 9.
    - The TALLY indicators, the tally indicator on the front panel of the viewfinder, and the REC indication on the viewfinder screen go out, and camcorder enters recording standby (STBY) mode.
    - A clip is created from the video and audio data and the metadata recorded between steps 9 and 10.

To check the recording (recording review)

With the camcorder in recording standby (STBY) mode, turn on the assignable switch to which the Rec Review function or the Freeze Mix function has been assigned (see page 142).

The camcorder plays the entire last clip, or the last few seconds of that clip (3 seconds or 10 seconds), and then returns to standby mode.
You can use MAINTENANCE > Camera Config > Rec Review in the setup menu (see page 134) to change the playback time. When the Rec Review function is assigned to the RET button, you can also conduct a review by using the RET button.

12 Repeat steps 9 and 10 to continue recording.
With each repetition, another clip is created on the memory card.

```
Clip 1  Clip 2  Clip 3
REC START  REC STOP/START  REC START
```

Notes
- You cannot resume recording for about one second after stopping recording.
- The maximum number of clips that can be recorded on one memory card is 600. Even if the memory card has enough free capacity to record more clips, when 600 clips have been recorded, no further recording is possible.

Clip file sizes
The XDCAM EX-series products limit the maximum file size of a clip to 4 GB.
If you continue recording for an extended period, recorded materials may be segmented into multiple files, depending on the file size (the maximum number of partitions is 99). The camcorder regards continuous recording as one clip even if it has been segmented into multiple files.

Clip names
The camcorder automatically furnishes a nine-character clip name (for 3D clips) or eight-character clip name (for 2D clips) to each recorded clip.

Example: ABCD001L
**ABCD:** Four-character alphanumeric prefix. You can change the prefix to an arbitrary length (4 to 46 characters) using OPERATION > Clip > Title Prefix in the setup menu. (The prefix cannot be changed after recording begins.)
**0001:** Four-digit number that automatically increments as each clip is recorded. When recording in 3D, the media in the left slots and right slots are compared, and the larger number of the two is appended to both clips.
**L:** When recording in 3D, “L” is appended to left image clips and “R” to right image clips.
When recording to 2D, no suffix is added.

### Playing Recorded Clips

When the camcorder is in standby (STBY) mode, you can play all or part of the most recently recorded clip (see page 75).

1 Insert the SxS memory card to play (see page 71).
2 Press the PREV button (see page 26) or the F REV button (see page 26) to cue up the clip to play.
3 Press the PLAY/PAUSE button.
The PLAY/PAUSE indicator lights, and the playback picture appears in the viewfinder.

**To pause the playback**
Press the PLAY/PAUSE button.
The PLAY/PAUSE indicator flashes during pause.
Press the button again to return to playback mode.

**To play at high speed**
Press the F FWD button (see page 26) or the F REV button (see page 26).
To return to normal playback, press the PLAY/PAUSE button.

**To switch between memory cards**
When memory cards are loaded in both slots A and B, press the SLOT SELECT button (see page 29) to select the active slot.
It is not possible to switch between memory cards during playback.

**To end playback**
Press the STOP button: Playback stops, and the camcorder enters E-E mode.
Press the THUMBNAIL button: Playback stops, and a thumbnail screen (see page 89) appears in the viewfinder.
Playback also stops and the timecode screen appears in the viewfinder when you start recording during playback, and when you eject an SxS memory card.
Deleting Recorded Clips

You can use the assignable switches to delete the last recorded clips (Last Clip DEL function). For clips recorded in 3D, both the left and right clips are deleted.

You can also use the THUMBNAIL menu to delete all recorded clips (All Clips DEL function) or to delete selected clips. For details, see “Deleting Clips” (page 97).

1. Turn on the assignable switch to which the Last Clip DEL function has been assigned (see page 143).
   A confirmation message appears.

2. Turn the MENU knob to select [Execute], and then press the knob.

Advanced Operations

Recording Shot Marks

On this camcorder, two types of shot marks are available. You can record them at user-specified positions to make it easier for editors to cue up those positions.

You can record up to 127 shot marks per clip. For clips recorded in 3D, shot marks are recorded for clips in left slots only. However, shot marks are recorded for clips in right slots when recording to right slots only in 3D mode using the 3D Single Rec setting or when recording to right slots only in 2D mode.

You can also use the THUMBNAIL menu to add and delete shot marks in clips. For details, see “Adding and Deleting Shot Marks” (page 99).

To record shot marks

Do one of the following.
- Turn on an assignable switch to which Shot Mark 1 or Shot Mark 2 has been assigned (see page 142).
- If Lens RET has been assigned to the RET button, operate as follows.
  To record shot mark 1: Press the RET button once.
  To record shot mark 2: Press the RET button twice in quick succession.

When a shot mark is recorded, a “Shot Mark 1” or “Shot Mark 2” indication appears in the viewfinder for about three seconds near the timecode indication.

Setting OK Marks

To make it easier for editors to select good clips, you can set OK marks in clips.

OK marks are set for clips recorded in both left and right slots.

Note

OK marks cannot be set or deleted during recording or playback.
To add/delete OK marks
You use the THUMBNAIL menu to add and delete OK marks in previously recorded clips. For details, see “Adding and Deleting OK Marks” (page 96).

Starting to Record from Pre-stored Video (Picture Cache Function) (2D mode only)

The camcorder is equipped with enough internal memory to pre-store up to 15 seconds of video and audio data in a picture cache. This allows you to begin recording a specified number of seconds in advance of the time when you press a recording start button.

Note
In 3D mode, the picture cache record function cannot be used.

Selecting picture cache mode and setting the picture cache time
Before recording in picture cache mode, you must select picture cache mode and set the picture cache time (the number of seconds of video and audio data stored to memory) in the OPERATION menu.

The picture cache time determines how far in advance you can start recording, counting back in seconds from the operation that starts recording. Note that it may not be possible to start this far in advance in the special cases explained in the following notes.

Notes
- Storage of picture data to memory begins when you select picture cache mode. Therefore, if you start recording immediately after selecting picture cache mode, the picture data from before the selection is not recorded.
- No data is recorded to picture cache memory during playback or recording review and display of thumbnails. It is not possible to record picture data from the time you were conducting playback or a recording review.

To select picture cache mode and set the picture cache time

Notes
- Picture cache recording is not possible in Frame Rec, Interval Rec, and Slow & Quick Motion mode. The camcorder exits Frame Rec, Interval Rec, or Slow & Quick Motion mode whenever you select picture cache mode. The camcorder exits picture cache mode automatically whenever you select Frame Rec, Interval Rec, or Slow & Quick Motion mode.
- The data stored in picture cache memory is cleared when you change the system settings, for example by selecting a different video format. Picture data from before the change is not recorded even if you start recording immediately after the change. The camcorder exits picture cache mode automatically.
- It is not possible to set the picture cache time during recording.

1 In the setup menu, select OPERATION >Rec Function >Picture Cache Rec.
   For menu operations, see “Basic Setup Menu Operations” (page 101).
2 Turn the MENU knob to select [On], and then press the knob.
3 Select [P. Cache Rec Time], turn the MENU knob to select the desired picture cache time, and then press the knob.
   You can select from 0-2sec, 2-4sec, 4-6sec, 6-8sec, 8-10sec, 10-12sec, 12-14sec, and 13-15sec.

Once made, picture cache mode settings remain in effect until changed. Instead of carrying out steps 1 and 2, you can also select picture cache mode by using an assignable switch to which the Picture Cache function has been assigned (see page 142).

Camcorder data handling while recording in picture cache mode
Recording procedures in picture cache mode are basically the same as normal recording procedures. However, note the following differences with respect to how the camcorder handles video, time, and output data.
- If you start recording while the media is being accessed, the start point of the video that is actually recorded may be later than the currently specified picture cache time. Because the delay increases as the number of recorded clips increases, you should avoid rapid start-and-stop recording operations in picture cache mode.
Regardless of the setting of the F-RUN/SET/R-RUN switch, the advance mode of the internal timecode generator is always F-RUN.

In picture cache mode, you cannot set time data by setting the F-RUN/SET/R-RUN switch to SET. To set time data, exit picture cache mode.

If the remaining free capacity of the media in the currently selected slot is less than the picture cache time, and the media in the other slot has enough remaining capacity, then data is recorded to the media in the other slot. However, no data is recorded when there is no media in the other slot, and when the media in the other slot does not have enough remaining capacity. (A message appears in the viewfinder to inform you that there is not enough remaining capacity.)

Shot marks are not recorded if they are set before the recording start operation.

If power is lost during recording

- If you set the camcorder’s POWER switch to OFF, the camcorder is powered off automatically after a few seconds, during which the media is accessed to record the video and audio data stored in the camcorder’s memory up to that point.
- If power is lost because the battery was removed, the DC cable was disconnected, or the power was turned off on the AC adaptor side, then the video and audio data stored in memory is lost. The data stored in memory is not recorded. Be careful to avoid this when exchanging the battery.

Recording Time-lapse Video (Interval Rec Function)

The camcorder’s Interval Rec function allows you to capture time-lapse video to the camcorder’s internal memory. This function is an effective way to shoot slow-moving subjects. When you start recording, the camcorder automatically records a specified number of frames at a specified interval time.

A pre-lighting function is available when Interval Rec is enabled. This function automatically turns on a video light before recording starts, which allows you to record pictures under stable light and color temperature conditions.

Interval Rec settings and shooting

Notes

- The Interval Rec function cannot be used at the same time as the picture cache, Frame Rec, or Slow & Quick Motion function. When you select Interval Rec mode, the picture cache, Frame Rec, and Slow & Quick Motion functions are disabled. When you select picture cache, Frame Rec, or Slow & Quick Motion mode, the Interval Rec function is disabled.
- The data stored in picture cache memory is cleared when you change the system settings, for example by selecting a different video format. Picture data from before the change is not recorded even if you start recording immediately after the change. The camcorder exits picture cache mode automatically.
- Interval Rec settings cannot be changed during recording.

To make Interval Rec settings

1. Select OPERATION >Rec Function >Interval Rec in the setup menu.
   For menu operations, see “Basic Setup Menu Operations” (page 101).

2. Turn the MENU knob to select [On], and then press the knob.
   The camcorder enters Interval Rec mode, the “Interval” indication on the viewfinder screen flashes.
3 Select [Number of Frames], turn the MENU knob to select the number of frames to record in one take, and then press the knob.
You can select from 1, 3, 6, 9 (or from 2, 6, 12 when the video format setting is 720/59.94P or 720/50P).

4 Select [Interval Time], turn the MENU knob to select the desired interval, and then press the knob.
You can select 1 to 10/15/20/30/40/50 sec, 1 to 10/15/20/30/40/50 min, 1 to 4/6/12/24 hour.

5 As required, select [Pre-Lighting], turn the MENU knob to select the length of lighting time before recording starts, and then press the knob.
You can select 1 to 10/15/20/30/40/50 sec, 1 to 10/15/20/30/40/50 min, 1 to 4/6/12/24 hour.

Notes
- If you want to turn the video light on before the start of recording, set the camcorder’s LIGHT switch to [AUTO]. The video light’s switch must also be turned on. When this is done, the video light turns on and off automatically. However, the video light remains lit when the time that it is off is five seconds or less.
- If you set the LIGHT switch to [MANUAL] and turn the video light’s switch on, the video light is always lit. (It does not go on and off automatically.)

The camcorder exits Interval Rec mode when it is powered off, but the number of frames, interval time, and pre-lighting settings are maintained.
You do not need to set them again the next time you shoot in Interval Rec mode.

To shoot in Interval Rec mode
Make the settings and preparations described in “Basic Operations” (page 75), secure the camcorder so that it does not move, and begin shooting.

When recording starts, the “Interval” indication in the viewfinder changes from flashing to lit, and “INT REC” and “INT STBY” appear alternatively at the position of the REC indication. The TALLY indicators and the tally indicator on the front panel of the viewfinder light as they do during normal recording.

If you are using the pre-lighting function, the video light comes on before recording starts.

To stop shooting
Stop the recording.

When shooting ends, the video data stored in memory up to that point is written to the media.

To exit Interval Rec mode
Do one of the following.
- Set the POWER switch to OFF.
- With the camcorder in recording standby mode, set OPERATION >Rec Function >Interval Rec in the setup menu to “Off”.

Limitations during recording
- Regardless of the setting of the F-RUN/SET/R-RUN switch, the advance mode of the internal timecode generator is always F-RUN.
- Audio cannot be recorded.
- Recording review is not possible.
- If you press the SLOT SELECT button, the camcorder completes recording of the specified number of frames, creates a clip, and switches to the other media.
- Genlock is not possible.

If power is lost during recording
- If you set the camcorder’s POWER switch to OFF, the camcorder is powered off automatically after a few seconds, during which the media is accessed to record the video and audio data stored in the camcorder’s memory up to that point.
- If power is lost because the battery was removed, the DC cable was disconnected, or the power was turned off on the AC adaptor side, then the video and audio data shot up to that point may be lost (maximum 10 seconds). Be careful to avoid this when exchanging the battery.

The Frame Rec function is useful for shooting stop motion animations, such as animations with puppets or clay figures.
Each time that you press the recording start button, the camcorder shoots a specified number of frames and then stops.

Shooting Stop Motion Animations (Frame Rec Function)
Frame Rec settings and shooting

Notes

- The Frame Rec function cannot be used at the same time as the picture cache, Interval Rec, or Slow & Quick Motion function. When you select Frame Rec mode, the picture cache, Interval Rec, and Slow & Quick Motion functions are disabled. When you select picture cache, Interval Rec, or Slow & Quick Motion mode, the Frame Rec function is disabled.
- The data stored in memory is cleared when you change the system settings, for example by selecting a different video format. Picture data from before the change is not recorded even if you start recording immediately after the change. The camcorder exits Frame Rec mode automatically.
- Frame Rec settings cannot be changed during recording.

To make Frame Rec settings

1. Select OPERATION >Rec Function >Frame Rec in the setup menu.
   For menu operations, see “Basic Setup Menu Operations” (page 101).

2. Turn the MENU knob to select [On], and then press the knob.
   The camcorder enters Frame Rec mode, the “Frame Rec” indication on the viewfinder screen flashes.

3. Select [Number of Frames], turn the MENU knob to select the number of frames to record in one take, and then press the knob.
   You can select from 1, 3, 6, 9 (or from 2, 6, 12 when the video format setting is 720/59.94P or 720/50P).

The camcorder exits Frame Rec mode when it is powered off, but the setting for the number of frames setting is maintained. You do not need to set it again the next time you shoot in Frame Rec mode.

To shoot in Frame Rec mode

Make the settings and preparations described in “Basic Operations” (page 75), secure the camcorder so that it does not move, and begin shooting.

When recording starts, the “Frame Rec” indication in the viewfinder changes from flashing to lit, and “FRM REC” and “FRM STBY” appear alternatively at the position of the REC indication. The TALLY indicators and the tally indicator on the front panel of the viewfinder light as they do during normal recording.

To stop shooting

Stop the recording.

When shooting ends, the video data stored in memory up to that point is written to the media.

To exit Interval Rec mode

Do one of the following.
- Set the POWER switch to OFF
- With the camcorder in recording standby mode, set OPERATION >Rec Function >Interval Rec in the setup menu to [Off].

Limitations during recording

- Regardless of the setting of the F-RUN/SET/R-RUN switch, the advance mode of the internal timecode generator is always R-RUN.
- Audio cannot be recorded.
- Recording review is not possible.
- If you press the SLOT SELECT button, the camcorder completes recording of the specified number of frames, creates a clip, and switches to the other media.
- Genlock is not possible.

If power is lost during recording

- If you set the camcorder’s POWER switch to OFF, the camcorder is powered off automatically after a few seconds, during which the media is accessed to record the video and audio data stored in the camcorder’s memory up to that point.
- If power is lost because the battery was removed, the DC cable was disconnected, or the power was turned off on the AC adaptor side, then the video and audio data shot up to that point may be lost (maximum 10 seconds). Be careful to avoid this when exchanging the battery.
Shooting with Slow & Quick Motion

When the camcorder is in HD mode and the video format (see page 51) is set to one of the formats listed below, you can specify a recording frame rate that is different from the playback frame rate.

When the Country setting is [NTSC Area]/[NTSC Area(J)]: HQ 1920/29.97P, HQ 1920/23.98P, HQ 1280/59.94P, HQ 1280/29.97P, HQ 1280/23.98P

When the Country setting is [PAL Area]: HQ 1920/25P, HQ 1280/50P, HQ 1280/25P

By shooting with a frame rate that differs from the playback frame rate, you can obtain slow and quick motion effects that are smoother than low-speed or high-speed playback of content recorded at the normal frame rate.

Example
When the video format is HQ 1280/23.98P, you can obtain quick-motion effects by setting the frame rate to 1 to 23, and obtain slow-motion effects by setting the frame rate to 25 to 60.

Slow & Quick Motion settings and shooting

Notes
- The Slow & Quick Motion function cannot be used at the same time as the picture cache, Interval Rec, or Frame Rec function. When you select Slow & Quick Motion mode, the picture cache, Interval Rec, and Frame Rec functions are disabled. When you select picture cache, Frame Rec, or Interval Rec mode, the Slow & Quick Motion function is disabled.
- Slow & Quick Motion is disabled when the slow shutter function (viewfinder display “SLS”) function is enabled. The slow shutter function is disabled when the Slow & Quick Motion function is enabled.
- Slow & Quick Motion settings cannot be changed during recording.
- The left slot and right slot shutter timing may vary when recording to both left and right slots in 2D mode.

To make Slow & Quick Motion settings

1. Select OPERATION >Rec Function >Slow & Quick in the setup menu.

For menu operations, see “Basic Setup Menu Operations” (page 101).

2. Turn the MENU knob to select [On], and then press the knob.

The camcorder enters Slow & Quick Motion mode, and the “S&Q STBY” indication in the viewfinder lights.

3. Select [Frame Rate], turn the MENU knob to select the recording frame rate, and then press the knob.

The setting range for the frame rate is as follows.

<table>
<thead>
<tr>
<th>3D/2D</th>
<th>System lines</th>
<th>Frame rate</th>
</tr>
</thead>
<tbody>
<tr>
<td>2D</td>
<td>1080</td>
<td>1 to 30</td>
</tr>
<tr>
<td></td>
<td>720</td>
<td>1 to 60</td>
</tr>
<tr>
<td>3D</td>
<td>1080</td>
<td>17 to 30</td>
</tr>
<tr>
<td></td>
<td>720</td>
<td>17 to 60</td>
</tr>
</tbody>
</table>

When you finish making these settings, the system frequency and the frame rate appear at the top of the viewfinder screen. You can change the frame rate while viewing the display in the viewfinder by turning the MENU knob. The Slow & Quick Motion mode setting and the frame rate are retained even after the camcorder is powered off.

To shoot in Slow & Quick Motion mode
Shoot as described in “Basic Operations” (page 75).

When recording starts, the “S&Q STBY” indication in the viewfinder changes to the “● S&Q REC” indication. The TALLY indicators and the tally indicator on the front panel of the viewfinder light as they do during normal recording.

To stop shooting
Stop the recording.

Note
It takes longer than normal for recording to stop when Frame Rate is set to a low value (for a slow frame rate).

To exit Slow & Quick Motion mode
With the camcorder in recording standby mode, set OPERATION >Rec Function >Slow & Quick in the setup menu to “Off”.

Limitations during recording
- Regardless of the setting of the F-RUN/SET/R-RUN switch, the advance mode of the internal timecode generator is always R-RUN.
- Audio cannot be recorded when the recording and playback frame rates differ.
• Recording review is not possible.
• If you change the recording frame rate to a value faster than the current shutter speed, the shutter speed is changed to the slowest value for which shooting is possible.
  Example: If the frame rate is 32 and the shutter speed is 1/40, and you change the frame rate to 55, then the shutter speed is changed to 1/60.
  If is not possible to select a shutter speed that is slower than the recording frame rate.
• Genlock is not possible.

### Framing Shots with the Freeze Mix Function

The freeze mix function allows you to temporarily overlap a still image (freeze picture) from a clip onto the current camera picture. This makes it easier to frame the shot.
In 3D mode, an image from the left slot clip overlaps the left-lens input image.

**Note**
The freeze mix function is not available in the following cases.
• When the video formats of the recorded picture and the camera picture differ
• When you are shooting in Slow & Quick Motion mode or slow shutter mode

### To display a freeze mix picture

1. Play a clip or conduct a recording review of a clip with the same format as the camera picture.

2. Display the picture that you want to use as the frame, and then turn on the assignable switch to which the Freeze Mix function has been assigned.
   The recording review picture is frozen and overlaps the camera picture.

**Note**
The following functions are disabled at the freeze mix times.
• Menu operations
• During Focus Mag display
• Marker display
• Zebra display
• Peaking display
• Skin details display

---

**To cancel the freeze mix display**

Do one of the following.
• Press an assignable switch again to which the Freeze Mix function has been assigned.
The freeze mix display is canceled and the display returns to the normal camera picture.
• Start recording (see page 75).
Normal recording starts.
Planning Metadata Operations

Planning metadata is information about shooting and recording plans, recorded in an XML file.

Example of a planning metadata file

You can shoot using clip names and shot mark names defined in advance in a planning metadata file.

Left slots only are used when loading planning metadata files from SxS memory cards or writing planning metadata files to SxS memory cards. Right slots cannot be used.

The camcorder can display clip names and shot mark names defined in the following languages.

- English
- Chinese
- German
- French
- Italian
- Spanish
- Dutch
- Portuguese
- Swedish
- Norwegian
- Danish
- Finnish

1) Some characters are displayed as different but similar characters.

Note

If you define clip name and shot mark names in languages other than the above, they may not be displayed on the viewfinder screen.

On the viewfinder screen, only alphanumeric characters and symbols can be displayed.

Loading a Planning Metadata File into Camcorder’s Internal Memory

To record planning metadata together with recording clips, you need to load a planning metadata file into the camcorder’s memory before starting to shoot.

There are two ways to load files.

- Load a file that has been written to the following directories on an SxS memory card.

<table>
<thead>
<tr>
<th>Media</th>
<th>Directory to which files are written</th>
</tr>
</thead>
<tbody>
<tr>
<td>SxS memory card</td>
<td>BPAV/General/Sony/Planning</td>
</tr>
<tr>
<td>SDHC</td>
<td>PRIVATE/SONY/BPAV/General/Sony/Planning</td>
</tr>
</tbody>
</table>

- When a Wi-Fi connection is made between the camcorder and a computer, operate the Web menu built in the camcorder from the computer to transfer a file.

For details on how to use the Web menu to load a planning metadata file, refer to the Supplement supplied in the CD-ROM (labeled “Manuals for Solid-State Memory 3D Camcorder”).

To load a planning metadata file by menu operation

Do the following procedures with OPERAION >Planning Metadata in the setup menu.

1. Insert an SxS memory card into the left memory card slot A or B, and set Load/Slot(A) or Load/Slot(B) to [Execute].

A file list appears.

Notes

- The right slots cannot be used to load planning metadata from SxS memory cards.
- The file list displays up to 64 files. Even if the total number of planning metadata files is 64 or less, all of the planning metadata files may not appear if the directory where they are located on the SxS memory card (General/Sony/Planning) contains 512 or more files.

2. Turn the MENU knob to select a file to load and press the knob.
To display detailed information in planning metadata

After loading planning metadata into the camcorder, you can check the detailed information that it contains, such as file names, date and time of creation, and titles.

1. Under OPERATION > Plan.Metadata > Properties in the setup menu, select [Execute].

2. Turn the MENU knob to select [Execute], and then press the knob.

The PLANNING METADATA PROPERTIES list appears.

The list contains the following information.

<table>
<thead>
<tr>
<th>Item</th>
<th>Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>File Name</td>
<td>File name</td>
</tr>
<tr>
<td>Assign ID</td>
<td>Assign ID</td>
</tr>
<tr>
<td>Created</td>
<td>Date and time of creation</td>
</tr>
<tr>
<td>Modified</td>
<td>Date and time of most recent modification</td>
</tr>
<tr>
<td>Modified by</td>
<td>Name of person who modified the file</td>
</tr>
<tr>
<td>Title</td>
<td>Title1 specified in file (ASCII format clip name)</td>
</tr>
<tr>
<td>Title2</td>
<td>Title2 specified in file (UTF-8 format clip name)</td>
</tr>
<tr>
<td>Material Gp</td>
<td>Number of clips in material group a)</td>
</tr>
<tr>
<td>Shot Mark0 to Shot Mark9</td>
<td>Names defined in file for Shot Mark 0 to Shot Mark 9</td>
</tr>
</tbody>
</table>

a) Material group: A group of clips recorded with the same planning metadata.

You can turn the MENU knob to scroll the list.

After turning the MENU knob to select an item, you can press the SET button to display the selected item only.

To clear the planning metadata loaded

1. Under OPERATION > Plan.Metadata > Clear in the setup menu, select [Execute].

2. Turn the MENU knob to select [Execute], and then press the knob.

Deletion of the file starts.

The message “Clear Planning Metadata File OK” appears when the deletion finishes.

Defining Clip Names in Planning Metadata

The following two types of clip name strings can be written in a planning metadata file.

- The ASCII format name that appears in the viewfinder
- The UTF-8 format name that is actually registered as the clip name

You can select which type of clip name is displayed with OPERAION > Planning Metadata > Clip Name Disp in the setup menu.

When a clip name is set with planning metadata, the name is displayed under the depth of field indication on the viewfinder screen.

Note

When you define both of ASCII format name and UTF-8 format name with planning metadata, the UTF-8 format string is used as the clip name string. If you define either of ASCII format name and UTF-8 format name with planning metadata, the defined format name is displayed though it is not selected by menu setting.

Clip name string example

Use a text editor to modify the two fields in the <Title> tag that contain the clip name strings.

The shaded fields in the example are clip name strings. “Typhoon” is described in ASCII format (up to 44 characters). “Typhoon_Strikes_Tokyo” is described in UTF-8 format (up to 44 bytes). “sp” indicates a space and "\r" indicates a carriage return.

```xml
<?xml spversion="1.0" sencoding="UTF-8"?>
<PlanningMetadata spxmlns="http://xmlns.sony.net/pro/metadata/planningmetadata" spassignId="P0001" spcreationDate="2011-08-20T17:00:00+09:00" splastUpdate="2011-09-28T10:30:00+09:00" spversion="1.00">
  <Properties sppropertyId="assignment" spupdate="2011-09-20T10:30:00+09:00" spmodifiedBy="Chris">
    <Title>spTyphoonsp</Title>
    <Title2>Typhoon_Strikes_Tokyo</Title2>
  </Properties>
</PlanningMetadata>
```
When you create a file, enter each statement as a single line with a CRLF only after the last character in the statement line, and do not enter spaces except where specified.

- Up to 44 bytes (or characters) string is available for the clip name.
  If the UTF-8 format string exceeds 44 bytes, 44 bytes string is used as the clip name.
  If only ASCII format name is specified, 44 characters string is used as the clip name.
  When neither an ASCII format name string nor UTF-8 format name string can be used, the standard format clip name is used.

You can use the Sony Planning Metadata Add-in application software supplied with the CBK-WA01 Wi-Fi Adapter to define clip names. For details, refer to the Operating Instructions supplied with the CBK-WA01.

To set clip names

1. Load a planning metadata file that contains clip names into this camcorder.

2. Set OPERATION > Clip > Auto Naming in the setup menu to [Plan].

Each time that you record a clip, the unit automatically generates a name consisting of the clip name defined in the planning metadata file, with the addition of an underbar (_) and a five-digit serial number (00001 to 99999).

Examples:
  Typhoon_Strikes_Tokyo_00001,
  Typhoon_Strikes_Tokyo_00002, ...

Note
When you load another planning metadata file, the serial number returns to 00001 with the next recording operation.

To select the clip name display format
When names are defined in both ASCII format and UTF-8 format, you can use OPERATION > Clip > Clip Name Disp in the setup menu to select which of the names to display on the viewfinder screen.

To display ASCII format names: Select Title1(ASCII).
The clip name becomes “Typhoon_Strikes_Tokyo_SerialNumber”, but “Typhoon_SerialNumber” is displayed on the screens.

To display UTF-8 format names: Select Title2(UTF-8).
The clip name becomes “Typhoon_Strikes_Tokyo_SerialNumber”, and the same name is displayed on the screens.

Defining Shot Mark Names in Planning Metadata

When you use planning metadata to set shot marks, you can define names for Shot Mark 0 to Shot Mark 9.

When you record shot marks, you can add the shot mark name strings defined in the planning metadata.

Notes
- Shot marks are set for left slot clips only.
- Shot Mark 1 and Shot Mark 2 can be recorded on the camcorder. Shot Mark 3 to Shot Mark 9 and Shot Mark 0 can be recorded by operation from a computer which is connected with the camcorder via Wi-Fi.

Shot mark name string example
Use a text editor to modify the fields in the <Meta name> tag.
The shaded fields in the example are essence mark name strings. Names can be either in ASCII format (up to 32 characters) or UTF-8 format (up to 16 characters).
“sp” indicates a space and - - indicates a carriage return.

Note
If a name string contains even one non-ASCII character, the maximum length of that string is 16 characters.

<?xml version="1.0" encoding="UTF-8"?>
<Properties>
<Title>SpTyphoon</Title>
</Properties>
</PlanningMetadata>
The camcorder provides the following functions to help keep the left/right parallax within an appropriate range when shooting in 3D.

- Displays the subject distance range in the viewfinder that will keep the parallax in an appropriate range and produce natural stereoscopic images.
- Displays a colored outline of the subject in the viewfinder as a warning that the parallax is too large and stereoscopic imaging of the subject is difficult (3D depth warning display).
- Displays a grid in the viewfinder.

For details about parallax, see page 13.

### Displaying the Subject Distance Range

The distance range to the subject that will produce natural, stereoscopic images is displayed in the viewfinder.

When shooting, keep the subject within this range.

### Displaying 3D Depth Warning

When the parallax is too large because the subject is too close or too far away, a colored outline around the subject is displayed in the viewfinder.

A red outline is displayed when the subject is too close, and a blue outline when the subject is too far away.

When a 3D depth warning is displayed, you should adjust the framing and convergence point.
so that the warning is not displayed for an extended length of time.

To display the 3D depth warning, set OPERATION >3D Guide >Depth Warning in the setup menu to On. The 3D depth warning display can be switched On and Off during recording by setting an assignable switch with the Depth Warning function assignment to On.

**Notes**

- The warning may not be displayed correctly, depending on the subject. Use this function as a guide when shooting in 3D.
- The 3D depth warning can be displayed in the supplied viewfinder only.

### Setting the parallax reference

You can set the amount of parallax as a percentage (%) of the screen width or the maximum size of the screen as the reference for calculating the appropriate subject distance using the 3D shooting guide function.

**To set the amount of parallax percentage**

1. Set OPERATION >3D Guide >Setting in the setup menu to %.

2. Set the maximum value of parallax for close subjects in 3D Guide >Setting >% (Near), and the maximum value of parallax for distant subjects in 3D Guide >Setting >% (Far).
   You can set values between 1.0 and 10.0%.

### Displaying the Grid

You can display a grid when shooting in 3D to easily check the left/right parallax. The grid can be displayed in the viewfinder, on a monitor connected to the HD/SD SDI OUT connector, and on a monitor connected to the HDMI connector.

To display the grid in the viewfinder, set OPERATION >Grid >Grid(VF) in the setup menu to On. Similarly, you can also individually set whether to display the grid on monitors connected to the HD/SD SDI OUT (L/R) connector and the HDMI connector.

The grid display can be switched On and Off during recording by setting an assignable switch with the Grid (VF) function assignment to On.

**Notes**

- The grid cannot be displayed when the viewfinder display select switch is set to 3D.
- The grid cannot be displayed when using side-by-side output on the HD/SD SDI OUT connector or HDMI connector.
Clip Playback

A thumbnail screen appears if you press the THUMBNAIL button in E-E or playback mode. Thumbnail screens display lists of the clips stored on SxS memory cards in the form of index pictures. (A message appears if you insert a memory card that contains no clips.)

The thumbnail screen displays the content of memory cards inserted in the left slots. (If the THUMBNAIL button is pressed when memory cards are inserted in right slots only, the all clips thumbnail screen for the memory cards in the right slots is displayed.)

You can select any clip (see page 91) in a thumbnail screen and start playback of that clip (see page 91).

Thumbnail Screen

In thumbnail screens, the timecode of the index picture appears beneath the thumbnail for each clip. (An OK mark also appears when a clip has been marked with an OK mark.)

Note

Normal thumbnail screens only display clips in the recording format configured in the camcorder (clips that match all the Rec Format, HD System Line, System Frequency, and Country settings under OPERATION >Format in the setup menu (see page 104)).

If you want to display all recorded clips, switch to the all clips thumbnail screen. However, it is not possible to start playback from the all clips thumbnail screen (see page 94).
When a clip is recorded, its first frame is set automatically as the index picture. You can change to index picture to any frame (see page 99).

Indicates the selected clip is marked with an OK mark and protected.

Displays highlighted icons for the currently selected SxS memory card. If the card is write-protected, a lock mark appears on the left. This indicator displays the status of SxS memory cards in the left slots. If there is no memory card in either of the left slots (A or B), the indicator displays the status of the memory cards in the right slots.

This is the timecode of the index picture.

This appears only when a clip is an independent AV file. SxS memory cards may contain independent files that have been added directly from a computer. Because independent files lack the associated management files, some operations and information displays may not be available.

This displays the mode of clips that have been recorded in a special mode (Slow & Quick Motion, Interval Rec, Frame Rec). For Slow & Quick Motion clips, the frame rates are displayed to the right as [Recording frame rate/Playback frame rate] fps.

An OK mark appears only when the clip has been marked with an OK mark (see page 96).

When a 3D clip is selected, this displays “L” or “R.” When a 2D clip is selected, this displays “2D.”

This is the timecode of the index picture.
To switch between SxS memory cards

When memory cards are loaded in both slots A and B, you can switch between them by pressing the SLOT SELECT button.

**Note**

While an expand thumbnail screen (see page 98) or an essence mark thumbnail screen (see page 98) is displayed, SxS memory cards cannot be switched.

To hide the thumbnail screen

Press the THUMBNAIL button.

### Playing Clips

#### To select clip thumbnails

Do one of the following to move the yellow cursor to the clip that you want to select.
- Press an arrow button (↑, ↓, ←, →).
- Turn the MENU knob.
- Press the PREV or NEXT button.

**To select the first thumbnail**

With the F REV button held down, press the PREV button.

**To select the last thumbnail**

With the F FWD button held down, press the NEXT button.

**To play clips sequentially starting from a selected clip**

1. **Select the thumbnail of the clip that you want to play first.**
2. **Press the PLAY/PAUSE button.**
   Play begins from the top of the selected clip.

Play continues through all clips after the selected clip.

Play continues even if there is mix of 3D clips and 2D clips. This function plays memory cards in the left slots. Clips on memory cards in the right slots are played only when a 3D clip exists on a memory card in the left slots and there is a corresponding clip in the right slots.

When the last clip has been played to the end, the camcorder enters pause (still image) mode at the last frame of the last clip.

Press the THUMBNAIL button to return to the thumbnail screen.

**Notes**

- There may be momentary picture breakup or still image display at the transition from one clip to another. During this time, the playback controls and the THUMBNAIL button cannot be operated.
- When you select a clip in the thumbnail screen and begin playback, there may be momentary picture breakup at the top of the clip. To view the top of the clip without breakup, put the camcorder into playback mode, pause, use the PREV button to return to the top of the clip, and start playback again.

### Playing 3D clips

Clips that were recorded by the camcorder in 3D are played in 3D. Both of the left and right clips that were recorded in 3D are required in order to play in 3D. However, clips cannot be played in 3D if the clips are in slot A on the left side and in slot B on the right side. Also, clips cannot be played if they were recorded in left and right slots and then inserted into the opposite slots for playback.

When there is a 3D clip on a memory card in a left slot and no corresponding clip in a right slot, the clip is played in 2D. Clips that exist only in right slots cannot be played.

Audio is played from left clips only.

**Note**

If the recording time of a clip in the left slot is longer than the clip in the right slot, the clip in the left slot continues to play when the clip in the right slot finishes. If the recording time of the clip in the right slot is longer, the playback of the clip in the right slot stops at the same time the clip in the left slot finishes, and then playback of the next clip in the left slot begins.

**To pause playback**

Press the PLAY/PAUSE button. The PLAY/PAUSE indicator flashes while playback is paused. Press the button again to return to playback mode.

**To play at high speed**

Press the F FWD button (see page 26) or the F REV button (see page 26). To return to normal playback, press the PLAY/PAUSE button.

**To stop playback**

Press the STOP button: Playback stops and the camcorder enters E-E mode.
Press the THUMBNAIL button: Playback stops and the thumbnail screen (see page 89) appears in the viewfinder.

Playback also stops if you eject the memory card. In this case, the camera picture appears in the viewfinder.

To cue up clips

To return to the top of the current clip
Press the PREV button.
• During playback or F FWD, this jumps to the top of the current clip and starts playback.
• During F REV or pause, this jumps to the top of the current clip and displays a still image.
• Each subsequent press of the button moves to the previous clip.

To play from the top of the first clip
Simultaneously press the PREV and F REV buttons. This jumps to the top of the first clip on the SxS memory card.

To jump to the top of the next clip
Press the NEXT button.
• During playback or F FWD, this jumps to the top of the next clip and starts playback.
• During F REV or pause, this jumps to the top of the next clip and displays a still image.
• Each subsequent press of the button moves to the next clip.

To play from the top of the last clip
Simultaneously press the NEXT and F FWD buttons. This jumps to the top of the last clip on the SxS memory card.

To add a shot mark during play
You can add shot marks to clips during play by using the same method used during recording (see page 77). Shot marks can be added to clips in left slots only.

Notes
• Shot marks cannot be recorded when the SxS memory card is write protected.
• Shot marks cannot be added at the first frame of each clip or last frame of the last clip.

Using Thumbnails to Search Inside Clips

You can switch a thumbnail screen to the following thumbnail search screens, which allow you quickly find the clips you want.
• Expand thumbnail screen
• Shot mark thumbnail screen

Like the normal thumbnail screen and the OK clip thumbnail screen, these screens allow you to select clip thumbnails (see page 91) and to start clip playback (see page 91).

To search for scenes in clips with the expand thumbnail screen

The expand thumbnail screen is convenient when you want to find and cue up a specific scene in a long clip.
To display the expand thumbnail screen, select a clip in the thumbnail screen and press the EXPAND button (see page 27) or select THUMBNAIL >Thumbnail View >Forward Expansion in the setup menu. The selected clip is divided into 12 equally-sized blocks, and a thumbnail of the first frame in each block is displayed.

This helps you to quickly cue up to a desired scene in a clip of long duration.

See “Displaying the Expand Thumbnail Screen” (page 98) for more information about the expand thumbnail screen.

To search for shot marks in clips with the shot mark thumbnail screen

When a clip contains one or more shot marks, you can easily find them with the shot mark thumbnail screen. The shot mark thumbnail screen displays a thumbnail of each shot mark frame in the clip.
To display the shot mark thumbnail screen, press the ESSENCE MARK button (see page 28) or select THUMBNAIL >Thumbnail View >Essence Mark Thumbnail in the setup menu.

See “Displaying the Shot Mark Thumbnail Screen” (page 98) for more information about the shot mark thumbnail screen.
You can use the THUMBNAIL menu to perform various operations on clips, to check clip properties, and to change clip metadata.

**THUMBNAIL Menu Configuration**

<table>
<thead>
<tr>
<th>Menu items</th>
<th>Sub-items</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clip Properties</td>
<td>—</td>
<td>Displays detailed properties <em>(see page 95).</em></td>
</tr>
<tr>
<td>Set Index Picture</td>
<td>—</td>
<td>Changes index pictures in the expand thumbnail screen or the shot mark thumbnail screen <em>(see page 99).</em></td>
</tr>
<tr>
<td>Thumbnail View</td>
<td>Forward Expansion</td>
<td>• Displays the expand thumbnail screen <em>(see page 98).</em></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• In the expand thumbnail screen, increases the number of divisions <em>(see page 98).</em></td>
</tr>
<tr>
<td></td>
<td>Back Expansion</td>
<td>In the expand thumbnail screen, decreases the number of divisions.</td>
</tr>
<tr>
<td></td>
<td>Essence Mark Thumbnail</td>
<td>Displays the shot mark thumbnail screen <em>(see page 98).</em></td>
</tr>
<tr>
<td></td>
<td>Clip Thumbnail</td>
<td>Displays the normal thumbnail screen.</td>
</tr>
<tr>
<td></td>
<td>All Clip Thumbnail- L</td>
<td>Displays the all clip thumbnails screen for media in left slots <em>(see page 94).</em></td>
</tr>
<tr>
<td></td>
<td>All Clip Thumbnail- R</td>
<td>Displays the all clip thumbnails screen for media in right slots <em>(see page 94).</em></td>
</tr>
<tr>
<td>Set Shot Mark</td>
<td>Add Shot Mark1</td>
<td>In the expand thumbnail screen or the shot mark thumbnail screen, adds a Shot Mark1 mark <em>(see page 99).</em></td>
</tr>
<tr>
<td></td>
<td>Delete Shot Mark1</td>
<td>In the expand thumbnail screen or the shot mark thumbnail screen, deletes a Shot Mark1 mark <em>(see page 99).</em></td>
</tr>
<tr>
<td></td>
<td>Add Shot Mark2</td>
<td>In the expand thumbnail screen or the shot mark thumbnail screen, adds a Shot Mark2 mark <em>(see page 99).</em></td>
</tr>
<tr>
<td></td>
<td>Delete Shot Mark2</td>
<td>In the expand thumbnail screen or the shot mark thumbnail screen, deletes a Shot Mark2 mark <em>(see page 99).</em></td>
</tr>
<tr>
<td>Add OK Mark</td>
<td>—</td>
<td>Adds an OK mark and protects a clip <em>(see page 96).</em></td>
</tr>
<tr>
<td>Delete OK Mark</td>
<td>—</td>
<td>Deletes an OK mark and unprotects a clip <em>(see page 96).</em></td>
</tr>
<tr>
<td>Copy Clip</td>
<td>—</td>
<td>Copies a clip <em>(see page 96).</em></td>
</tr>
<tr>
<td>Delete Clip</td>
<td>—</td>
<td>Deletes a clip <em>(see page 97).</em></td>
</tr>
<tr>
<td>Filter Clips</td>
<td>—</td>
<td>Displays the OK clip thumbnail screen <em>(see page 94).</em></td>
</tr>
<tr>
<td>Copy All</td>
<td>All Clips</td>
<td>Batch copies groups of clips/files <em>(see page 96).</em></td>
</tr>
<tr>
<td></td>
<td>General Files</td>
<td></td>
</tr>
<tr>
<td></td>
<td>All Clips &amp; General Files</td>
<td></td>
</tr>
<tr>
<td>Delete All Clips</td>
<td>Left</td>
<td>Deletes all unprotected clips from media in left slots <em>(see page 97).</em></td>
</tr>
<tr>
<td></td>
<td>Left &amp; Right</td>
<td>Deletes all unprotected clips from media in left and right slots <em>(see page 97).</em></td>
</tr>
</tbody>
</table>
Basic THUMBNAIL Menu Operations

See “Basic Setup Menu Operations” (page 101) for information about menu operations.

To display the THUMBNAIL menu

1. Press the THUMBNAIL button to display the thumbnail screen.
2. Set the MENU ON/OFF switch to ON, or press the MENU button.
3. Turn the MENU knob to select “TH”, and then press the knob. Or press the ↑ or ↓ button to select “TH”, and then press the SET button.
   The THUMBNAIL menu appears.

To hide the THUMBNAIL menu, press the MENU button again.

To select menu items and sub-items

Do one of the following.
• Turn the MENU knob to select an item or sub-item, and then press the knob.
• Press the arrow buttons (↑, ↓, ↔, →) to select an item or sub-item, and then press the SET button.
   According to the selected item or sub-item, a selection list or a clip properties screen appears (see page 95).
   To return to the previous state, push the MENU CANCEL/PRST/ESCAPE switch down to the ESCAPE side.

Notes
• When an SxS memory card is write protected, it is not possible to copy or delete clips, to change index pictures, or to add and delete OK marks and shot marks.
• Some items cannot be selected, depending on the state of the camcorder when the menu was displayed.

To hide the clip properties screen

Do one of the following.
Press the RESET/RETURN button: This returns to the THUMBNAIL menu.
Press the THUMBNAIL button: The camcorder enters E-E mode, and the camera picture appears.
Press the PLAY/PAUSE button: Playback from the selected clip starts.

Changing the Thumbnail Screen Type

To display OK clip thumbnails

From among all clips stored on the currently selected SxS memory card, the OK clip thumbnail screen displays only clips which have been marked with an OK mark.
   When the normal thumbnail screen is displayed, you can select THUMBNAIL >Filter Clips to switch to the OK clip thumbnail screen.
   See “Adding and Deleting OK Marks” (page 96) for information about how to add OK marks.

To display the all clips thumbnail screen

The all clips thumbnail screen displays thumbnails of all of the clips on the selected memory card, regardless of the recording format. This is useful when you want to check whether the memory card contains clips in another mode. The all clips thumbnail screen can also display clips on SxS memory cards inserted in right slots. When normal thumbnail screens are displayed, you can switch to the all clips thumbnail screen by selecting THUMBNAIL >All Clip Thumbnail-L (left slots) or All Clip Thumbnail-R (right slots) in the setup menu. When the all clips thumbnail screen for left clips is displayed, pressing the RESET/RETURN button returns you to the normal thumbnail screen. When the all clips thumbnail screen for right clips is displayed, pressing the RESET/RETURN button returns you to E-E mode.

Note
You cannot start playback from the all clips thumbnail screen.
Displaying Clip Properties

The clip properties screen appears when you select Clip Properties in the THUMBNAIL menu.

1. Image of the current clip
2. Image of the previous clip
   Press the PREV button to display the properties of the previous clip.
3. Image of the next clip
   Press the NEXT button to display the properties of the next clip.
4. Clip name
   The number of component clips appears after the clip name.
   When clip names are 12 characters or longer, only the first five characters and the last five characters are displayed. If you want to check the abbreviated characters, press the MENU knob to switch to long display mode. In long display mode, up to 53 characters are displayed in clip names. Press the MENU knob again to exit long display mode. Pressing the PREV or NEXT button to display the previous or next clip also exists long display mode.
5. Lock mark
   This appears when the clip is marked with an OK mark and protected.
6. OK mark
   This appears only when an OK mark has been added.
7. Date and start time of recording
8. 3D/2D
   When a 3D clip is selected, this displays “Left” or “Right.” When a 2D clip is selected, this displays “2D.”
9. Special recording information
   This displays the mode of clips that have been recorded in a special mode (Slow & Quick Motion, Interval Rec, Frame Rec). For Slow & Quick Motion clips, the frame rates are displayed to the right as [Recording frame rate/Playback frame rate].
10. Timecode of the displayed image
11. Timecode of the recording start point
12. Timecode of the recording end point
13. Duration
14. Recorded audio channels
15. Video format of recording
Adding and Deleting OK Marks

You can add OK marks to clips. This makes it possible to display thumbnails of only the clips that you need by pressing the THUMBNAIL button.

Clips with OK marks cannot be deleted. If you want to delete such a clip, delete the OK mark first.

Note

OK marks are added to and deleted from clips on memory cards inserted in left slots. However, if a clip is a 3D clip and has a corresponding clip in a right slot, OK marks are also added to and deleted from the clip in the right slot.

To add an OK mark

1. In the thumbnail screen, select THUMBNAIL > Add OK Mark. The screen changes to the clip properties screen, and a confirmation message appears beneath the index picture.

2. Select [Execute], and press the MENU knob. An OK mark is added to the selected clip.

To delete an OK mark

A Delete OK Mark item appears in the THUMBNAIL menu when you have selected a clip that has an OK mark.

1. In the thumbnail screen, select THUMBNAIL > Delete OK Mark. The screen changes to the clip properties screen, and a confirmation message appears beneath the index picture.

2. Select [Execute], and press the MENU knob. The OK mark is deleted from the selected clip.

Copying Clips

You can copy clips to other SxS memory cards. Clips are copied to destination SxS memory cards using the same names as the original clips.

When copying 3D clips, both the left and right clips are simultaneously copied. Insert SxS memory cards in both left and right slots for the copy source and copy destination.

When copying 2D clips, the clips in the left slots are copied.

Notes

- If a clip with the same name already exists at the copy destination SxS memory card, a one-digit number in parentheses is added to the original name. The number in parentheses is the smallest number that does not exist at the copy destination.

Examples:
ABCD0002 → ABCD0002(1)  
ABCD0002(1) → ABCD0002(2)  
ABCD0005(3) → ABCD0005(4)

- If the parenthetical numbers (1) to (9) already exist at the copy destination, it is not possible to copy any more clips under that name. (A tenth clip cannot be copied.)

- A message appears if there is not enough free capacity at the copy destination SxS memory card. Exchange the card for one with more free capacity.

- When multiple clips are recorded in a source SxS memory card, it may not be possible to copy all clips to the end. Depending on memory characteristics and usage of the memory cards, this can occur even when the source and destination memory cards have the same capacity.

1. In the thumbnail screen, select the thumbnail of the clip to copy, and then select THUMBNAIL > Copy Clip. The screen changes to the properties screen of that clip, and a confirmation message appears beneath the index picture.

2. Select [Execute], and press the MENU knob. The copy starts. During the copy, an execution message and progress bar are displayed. When the copy finishes, the display returns to the thumbnail screen.

To cancel a copy operation

Press the RESET/RETURN button. The copy is cancelled, and the display returns to the thumbnail screen.

To batch copy groups of clips/files

You can batch copy groups of clips from one SxS memory card to another SxS memory card.
The batch copy function copies all clips (clips matching the recording format configured for the camcorder) displayed in the thumbnail screen. Clips not displayed in the thumbnail screen are not copied.

If the batch copy target includes 3D clips, the corresponding right clips on media in right slots are simultaneously copied.

You can also copy the files in the General directory, either together with or separately from clips.

1. **In the thumbnail screen, select the thumbnails of the clips to copy and then select THUMBNAIL >Copy All >All Clips.**
   The confirmation message “Copy All Clip?” appears.

2. **Select [Execute], and press the MENU knob.**
   The copy starts.
   During the copy, the progress of the copy is displayed.

   **To cancel the copy operation**
   Press the RESET/RETURN button.

   **When the copy finishes**
   A completion message appears, and the THUMBNAIL menu screen appears again.

   **To copy all files in the General directory**
   To copy all files only, without copying clips, select THUMBNAIL >Copy All >General Files in step 1.
   To copy all files together with all clips, select THUMBNAIL >Copy All >All Clips & General Files in step 1.

**Deleting Clips**

You can delete clips from SxS memory cards.

When deleting 3D clips, both the left and right clips are deleted if the corresponding clips in the left and right slots are both present.

**Note**

Clips with OK marks cannot be deleted.

If you want to delete such clips, first delete the OK marks (see page 96).

1. **In the thumbnail screen, select the thumbnail of the clip to delete, and then select THUMBNAIL >Delete Clip.**
   The screen changes to the properties screen of that clip, and a confirmation message appears beneath the index picture.

2. **Select [Execute], and press the MENU knob.**
   The clip is deleted.

   In the thumbnail screen, the clips that followed the deleted clip move up one position.

**To batch delete groups of clips**

You can batch delete groups of clips from an SxS memory card.

**Notes**

- The batch delete function deletes only clips (clips matching the recording format configured for the camcorder) displayed in the thumbnail screen. Clips not displayed in the thumbnail screen are not deleted.
- In HD mode, clips with OK marks are not deleted, even when a deletion is executed for a group of clips that includes them.

1. **In the thumbnail screen, select the thumbnails of the clips to delete and then select THUMBNAIL >Delete All Clips.**

2. **Select Left to delete clips on SxS memory cards in left slots, or select Left & Right to delete clips on SxS memory cards in left and right slots.**
   The confirmation message “Delete All Clips?” appears.

3. **Select [Execute], and press the MENU knob.**
   The deletion starts.
   During the deletion, the progress of the deletion is displayed.

   **To cancel the deletion**
   Press the RESET/RETURN button.

   **When the deletion finishes**
   A completion message appears, and the THUMBNAIL menu screen appears again.
Displaying the Expand Thumbnail Screen

The expand thumbnail screen allows you to search inside clips by using thumbnails (see page 92), to change index pictures (see page 99), and to add and delete shot marks (see page 99).

To display the screen
In the thumbnail screen, select a thumbnail and press the EXPAND button (see page 27) or select THUMBNAIL > Thumbnail View > Forward Expansion.
The selected clip is divided into 12 equally-sized blocks, and the first frame in each block is displayed in a list of thumbnails.

Number of the selected frame

Clip properties are shown at the bottom of the screen.
Except for the items listed below, the information displayed here is the same as the information displayed in the normal thumbnail screen.

1 Frame information
This displays frame information using icons.

- Index picture
- Frame with Shot Mark1
- Frame with Shot Mark2

The same icons are also displayed beneath the thumbnails. However, when several icons could be displayed for the same frame, one icon is selected for display, in the order of priority: Index picture > Shot Mark1 > Shot Mark2.

2 Timecode
This displays the timecode of the selected frame in the expand thumbnail screen.

To increase the number of divisions
When you press the EXPAND button, or select THUMBNAIL > Thumbnail View > Forward Expansion, the divided clip or file is further divided into 12 equally-sized blocks (a clip or file that has been divided into 12 is further divided into 12, for $12 \times 12 = 144$ divisions). You can repeat the same operation to increase the number of division.

To return to the previous division level
Press the EXPAND button with the SHIFT button held down, or select THUMBNAIL > Thumbnail View > Back Expansion. The expand thumbnail screen returns to the previous division level.

Displaying the Shot Mark Thumbnail Screen

In the shot mark thumbnail screen, you can search for shot marks in clips (see page 92), change index pictures (see page 99), and add and delete shot marks (see page 99).

Only left slot memory cards can be displayed on the shot mark thumbnail screen. The shot mark thumbnail screen is not displayed for right slot memory cards.

1 In the thumbnail screen, select the thumbnail of a clip, and press the ESSENCE MARK button (see page 28) or select THUMBNAIL > Thumbnail View > Essence Mark Thumbnail.
The shot mark thumbnail screen appears, and a selection list is displayed.

2 Select the type of the essence mark thumbnail screen.
   All: Thumbnail display of all frames marked with essence marks.
   Shot Mark1: Display only frames marked with Shot Mark1 marks.
   Shot Mark2: Display only frames marked with Shot Mark2 marks.
You can also select Shot Mark 0 and Shot Mark 3 to Shot Mark 9.
If you have recorded clips by using planning metadata that defined names for Shot Mark 0 to Shot Mark 9, the defined names are displayed instead of the above item names in the list.

**Example shot mark thumbnail screen (with Shot Mark1 selected)**

The properties of the clip appear at the bottom of the screen.

Except for the following item, the information displayed here is the same as the information displayed in the expand thumbnail screen.

1. **Timecode**
   This is the timecode of the selected frame in the shot mark thumbnail screen.

---

### Adding and Deleting Shot Marks

In the shot mark thumbnail screen (see page 98) or the expand thumbnail screen (see page 98), you can add shot marks to any frame of clips, and delete recorded shot marks.

#### To add shot marks

1. Select the frame where you want to add a shot mark, and then select THUMBNAIL > Set Shot Mark > Add Shot Mark1 (or Add Shot Mark2).
   The properties screen of the selected frame appears, and a confirmation message appears below the image.

2. Select [Execute], and press the MENU knob.

---

#### To delete shot marks

1. Select the frame where you want to delete a shot mark, and then select THUMBNAIL > Set Shot Mark > Delete Shot Mark1 (or Delete Shot Mark2).
   The properties screen of the selected frame appears, and a confirmation message appears below the image.

2. Select [Execute], and press the MENU knob.

### Changing Clip Index Pictures

In the shot mark thumbnail screen (see page 98) or the expand thumbnail screen (see page 98), you can set the selected frame as the clip index picture.

The clip index picture can be changed only for clips on memory cards inserted in left slots.

1. Select the thumbnail of the frame that you want to use as the index picture, and then select THUMBNAIL > Set Index Picture.
   The properties screen of the selected frame appears, and a confirmation message appears below the image.

2. Select [Execute], and press the MENU knob.

---

**Note**

Even if you set the index picture to a frame that is not the first frame of a clip, playback of that clip from a thumbnail screen always begins at the first frame.
On this camcorder, settings for shooting and playback are made in the setup menu, which appears in the viewfinder. The setup menu can also be displayed on an external video monitor (see page 151).

Setup Menu Organization

The setup menu consists of the following menus.

Op: OPERATION menu
Settings related to shooting, except settings related to picture quality (see page 104)

Pa: PAINT menu
Settings related to picture quality (see page 122)

Th: THUMBNAIL menu
Settings related to clip thumbnails (see page 93)

Note
The THUMBNAIL menu is used only when a thumbnail screen (see page 89) is displayed. It is disabled when no thumbnail screen is displayed.

Ma: MAINTENANCE menu
Settings related to audio and timecode (see page 127)

Fi: FILE menu
Settings related to file operations (see page 140)

Setup Menu Levels

See “THUMBNAIL Menu Configuration” (page 93) for the organization of the THUMBNAIL menu.
Basic Setup Menu Operations

To display the setup menu

Set the MENU ON/OFF switch to ON, or press the MENU button.

The camcorder enters menu mode and the menu list appears on the screen.

A cursor appears over the first two characters of the most recently used menu, and the corresponding menu item selection area appears to the right.

**Example: When the cursor is positioned at the OPERATION menu**

To make menu settings

1. **Turn the MENU knob, or press the ↑ or ↓ button, to move the cursor to the item that you want to set.**

   A list of selectable menu items appears in the menu item selection area to the right of the icon.

2. **Press the MENU knob or the SET button.**

   The cursor moves to the menu item selection area.

   You can also move the cursor to the menu item selection area by pressing the ⇔ button.
• The menu item selection area displays a maximum of seven lines. You can scroll through menus with more than seven lines by moving the cursor up and down. Triangles appear at the upper right and lower right of the menu item selection area to indicate that a menu is scrollable.

3 Turn the MENU knob, or press the ↑ or ↓ button, to move the cursor to the item that you want to set, and then confirm by pressing the MENU knob or the SET button.

The sub-items area appears to the right of the menu item selection area, and the cursor moves to the first sub-item.

4 Turn the MENU knob, or press the ↑ or ↓ button, to move the cursor to the sub-item that you want to set, and then confirm the selection by pressing the MENU knob or the SET button.

The settings of the selected sub-item appear, and the cursor moves to the currently selected value.

• The settings area displays a maximum of seven lines. You can scroll through menus with more than seven sub-items by moving the cursor up and down. Triangles appear at the upper right and lower right of the settings area to indicate that a sub-item menu is scrollable.

• For sub-items with a large settings range (for example, –99 to +99), the settings area is not displayed. Instead, the sub-item name is highlighted to indicate that the sub-item can be set.

5 Turn the MENU knob, or press the ↑ or ↓ button, to select the value to set, and then confirm by pressing the MENU knob or the SET button.

The setting is changed, and the display is updated to show the new setting.

If you select [Execute] for an executable item, the corresponding function is executed.

Items that require confirmation before execution

In step 3, the menu disappears and a confirmation message appears if you select an item that requires confirmation before execution. Follow the instructions in the message to execute or cancel the operation.

To enter text

Some items, such as time data or file names, must be set by entering text. When you select one of these items, the text entry area is highlighted, with “SET” displayed to the right.
1 Turn the MENU knob, or press the ↑ or ↓ button, to select a character, and then confirm by pressing the MENU knob or the SET button.
   The cursor moves to the next position.
   To return to the previous position, push the MENU CANCEL/PRST/ESCAPE switch down to the ESCAPE side.

2 Select characters for all positions up to the last.
   The cursor moves to “SET”.

3 Press the MENU knob or the SET button.
   This confirms the setting.

To cancel the setting change
Push the MENU CANCEL/PRST/ESCAPE switch down to the ESCAPE side.

To reset a setting to the initial value

1 Before a setting is changed or after a setting change is cancelled, push the MENU CANCEL/PRST/ESCAPE switch up to the CANCEL/PRST side.

2 When the message to confirm whether the current setting is reset to the initial value, push the MENU CANCEL/PRST/ESCAPE switch up to the CANCEL/PRST side again.
   The current setting is reset to the initial value.

To exit the menu
Set the MENU ON/OFF switch to OFF or press the MENU button.
The normal camera picture reappears.
## OPERATION Menu

Settings in bold are the factory default values.

<table>
<thead>
<tr>
<th>OPERATION Menu items</th>
<th>Sub-item</th>
<th>Settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Format</td>
<td></td>
<td>3D/2D</td>
<td>Selects 3D or 2D recording.</td>
</tr>
<tr>
<td></td>
<td>3D Single Rec</td>
<td>Enable/Disable</td>
<td>When recording in 3D, selects whether to enable or disable continuous recording to the SxS memory card in the other slot when the first card can no longer be recorded to.</td>
</tr>
<tr>
<td>HD System Line</td>
<td></td>
<td>1080/720</td>
<td>Sets the number of system lines to 1080 or 720 (execute by selecting Execute).</td>
</tr>
<tr>
<td>System Frequency</td>
<td></td>
<td>The available settings vary depending on the settings in HD System Line, and Country.</td>
<td>Selects the system frequency (execute by selecting Execute).</td>
</tr>
<tr>
<td></td>
<td></td>
<td>59.94i/29.97P/23.98P</td>
<td>When the HD System Line setting is [1080], and the Country setting is other than [PAL Area].</td>
</tr>
<tr>
<td></td>
<td></td>
<td>59.94P/29.97P/23.98P</td>
<td>When the HD System Line setting is [720], and the Country setting is other than [PAL Area].</td>
</tr>
<tr>
<td></td>
<td></td>
<td>50i/25P</td>
<td>When the HD System Line setting is [1080], and the Country setting is [PAL Area].</td>
</tr>
<tr>
<td></td>
<td></td>
<td>50P/25P</td>
<td>When the HD System Line setting is [720], and the Country setting is [PAL Area].</td>
</tr>
</tbody>
</table>
**OPERATION**

<table>
<thead>
<tr>
<th>Menu items</th>
<th>Sub-item</th>
<th>Settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Format</strong></td>
<td>Rec Format</td>
<td>The available settings vary depending on the settings in HD System Line, and System Frequency.</td>
<td>Selects the recording format (execute by selecting Execute).</td>
</tr>
<tr>
<td></td>
<td><strong>HQ 1920/HQ 1440</strong></td>
<td>When the HD System Line setting is [1080] and the System Frequency setting is [29.97P], [23.98P] or [25P].</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>HQ 1920/HQ 1440/SP 1440</strong></td>
<td>When the HD System Line setting is [1080] and the System Frequency setting is [59.94i] or [50i].</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>HQ 1280</strong></td>
<td>When the HD System Line setting is [720].</td>
<td></td>
</tr>
<tr>
<td><strong>Country</strong></td>
<td>NTSC Area/NTSC(J) Area/PAL Area</td>
<td>Selects the area of use (execute by selecting Execute).</td>
<td></td>
</tr>
<tr>
<td><strong>Format Media</strong></td>
<td>Media(A)-Left</td>
<td>Execute/Cancel</td>
<td>Initializes the SxS memory card in slot A on the left side (execute by selecting Execute).</td>
</tr>
<tr>
<td></td>
<td>Media(A)-Right</td>
<td>Execute/Cancel</td>
<td>Initializes the SxS memory card in slot A on the right side (execute by selecting Execute).</td>
</tr>
<tr>
<td></td>
<td>Media(A)-L&amp;R</td>
<td>Execute/Cancel</td>
<td>Initializes the SxS memory cards in slot A on both the left and right sides (execute by selecting Execute).</td>
</tr>
<tr>
<td></td>
<td>Media(B)-Left</td>
<td>Execute/Cancel</td>
<td>Initializes the SxS memory card in slot B on the left side (execute by selecting Execute).</td>
</tr>
<tr>
<td></td>
<td>Media(B)-Right</td>
<td>Execute/Cancel</td>
<td>Initializes the SxS memory card in slot B on the right side (execute by selecting Execute).</td>
</tr>
<tr>
<td></td>
<td>Media(B)-L&amp;R</td>
<td>Execute/Cancel</td>
<td>Initializes the SxS memory cards in slot B on both the left and right sides (execute by selecting Execute).</td>
</tr>
<tr>
<td>Menu items</td>
<td>Sub-item</td>
<td>Settings</td>
<td>Description</td>
</tr>
<tr>
<td>------------</td>
<td>----------</td>
<td>----------</td>
<td>-------------</td>
</tr>
<tr>
<td>Output</td>
<td>Signal Format</td>
<td>HD/SD/480P (576P)</td>
<td>Selects the signals output from the video connectors. About 480P (576P), 480P can be selected when the Country setting is other than [PAL Area], and 576P can be selected when the Country setting is [PAL Area].</td>
</tr>
<tr>
<td></td>
<td>23.98P Output</td>
<td>SDI(PsF)/HDMI(P)/Pull Down</td>
<td>Selects the output format when the video format is HQ1920/23.98P or HQ1440/23.98P. <strong>SDI(PsF):</strong> Progressive output from the HD/SD SDI OUT connector. <strong>HDMI(P):</strong> Pure P output from the HDMI connector. <strong>Pull Down:</strong> Pulldown output from the HD/SD SDI OUT and HDMI connectors.</td>
</tr>
<tr>
<td></td>
<td>SDI Output(L)</td>
<td>On/Off</td>
<td>Turns on or off the output of signals from the HD/SD SDI OUT(L) connector.</td>
</tr>
<tr>
<td></td>
<td>SDI Signal(L)</td>
<td>3G/L/L+R/L-R/Side By Side/Anaglyph</td>
<td>Selects the output format from the HD/SD SDI OUT(L) connector when the Signal Format setting is HD. <strong>3G:</strong> 3G SDI left and right signal output. <strong>L:</strong> 1.5G SDI left signal output. <strong>L+R:</strong> 1.5G SDI L+R format signal output. <strong>L-R:</strong> 1.5G SDI L-R format signal output. <strong>Side By Side:</strong> 1.5G SDI side-by-side format signal output. <strong>Anaglyph:</strong> 1.5G SDI anaglyph output.</td>
</tr>
<tr>
<td></td>
<td>SDI Output(R)</td>
<td>On/Off</td>
<td>Turns on or off the output of signals from the HD/SD SDI OUT(R) connector.</td>
</tr>
</tbody>
</table>
# Output

Makes settings related to output signals.

<table>
<thead>
<tr>
<th>Menu items</th>
<th>Sub-item</th>
<th>Settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Output</td>
<td>SDI Signal(R)</td>
<td>R/L/L+R/L-R/Side By Side/Anaglyph</td>
<td>Selects the output format from the HD/SD SDI OUT(R) connector when the Signal Format setting is HD and the SDI Signal(L) setting is 3G. <strong>R:</strong> 1.5G SDI right signal output. <strong>L:</strong> 1.5G SDI left signal output. <strong>L+R:</strong> 1.5G SDI L+R format signal output. <strong>L-R:</strong> 1.5G SDI L-R format signal output. <strong>Side By Side:</strong> 1.5G SDI side-by-side format signal output. <strong>Anaglyph:</strong> 1.5G SDI anaglyph output.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Menu items</th>
<th>Sub-item</th>
<th>Settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>HDMI Output</td>
<td>On/Off</td>
<td></td>
<td>Turns on or off the output of signals from the HDMI connector.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Menu items</th>
<th>Sub-item</th>
<th>Settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>HDMI Signal</td>
<td>Side By Side/L/R/L+R/L-R/Anaglyph</td>
<td></td>
<td>Selects the output format from the HDMI connector when the Signal Format setting is HD. <strong>Side By Side:</strong> In 3D mode, side-by-side format signal output. In 2D mode, left signal output. <strong>L:</strong> Left signal output <strong>R:</strong> Right signal output <strong>L+R:</strong> In 3D mode, L+R format signal output. In 2D mode, left signal output. <strong>L-R:</strong> In 3D mode, L-R format signal output. In 2D mode, left signal output. <strong>Anaglyph:</strong> Anaglyph output.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Menu items</th>
<th>Sub-item</th>
<th>Settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>SDI/HDMI Out Super</td>
<td>On/Off</td>
<td></td>
<td>Turns on or off the superimposition of text information on the output of the HD/SD SDI OUT and HDMI connectors. <strong>Note</strong> Text information is displayed correctly only when SDI Signal (L), SDI Signal (R), and HDMI Signal is set to “L”.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Menu items</th>
<th>Sub-item</th>
<th>Settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Video Out Super</td>
<td>On/Off</td>
<td></td>
<td>Turns on or off the superimposition of text information on the output of the VIDEO OUT connector. <strong>Note</strong> This setting cannot be selected when the Signal Format setting is 480P or 576P, or when the System Frequency setting is 23.98P, the Rec Format setting is HQ1920 or HQ1440, and the 23.98P Output setting is HDMI(P).</td>
</tr>
</tbody>
</table>
### Menu List

#### Chapter 6  Menu and Detailed Settings

<table>
<thead>
<tr>
<th>Menu items</th>
<th>Sub-item</th>
<th>Settings</th>
<th>Description</th>
</tr>
</thead>
</table>
| Output           | Makes settings related to output signals. | Down Converter Crop/Letter/Squeeze | Selects the signal conversion mode for output of SD signals.  
|                  |                               |                | **Crop**: Crop the edges of the 16:9 picture and output as a 4:3 picture.  
|                  |                               |                | **Letter**: Mask the top and bottom of the 4:3 picture and display in the center of the screen as a 16:9 picture.  
|                  |                               |                | **Squeeze**: Squeeze the 16:9 picture horizontally and output as a 4:3 picture.  |
|                  | Wide ID  Through/Auto         |                | Selects whether to add a wide ID signal to the SD output signal.  
|                  |                               |                | **Through**: Output without adding a wide ID signal.  
|                  |                               |                | **Auto**: Add and output a wide ID signal when the Down Converter setting is Squeeze.  |
| Super Impose     | Makes settings related to superimposed text and markers. | Super(VF Display) On/Off | When the setting of Output >SDI/HDMI Out Super or Video Out is On, superimpose text information on the output from the HD/SD SDI OUT connector, HDMI connector, and VIDEO OUT connector, as specified (On or Off) for each item.  
|                  | Super(Menu) On/Off            |                | When the setting of Output >Video Out is On, specifies whether to superimpose markers on the output from the VIDEO OUT connector.  
|                  | Super(Timecode) On/Off        |                | When the setting of Output >Video Out is On, specifies whether to superimpose markers on the output from the VIDEO OUT connector.  
|                  | Super(Marker) On/Off          |                | When the setting of Output >Video Out is On, specifies whether to superimpose markers on the output from the VIDEO OUT connector.  |
### Rec Function
Makes settings related to special recording modes.

**Note**
When Picture Cache is assigned to an assignable switch, this item is disabled (displayed in grey).

<table>
<thead>
<tr>
<th>Sub-item</th>
<th>Settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Slow &amp; Quick</td>
<td>On/Off</td>
<td>Turns the Slow &amp; Quick Motion function on or off. (When this is set to On, the Picture Cache Rec, Interval Rec, and Frame Rec sub-items are set to Off.)</td>
</tr>
<tr>
<td>Frame Rate</td>
<td></td>
<td>When the Slow &amp; Quick setting is On, sets the frame rate for Slow &amp; Quick Motion shooting.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>When the Slow &amp; Quick setting is On, sets the speed for Slow &amp; Quick Motion shooting.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>When Picture CacheRec is set to On, the Slow &amp; Quick, Interval Rec, and Frame Rec sub-items are set to Off.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>When the Picture CacheRec setting is On, set the picture cache time.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Sub-item</th>
<th>Settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Interval Rec</td>
<td>On/Off</td>
<td>Turns the Interval Rec function on or off. (When this is set to On, the Slow &amp; Quick, Picture Cache Rec, and Frame Rec sub-items are set to Off.)</td>
</tr>
<tr>
<td>Frame Rec</td>
<td>On/Off</td>
<td>Turns the Frame Rec function on or off. (When this is set to On, the Slow &amp; Quick, Picture Cache Rec, and Interval Rec sub-items are set to Off.)</td>
</tr>
</tbody>
</table>
## Rec Function
Makes settings related to special recording modes.

**Note**
When Picture Cache is assigned to an assignable switch, this item is disabled (displayed in grey).

### Number of Frames
The available settings vary depending on the settings in Format > HD System Line and Format > System Frequency.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>2frame/6frame/12frame</td>
<td>When the HD System Line setting is 720, and the System Frequency setting is 59.94P or 50P.</td>
<td></td>
</tr>
<tr>
<td>1frame/3frame/6frame/9frame</td>
<td>When the HD System Line setting is other than 720, or the System Frequency setting is other than 59.94P or 50P.</td>
<td></td>
</tr>
</tbody>
</table>

### Interval Time
When the Interval Rec setting is On, sets the interval for Interval Rec shooting.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>1/2/3/4/5/6/7/8/9/10/15/20/30/40/50 (sec)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1/2/3/4/5/6/7/8/9/10/15/20/30/40/50 (min)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1/2/3/4/6/12/24 (hour)</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Pre-Lighting
If you want the video light to be turned on before Interval Rec shooting, select a number of seconds before the start of shooting. If you do not want it to be turned on, select Off.

### Assignable SW
Assigns functions to assignable switches.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;0&gt;</td>
<td>Assigns function to ASSIGN. 0 switch.</td>
<td></td>
</tr>
<tr>
<td>&lt;1&gt;</td>
<td>Assigns function to ASSIGN. 1 switch.</td>
<td></td>
</tr>
<tr>
<td>&lt;2&gt;</td>
<td>Assigns function to ASSIGN. 2 switch.</td>
<td></td>
</tr>
<tr>
<td>&lt;3&gt;</td>
<td>Assigns function to ASSIGN. 3 switch.</td>
<td></td>
</tr>
<tr>
<td>&lt;4&gt;</td>
<td>Assigns function to ASSIGNABLE 4 switch.</td>
<td></td>
</tr>
<tr>
<td>&lt;5&gt;</td>
<td>Assigns function to ASSIGNABLE 5 switch.</td>
<td></td>
</tr>
<tr>
<td>&lt;6&gt;</td>
<td>Assigns function to ASSIGN. 6 switch.</td>
<td></td>
</tr>
<tr>
<td>RET</td>
<td>Assigns function to RET button.</td>
<td></td>
</tr>
<tr>
<td>C. Temp</td>
<td>Assigns function to COLOR TEMP. button.</td>
<td></td>
</tr>
</tbody>
</table>

### Zoom Speed
When Zoom has been assigned to the ASSIGNABLE 4 or 5 switch, specifies the zoom speed.
<table>
<thead>
<tr>
<th>Menu items</th>
<th>Sub-item</th>
<th>Settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lens Dial</td>
<td>Outer</td>
<td>Zoom/Focus/Convergence/Iris/Assign Nothing</td>
<td>Assigns function to ZOOM dial.</td>
</tr>
<tr>
<td></td>
<td>Mid</td>
<td>Zoom/Focus/Convergence/Iris/Assign Nothing</td>
<td>Assigns function to FOCUS dial.</td>
</tr>
<tr>
<td></td>
<td>Inner</td>
<td>Zoom/Focus/Convergence/Iris/Assign Nothing</td>
<td>Assigns function to CONVERGENCE dial.</td>
</tr>
<tr>
<td>Dial Operation</td>
<td>Focus Clockwise</td>
<td>Near/Far</td>
<td>Sets the operation of the FOCUS dial when turned clockwise. Near: Shifts focus closer. Far: Shifts focus further away.</td>
</tr>
<tr>
<td></td>
<td>Zoom Clockwise</td>
<td>Tele/Wide</td>
<td>Sets the operation of the ZOOM dial when turned clockwise. Tele: Telephoto Wide: Wide angle</td>
</tr>
<tr>
<td></td>
<td>Iris Clockwise</td>
<td>Open/Close</td>
<td>Sets the operation of the IRIS dial when turned clockwise. Open: Opens the iris aperture. Close: Closes the iris aperture.</td>
</tr>
<tr>
<td>Enable VF Disp</td>
<td>Right</td>
<td>Enable/Disable</td>
<td>Enables/disables selection of Right-signal image display.</td>
</tr>
<tr>
<td></td>
<td>L+R</td>
<td>Enable/Disable</td>
<td>Enables/disables selection of L+R display.</td>
</tr>
<tr>
<td></td>
<td>L-R</td>
<td>Enable/Disable</td>
<td>Enables/disables selection of L-R display.</td>
</tr>
<tr>
<td></td>
<td>3D</td>
<td>Enable/Disable</td>
<td>Enables/disables selection of 3D display.</td>
</tr>
<tr>
<td></td>
<td>Anaglyph</td>
<td>Enable/Disable</td>
<td>Enables/disables selection of anaglyph display.</td>
</tr>
</tbody>
</table>
## Grid
Makes settings related to the grid display.

<table>
<thead>
<tr>
<th>Sub-item</th>
<th>Settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Grid(VF)</td>
<td>On/Off</td>
<td>Turns on or off the grid display in the viewfinder.</td>
</tr>
<tr>
<td>Grid(SDI(L))</td>
<td>On/Off</td>
<td>Turns on or off the grid display from the HD/SD SDI OUT(L) connector.</td>
</tr>
<tr>
<td>Grid(SDI(R))</td>
<td>On/Off</td>
<td>Turns on or off the grid display from the HD/SD SDI OUT(R) connector.</td>
</tr>
<tr>
<td>Grid(HDMI)</td>
<td>On/Off</td>
<td>Turns on or off the grid display from the HDMI connector.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Width Select</th>
<th>%/Pixels</th>
<th>Selects the method of specifying grid intervals.</th>
</tr>
</thead>
<tbody>
<tr>
<td>%</td>
<td>0.5% to 3.0% to 10.0% (0.1% steps)</td>
<td>Sets the grid interval as a percentage.</td>
</tr>
<tr>
<td>Pixels</td>
<td>The available settings vary depending on the Format &gt; HD System Line setting.</td>
<td>Sets the grid interval as number of pixels.</td>
</tr>
<tr>
<td></td>
<td>10 to <strong>60</strong> to 192</td>
<td>When the HD System Line setting is 1080.</td>
</tr>
<tr>
<td></td>
<td>10 to <strong>40</strong> to 128</td>
<td>When the HD System Line setting is 720.</td>
</tr>
</tbody>
</table>

| Line Thickness | Thin/Normal/Thick | Sets the thickness of the grid lines. |

## 3D Guide
Makes settings related to the 3D shooting guide function.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Screen Size/%</th>
<th>Selects the reference for calculating the appropriate distance to the subject to control parallax.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Screen Size</td>
<td><strong>77inch/100inch/200inch</strong></td>
<td>When Screen Size is selected in Setting, selects the maximum size of the viewing monitor.</td>
</tr>
<tr>
<td>%(Near)</td>
<td>1.0% to <strong>3.0%</strong> to 10.0% (0.1% steps)</td>
<td>When % is selected in Setting, sets the maximum divergence in the near field.</td>
</tr>
<tr>
<td>%(Far)</td>
<td>1.0% to <strong>3.0%</strong> to 10.0% (0.1% steps)</td>
<td>When % is selected in Setting, sets the maximum divergence in the far field.</td>
</tr>
</tbody>
</table>

| Depth Warning | On/Off | Turns on or off the display of the 3D depth warning in the viewfinder. |
### VF Setting
Makes settings related to the viewfinder screen.

<table>
<thead>
<tr>
<th>Sub-item</th>
<th>Settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Color</td>
<td>–99 to ±0 to +99</td>
<td>Adjusts the density of the colors displayed in the viewfinder screen.</td>
</tr>
<tr>
<td>Mode</td>
<td>Color/B&amp;W</td>
<td>Selects Color or B&amp;W as the display mode of the viewfinder screen. (Even when B&amp;W is selected, some indications are always displayed in color. Examples include tally indications, thumbnails, and the skin gate area.)</td>
</tr>
<tr>
<td>Peaking Type</td>
<td>Normal/Color/Both</td>
<td>Selects the peaking type. <strong>Normal</strong>: Normal peaking <strong>Color</strong>: Color peaking <strong>Both</strong>: Both</td>
</tr>
<tr>
<td>Peaking Frequency</td>
<td>Normal/High</td>
<td>Selects Normal or High as the peaking frequency.</td>
</tr>
<tr>
<td>Peaking Color</td>
<td>White/Red/Yellow/Blue</td>
<td>When the Peaking Type setting is Color, selects the peaking color from among White, Red, Yellow, and Blue.</td>
</tr>
<tr>
<td>Peaking Level</td>
<td>Low/Mid/High</td>
<td>When the Peaking Type setting is Both, selects the color peaking level from among Low, Mid, and High.</td>
</tr>
<tr>
<td>DXF Rec Tally</td>
<td>Upper/Both</td>
<td>When a separately sold viewfinder is installed, specified whether to light the tally indicator on the upper side only (Upper), or on both the upper and lower sides (Both).</td>
</tr>
</tbody>
</table>

### Marker
Makes settings related to marker display in the viewfinder screen.

<table>
<thead>
<tr>
<th>Sub-item</th>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Setting</td>
<td>On/Off</td>
<td>Turns all markers on or off.</td>
</tr>
<tr>
<td>Center Marker</td>
<td>1/2/3/4/Off</td>
<td>When the center marker is displayed, selects the type. Select Off if you do not want to display the marker.</td>
</tr>
<tr>
<td>Center H Position</td>
<td>–40 to 0 to 40</td>
<td>Specifies the horizontal position of the center marker.</td>
</tr>
<tr>
<td>Center V Position</td>
<td>–40 to 0 to 40</td>
<td>Specifies the vertical position of the center marker.</td>
</tr>
</tbody>
</table>
**OPERATION**

<table>
<thead>
<tr>
<th>Menu items</th>
<th>Sub-item</th>
<th>Settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Marker</strong></td>
<td>Safety Zone</td>
<td>On/Off</td>
<td>Turns the safety zone display on or off.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td><strong>Note</strong>&lt;br&gt;When Center Marker, User Box, and Guide Frame are set to [On], this setting cannot be turned on.</td>
</tr>
<tr>
<td></td>
<td>Safety Area</td>
<td>80%/90%/92.5%/95%</td>
<td>Selects the safety zone range.</td>
</tr>
<tr>
<td></td>
<td>Aspect Marker</td>
<td>Line/Mask/Off</td>
<td>When an aspect marker is to be displayed, selects the display method. Select Off if you do not want to display the marker.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td><strong>Line:</strong> Show as white lines. <strong>Mask:</strong> Display by lowering the video signal level of areas outside the marker range.</td>
</tr>
<tr>
<td></td>
<td>Aspect Select</td>
<td>15:9/14:9/13:9/4:3/1.66:1/1.85:1/2.35:1/2.4:1</td>
<td>Selects the aspect ratio of the marker.</td>
</tr>
<tr>
<td></td>
<td>Aspect Mask</td>
<td>0% to 30% to 90% (10% step)</td>
<td>When the Aspect Marker setting is Mask, specifies the video signal level of areas outside the marker range as a percentage value relative to the video signal level of areas inside the marker range.</td>
</tr>
<tr>
<td></td>
<td>User Box</td>
<td>On/Off</td>
<td>Turns the box cursor display on or off.</td>
</tr>
<tr>
<td></td>
<td>User Box Width</td>
<td>40 to 500 to 999</td>
<td>Specifies the box cursor width (distance from the center to the left and right edges).</td>
</tr>
<tr>
<td></td>
<td>User Box Height</td>
<td>70 to 500 to 999</td>
<td>Specifies the box cursor height (distance from the center to the top and bottom edges).</td>
</tr>
<tr>
<td></td>
<td>User Box H Position</td>
<td>–479 to 0 to 479</td>
<td>Specifies the horizontal position of the box cursor center.</td>
</tr>
<tr>
<td></td>
<td>User Box V Position</td>
<td>–464 to 0 to 464</td>
<td>Specifies the vertical position of the box cursor center.</td>
</tr>
<tr>
<td></td>
<td>Guide Frame</td>
<td>On/Off</td>
<td>Turns display of the guide frame on or off.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td><strong>Note</strong>&lt;br&gt;When Center Marker, Safety Zone, and User Box are set to [On], this setting cannot be turned on.</td>
</tr>
</tbody>
</table>

---

**Table continued...**
### Gain Switch
Makes settings related to the GAIN switch.

<table>
<thead>
<tr>
<th>Sub-item</th>
<th>Settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Gain Low</td>
<td>-3dB/0dB/3dB/6dB/9dB/12dB/18dB</td>
<td>Specifies the gain value for the L position of the GAIN switch.</td>
</tr>
<tr>
<td>Gain Mid</td>
<td>-3dB/0dB/3dB/6dB/9dB/12dB/18dB</td>
<td>Specifies the gain value for the M position of the GAIN switch.</td>
</tr>
<tr>
<td>Gain High</td>
<td>-3dB/0dB/3dB/6dB/9dB/12dB/18dB</td>
<td>Specifies the gain value for the H position of the GAIN switch.</td>
</tr>
<tr>
<td>Gain Turbo</td>
<td>-3dB/0dB/3dB/6dB/9dB/12dB/18dB/24dB</td>
<td>Specifies the gain value for the Turbo Gain function, which can be assigned to an assignable switch.</td>
</tr>
</tbody>
</table>

### Shockless Gain
On/Off
Turns shockless gain (a function that switches smoothly when the gain is switched) on or off.

### TLCS
Makes settings related to total level control.

<table>
<thead>
<tr>
<th>Mode</th>
<th>Settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mode</td>
<td>Backlight/Standard/Spotlight</td>
<td>Selects the auto iris mode used when the TLCS system is activated. <strong>Backlight</strong>: Backlight mode (lessens the blackout of the main subject that occurs under backlit conditions) <strong>Standard</strong>: Standard mode <strong>Spotlight</strong>: Spotlight mode (lessens the whiteout of the main subject that occurs under a spotlight)</td>
</tr>
<tr>
<td>Speed</td>
<td>-99 to ±0 to +99</td>
<td>Specifies the control speed (speed of reaction to changes in the video) used when the TLCS system is activated. (Larger values specify quicker reaction times.)</td>
</tr>
<tr>
<td>AGC</td>
<td>On/Off</td>
<td>Turns the AGC (auto gain control) function on or off.</td>
</tr>
<tr>
<td>AGC Limit</td>
<td>3dB/6dB/9dB/12dB/18dB</td>
<td>Specifies the maximum gain used when AGC is on.</td>
</tr>
<tr>
<td>AGC Point</td>
<td>F5.6/F4/F2.8</td>
<td>Specifies the F value where control by auto iris switches to control by AGC, used when AGC is on.</td>
</tr>
<tr>
<td>Auto Shutter</td>
<td>On/Off</td>
<td>Turns the auto shutter function on or off.</td>
</tr>
<tr>
<td>Auto Shutter Limit</td>
<td>1/100 / 1/150 / 1/200 / 1/250</td>
<td>Selects the maximum shutter speed used when auto shutter is on.</td>
</tr>
<tr>
<td>Auto Shutter Point</td>
<td>F5.6/F8/F11/F16</td>
<td>Specifies the F value where control by auto iris switches to control by auto shutter, used when auto shutter is on.</td>
</tr>
</tbody>
</table>

### Zebra
Makes settings related to zebra displays.

<p>| Zebra Select        | 1/2/BOTH                    | Selects the zebra pattern type (Zebra1, Zebra2, Both).                      |
| Zebra1 Level        | 50% to 70% to 107%          | Specifies the Zebra1 display level.                                         |
| Zebra1 Aperture Level | 1 to 10% to 20%            | Specifies the Zebra1 aperture level.                                        |
| Zebra2 Level        | 52% to 100% to 109%         | Specifies the Zebra2 display level.                                         |</p>
<table>
<thead>
<tr>
<th>Menu items</th>
<th>Sub-item</th>
<th>Settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display On/Off</td>
<td>Video Level Warnings</td>
<td>On/Off</td>
<td>Turns the warnings that appear when the video level is too bright or too dark on or off.</td>
</tr>
<tr>
<td></td>
<td>Brightness Display</td>
<td>On/Off</td>
<td>Turns the numerical indication of the video brightness on or off.</td>
</tr>
<tr>
<td></td>
<td>Histogram Display</td>
<td>On/Off</td>
<td>Turns the histogram display of video signal levels on or off (in HD mode only).</td>
</tr>
</tbody>
</table>
|               | Lens Info              | Off/Meter/Feet | Selects whether or not to display the depth of field indication and the unit for display of the depth of field.  
|               |                        |           | **Meter:** Displayed in meters  
|               |                        |           | **Feet:** Displayed in feet  
|               |                        |           | **Off:** Do not display                                                     |
|               | Focus Position         | On/Off    | Turns the indication of the lens focus position on or off.                                                                                   |
|               | Zoom Position          | On/Off    | Turns the indication of the lens zoom position on or off.                                                                                   |
|               | Audio Level Meter      | On/Off    | Turns the display of the audio level meters on or off.                                                                                      |
|               | Timecode               | On/Off    | Turns the display of time data (timecode, user bits, counter, duration) on or off.                                                          |
|               | Battery Remain         | On/Off    | Turns the indications of the remaining battery time and input voltage on or off.                                                            |
|               | Media Remain           | On/Off    | Turns the indication of the remaining media capacity on or off.                                                                               |
|               | TLCS Mode              | On/Off    | Turns the indication of the TLCS operating mode on or off.                                                                                   |
|               | Focus Mode             | On/Off    | Turns the indication of the focus operating mode on or off.                                                                                   |
|               | White Balance Mode     | On/Off    | Turns the indication of the white balance mode on or off.                                                                                   |
|               | Filter Position        | On/Off    | Turns the indication of the ND filter setting on or off.                                                                                     |
|               | Iris Position          | On/Off    | Turns the indication of the iris position on or off.                                                                                         |
|               | Gain Setting           | On/Off    | Turns the indication of the gain setting on or off.                                                                                          |
|               | Shutter Setting        | On/Off    | Turns the indications of the shutter mode and shutter speed on or off.                                                                     |
|               | Color Temp             | On/Off    | Turns the indication of the color temperature on or off.                                                                                     |
|               | Video Format           | On/Off    | Turns the indication of the video format on or off.                                                                                          |
**Display On/Off**  
Selects the items to display in the viewfinder screen.

<table>
<thead>
<tr>
<th>Menu items</th>
<th>Sub-item</th>
<th>Settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display On/Off</td>
<td>System Line</td>
<td>On/Off</td>
<td>Turns the indication of the system lines on or off.</td>
</tr>
<tr>
<td></td>
<td>Rec Mode</td>
<td>On/Off</td>
<td>Turns the indication of special recording modes (S&amp;Q, Interval, Frame Rec, Picture Cache Rec) on or off.</td>
</tr>
<tr>
<td></td>
<td>WRR RF Level</td>
<td>On/Off</td>
<td>Turns the indication of the digital wireless receiver reception level on or off.</td>
</tr>
<tr>
<td></td>
<td>Clip Number(PB)</td>
<td>On/Off</td>
<td>Turns the indication of clip information on or off.</td>
</tr>
<tr>
<td></td>
<td>VF Display</td>
<td>On/Off</td>
<td>Turns the viewfinder output image type display on or off.</td>
</tr>
</tbody>
</table>

**Auto Conv.**  
Makes settings related to auto convergence.

<table>
<thead>
<tr>
<th>Menu items</th>
<th>Sub-item</th>
<th>Settings</th>
<th>Description</th>
</tr>
</thead>
</table>
| Auto Conv.       | Adjust Point   | 20%Far/10%Far/Focus Point/10%Near/20%Near | Selects the position to which to move the convergence point relative to the focus point when using auto convergence.  
  20%Far: 20% further away  
  10%Far: 10% further away  
  Focus Point: Focus position  
  10%Near: 10% closer  
  20%Near: 20% closer |

**Adjust Lens (R)**  
Adjusts differences between left lens and right lens.  
*(see page 157)*

<table>
<thead>
<tr>
<th>Menu items</th>
<th>Sub-item</th>
<th>Settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Adjust Lens (R)</td>
<td>Vertical Axis</td>
<td>-99 to ±0 to +99</td>
<td>Adjusts the optical axis.</td>
</tr>
<tr>
<td></td>
<td>Zoom</td>
<td>-99 to ±0 to +99</td>
<td>Adjusts the zoom.</td>
</tr>
<tr>
<td></td>
<td>Focus</td>
<td>-99 to ±0 to +99</td>
<td>Adjusts the focus.</td>
</tr>
<tr>
<td></td>
<td>Iris</td>
<td>-99 to ±0 to +99</td>
<td>Adjusts the iris.</td>
</tr>
</tbody>
</table>

**Auto Iris**  
Makes settings related to auto iris.

<table>
<thead>
<tr>
<th>Menu items</th>
<th>Sub-item</th>
<th>Settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto Iris</td>
<td>Iris Override</td>
<td>On/Off</td>
<td>Turns iris override (a setting that opens or closes the iris more than normal) on or off.</td>
</tr>
<tr>
<td></td>
<td>Iris Speed</td>
<td>-99 to ±0 to +99</td>
<td>Specifies the iris control speed (speed of reaction to changes in the video). (Larger values specify quicker reaction times.)</td>
</tr>
<tr>
<td></td>
<td>Clip High light</td>
<td>On/Off</td>
<td>Turns on or off the function that disregards highlights and forces a flatter reaction to high luminance.</td>
</tr>
</tbody>
</table>
|                  | Iris Window    | 1/2/3/4/5/6/Var | Selects the auto iris detection window type.  
  Var: Variable |
<p>|                  | Iris Window Indication | On/Off | Turns the indication of the auto iris detection window frame on or off. |</p>
<table>
<thead>
<tr>
<th>Menu items</th>
<th>Sub-item</th>
<th>Settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>White Setting</td>
<td>White Switch&lt;B&gt;</td>
<td>Memory/ATW</td>
<td>Specifies the operating mode selected by the B position of the WHITE BAL switch. Memory: Auto white balance ATW: Auto tracing white balance.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Shockless White: Off/1/2/3 Specifies the reaction speed when the WHITE BAL switch setting is changed. Off is an instant reaction, and 1 is faster than 2 or 3.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>ATW Speed: 1/2/3/4/5 Specifies the reaction speed when the White Switch&lt;B&gt; setting is [ATW]. 1 is the fastest reaction.</td>
</tr>
<tr>
<td></td>
<td>AWB Fixed Area</td>
<td>On/Off</td>
<td>Specifies whether auto white balance is executed at the center of the screen. On: Execute in an area corresponding to 25% of the height and width of the screen. Off: Execute in an area corresponding to 70% of the height and width of the screen.</td>
</tr>
<tr>
<td></td>
<td>Filter White Memory</td>
<td>On/Off</td>
<td>Specifies whether to allocate a white balance memory area for each FILTER knob position. On: Allocation a white balance memory area for each FILTER knob position. Off: Use A/B memory regardless of the filter position.</td>
</tr>
</tbody>
</table>
## OPERATION

<table>
<thead>
<tr>
<th>Menu items</th>
<th>Sub-item</th>
<th>Settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Offset White</strong></td>
<td>Offset White &lt;A&gt;</td>
<td>On/Off</td>
<td>Specifies whether to add (On) or not to add (Off) an offset value to the white balance value in memory A.</td>
</tr>
<tr>
<td></td>
<td>Warm Cool &lt;A&gt;</td>
<td>Approximate color temperature</td>
<td>When the setting of Offset White &lt;A&gt; is [On], specifies (as a color temperature) the offset to add to the white balance value in memory A. (Note that the error range becomes larger for higher offset color temperatures. Adjust while viewing the actual video.)</td>
</tr>
<tr>
<td></td>
<td>Warm Cool Balance &lt;A&gt;</td>
<td>−99 to ±0 to +99</td>
<td>Specifies a more precise color temperature, for use when satisfactory video cannot be obtained with the Warm Cool &lt;A&gt; setting.</td>
</tr>
<tr>
<td></td>
<td>Offset White &lt;B&gt;</td>
<td>On/Off</td>
<td>When this is set to [On], the offset adjusted set with this item is added to the white balance of channel B.</td>
</tr>
<tr>
<td></td>
<td>Warm Cool &lt;B&gt;</td>
<td>Approximate color temperature</td>
<td>When the setting of Offset White &lt;B&gt; is [On], specifies (as a color temperature) the offset to add to the white balance value in memory B. (Note that the error range becomes larger for higher offset color temperatures. Adjust while viewing the actual video.)</td>
</tr>
<tr>
<td></td>
<td>Warm Cool Balance &lt;B&gt;</td>
<td>−99 to ±0 to +99</td>
<td>Specifies a more precise color temperature, for use when satisfactory video cannot be obtained with the Warm Cool &lt;B&gt; setting.</td>
</tr>
<tr>
<td><strong>Shutter Select</strong></td>
<td>Shutter Select</td>
<td>Second/Degree</td>
<td>Specifies the unit used to select shutter speeds.</td>
</tr>
<tr>
<td></td>
<td>Time Zone</td>
<td>Zone</td>
<td>Specifies a difference from UTC (Greenwich Mean Time) in units of 30 minutes.</td>
</tr>
<tr>
<td><strong>Clip</strong></td>
<td>Auto Naming</td>
<td>Title/Plan</td>
<td>Selects the clip naming format.</td>
</tr>
</tbody>
</table>

### Note

Do not assign clip names that begin with the “.” (period) symbol. Clips with names in which the first character is “.” cannot be viewed on the application software for computers.
**Clip**
Make settings for clip name or clip management.

**Note**
Do not assign clip names that begin with the “.” (period) symbol. Clips with names in which the first character is “.” cannot be viewed on the application software for computers.

**Title Prefix Text input**
Specifies the title part (4 to 46 alphanumeric characters) of clip titles.

When the currently specified title is eight characters or fewer in length, the entire title appears. When the title is longer than eight characters, the first seven characters appear and a “…” symbol appears in place of the eighth character.

Displays the Character Set screen.

**Character Set screen configuration**
- Character selection area (three lines)
  Select the character to insert at the title prefix cursor position.
  !#$%()+.-;=@[]^_~0123456789
  abcdefghijklmnopqrstuvwxyz
  ABCDEFGHIJKLMNOPQRSTUVWXYZ
  - Cursor operation area (one line)
  Space: Changes the character at the cursor position to a space
  INS: Inserts a space at the cursor position
  DEL: Deletes the character at the cursor position
  ←: Moves the cursor to the left
  →: Moves the cursor to the right
  ESC: Cancels the change and return to the normal menu
  END: Executes the change and return to the normal menu
- Title prefix area (one line)
  An area to enter the title

To set titles
1. Turn the MENU knob or press the arrow buttons to select a character, highlighting it, in the character selection area, and then press the MENU knob or the SET button to insert it at the cursor position in the title prefix area. (The cursor moves to the right.)
2. Repeat step 1 to add more characters to the title (using Space, INS, and DEL as required).
3. When you have finished entering the title, select END to close the Character Set screen.
<table>
<thead>
<tr>
<th>Menu items</th>
<th>Sub-item</th>
<th>Settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Clip</td>
<td>Number Set</td>
<td>0001 to 9999</td>
<td>Specifies the initial value of the numeric part (four digits) of clip names (unless the name specified in planning metadata with Auto Naming set to [Plan]).</td>
</tr>
<tr>
<td></td>
<td>Name Display</td>
<td>Off/On</td>
<td>Selects whether to display the name of the next clips to be recorded in E-E mode (On) or not (Off).</td>
</tr>
<tr>
<td></td>
<td>Update</td>
<td>Media(A)-L/Media(A)-R/Media(B)-L/Media(B)-R</td>
<td>Updates the management files on the media in the selected slot (execute by selecting Execute).</td>
</tr>
<tr>
<td>Plan.Metadata</td>
<td>Load/Slot(A)</td>
<td>Execute/Cancel</td>
<td>Executes load of planning metadata from the SxS memory card in slot A. Select [Execute] to show the list of the planning metadata files stored in the slot A SxS memory card and select a file to execute the load.</td>
</tr>
<tr>
<td></td>
<td>Load/Slot(B)</td>
<td>Execute/Cancel</td>
<td>Executes load of planning metadata from the SxS memory card in slot B. Select [Execute] to show the list of the planning metadata files stored in the slot B SxS memory card and select a file to execute the load.</td>
</tr>
<tr>
<td></td>
<td>Properties</td>
<td>Execute/Cancel</td>
<td>Displays the detailed information in the planning metadata loaded on the camcorder (execute by selecting [Execute]).</td>
</tr>
<tr>
<td></td>
<td>Clear</td>
<td>Execute/Cancel</td>
<td>Clears the planning metadata loaded on the camcorder (execute by selecting [Execute]).</td>
</tr>
<tr>
<td></td>
<td>Clip Name Disp</td>
<td>Title1(ASCII) Title2=UTF-8)</td>
<td>Selects the display mode of the clip name specified in planning metadata (see page 86).</td>
</tr>
</tbody>
</table>
# PAINT Menu

Settings in bold are the factory default values.

<table>
<thead>
<tr>
<th>PAINT Menu</th>
<th>Sub-item</th>
<th>Settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Switch Status</strong></td>
<td>Gamma</td>
<td>On/Off</td>
<td>Turns gamma correction on or off.</td>
</tr>
<tr>
<td></td>
<td>Black Gamma</td>
<td>On/Off</td>
<td>Turns black gamma correction on or off.</td>
</tr>
<tr>
<td></td>
<td>Matrix</td>
<td>On/Off</td>
<td>Turns linear matrix correction and user matrix correction on or off.</td>
</tr>
<tr>
<td></td>
<td>Knee</td>
<td>On/Off</td>
<td>Turns knee correction on or off.</td>
</tr>
<tr>
<td></td>
<td>White Clip</td>
<td>On/Off</td>
<td>Turns white clip correction on or off.</td>
</tr>
<tr>
<td></td>
<td>Detail</td>
<td>On/Off</td>
<td>Turns detail correction on or off.</td>
</tr>
<tr>
<td></td>
<td>Aperture</td>
<td>On/Off</td>
<td>Turns aperture correction on or off.</td>
</tr>
<tr>
<td></td>
<td>Flare</td>
<td>On/Off</td>
<td>Turns flare correction on or off.</td>
</tr>
<tr>
<td></td>
<td>Test Saw</td>
<td>On/Off</td>
<td>Turns the test saw signal on or off.</td>
</tr>
<tr>
<td><strong>White</strong></td>
<td>Color Temp &lt;A&gt;</td>
<td>1500K to 3200K to 50000K (reference values)</td>
<td>Displays the white balance color temperature saved in memory A.</td>
</tr>
<tr>
<td></td>
<td>Color Temp BAL &lt;A&gt;</td>
<td>–99 to ±0 to +99</td>
<td>Specifies the white balance gain values saved in memory A (linked R gain and B gain).</td>
</tr>
<tr>
<td></td>
<td>R Gain &lt;A&gt;</td>
<td>–99 to ±0 to +99</td>
<td>Specifies the white balance R gain value saved in memory A.</td>
</tr>
<tr>
<td></td>
<td>B Gain &lt;A&gt;</td>
<td>–99 to ±0 to +99</td>
<td>Specifies the white balance B gain value saved in memory A.</td>
</tr>
<tr>
<td></td>
<td>Color Temp &lt;B&gt;</td>
<td>1500K to 3200K to 50000K (reference values)</td>
<td>Displays the white balance color temperature saved in memory B.</td>
</tr>
<tr>
<td></td>
<td>Color Temp BAL &lt;B&gt;</td>
<td>–99 to ±0 to +99</td>
<td>Specifies the white balance gain values saved in memory B (linked R gain and B gain).</td>
</tr>
<tr>
<td></td>
<td>R Gain &lt;B&gt;</td>
<td>–99 to ±0 to +99</td>
<td>Specifies the white balance R gain value saved in memory B.</td>
</tr>
<tr>
<td></td>
<td>B Gain &lt;B&gt;</td>
<td>–99 to ±0 to +99</td>
<td>Specifies the white balance B gain value saved in memory B.</td>
</tr>
<tr>
<td><strong>Black</strong></td>
<td>Master Black</td>
<td>–99 to ±0 to +99</td>
<td>Specifies the master black level.</td>
</tr>
<tr>
<td></td>
<td>R Black</td>
<td>–99 to ±0 to +99</td>
<td>Specifies the R black level.</td>
</tr>
<tr>
<td></td>
<td>B Black</td>
<td>–99 to ±0 to +99</td>
<td>Specifies the B black level.</td>
</tr>
<tr>
<td>Menu items</td>
<td>Sub-item</td>
<td>Settings</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>--------------</td>
<td>------------</td>
<td>-------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Flare</strong></td>
<td>Flare</td>
<td>On/Off</td>
<td>Turns flare correction on or off.</td>
</tr>
<tr>
<td></td>
<td>Master Flare</td>
<td>−99 to ±0 to +99</td>
<td>Sets the master flare correction level.</td>
</tr>
<tr>
<td></td>
<td>R Flare</td>
<td>−99 to ±0 to +99</td>
<td>Sets the R flare correction level.</td>
</tr>
<tr>
<td></td>
<td>G Flare</td>
<td>−99 to ±0 to +99</td>
<td>Sets the G flare correction level.</td>
</tr>
<tr>
<td></td>
<td>B Flare</td>
<td>−99 to ±0 to +99</td>
<td>Sets the B flare correction level.</td>
</tr>
<tr>
<td><strong>Gamma</strong></td>
<td>Gamma</td>
<td>On/Off</td>
<td>Turns gamma correction on or off.</td>
</tr>
<tr>
<td></td>
<td>Step Gamma</td>
<td>0.35 to 0.45 to 0.90 (0.05 step)</td>
<td>Specifies a gamma correction value in steps of 0.05</td>
</tr>
<tr>
<td></td>
<td>Master Gamma</td>
<td>−99 to ±0 to +99</td>
<td>Specifies the master gamma level.</td>
</tr>
<tr>
<td></td>
<td>R Gamma</td>
<td>−99 to ±0 to +99</td>
<td>Specifies the R gamma level.</td>
</tr>
<tr>
<td></td>
<td>G Gamma</td>
<td>−99 to ±0 to +99</td>
<td>Specifies the G gamma level.</td>
</tr>
<tr>
<td></td>
<td>B Gamma</td>
<td>−99 to ±0 to +99</td>
<td>Specifies the B gamma level.</td>
</tr>
<tr>
<td></td>
<td>Gamma Select</td>
<td>The available settings vary depending on the setting in Gamma Category (see “Description”).</td>
<td>Select the gamma table to use in gamma correction.</td>
</tr>
<tr>
<td><strong>Black Gamma</strong></td>
<td>Black Gamma</td>
<td>On/Off</td>
<td>Turns black gamma correction on or off.</td>
</tr>
<tr>
<td></td>
<td>Gamma Level</td>
<td>−99 to ±0 to +99</td>
<td>Specifies the master black gamma level.</td>
</tr>
<tr>
<td></td>
<td>Range</td>
<td>Low/L.Mid/H.Mid/High</td>
<td>Selects the black gamma correction effective range.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>LOW: 0 to 3.6%</td>
<td>LOW: 0 to 3.6%</td>
</tr>
<tr>
<td></td>
<td></td>
<td>L.MID: 0 to 7.2%</td>
<td>L.MID: 0 to 7.2%</td>
</tr>
<tr>
<td></td>
<td></td>
<td>H.MID: 0 to 14.4%</td>
<td>H.MID: 0 to 14.4%</td>
</tr>
<tr>
<td></td>
<td></td>
<td>HIGH: 0 to 28.8%</td>
<td>HIGH: 0 to 28.8%</td>
</tr>
</tbody>
</table>
Knee
Makes settings related to knee correction. Knee correction is processing that prevents washout by compressing the bright parts of the video according to an upper limit for the dynamic range of the recorded and output picture. The signal level where knee processing begins is called the “knee point”, and the slope of knee compression is called the “knee slope”.

<table>
<thead>
<tr>
<th>Sub-item</th>
<th>Settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Knee</td>
<td>On/Off</td>
<td>Turns knee correction on or off.</td>
</tr>
<tr>
<td>Knee Point</td>
<td>50.0% to 90.0% to 109.0%</td>
<td>Specifies the knee point.</td>
</tr>
<tr>
<td>Knee Slope</td>
<td>–99 to ±0 to +99</td>
<td>Specifies the knee slope.</td>
</tr>
<tr>
<td>Knee Saturation</td>
<td>On/Off</td>
<td>Turns the knee saturation function on or off.</td>
</tr>
<tr>
<td>Knee Saturation Level</td>
<td>–99 to ±0 to +99</td>
<td>Specifies the knee saturation level.</td>
</tr>
</tbody>
</table>

White Clip
Makes settings related to white clipping adjustments. White clipping is processing that limits the maximum level of video output signals. The maximum video signal output value is called the “white clip level”.

<table>
<thead>
<tr>
<th>Sub-item</th>
<th>Settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>White Clip</td>
<td>On/Off</td>
<td>Turns white clipping adjustment on or off.</td>
</tr>
<tr>
<td>Level</td>
<td>90.0% to 109.0%</td>
<td>Specifies the white clip level.</td>
</tr>
</tbody>
</table>
### Detail

Makes settings related to detail adjustments. Detail adjustment is processing that improves the clarity of the video by adding detail signals to the edges of the subject.

<table>
<thead>
<tr>
<th>Sub-item</th>
<th>Settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Detail</td>
<td>On/Off</td>
<td>Turns detail adjustment on or off.</td>
</tr>
<tr>
<td>Level</td>
<td>-99 to ±0 to +99</td>
<td>Specifies the detail level.</td>
</tr>
<tr>
<td>H/V Ratio</td>
<td>-99 to ±0 to +99</td>
<td>Specifies the mix ratio between the H detail level and the V detail level.</td>
</tr>
<tr>
<td>Crispening</td>
<td>-99 to ±0 to +99</td>
<td>Specifies the crispening level.</td>
</tr>
<tr>
<td>Level Depend</td>
<td>On/Off</td>
<td>Turns the level depend adjustment function on or off.</td>
</tr>
<tr>
<td>Level Depend Level</td>
<td>-99 to ±0 to +99</td>
<td>Specifies the level depend level.</td>
</tr>
<tr>
<td>Frequency</td>
<td>-99 to ±0 to +99</td>
<td>Specifies the central frequency for H detail signals. Larger values give finer details.</td>
</tr>
</tbody>
</table>

### Aperture

Makes settings related to aperture correction. Aperture correction is processing to improve resolution by adding high-frequency aperture signals to the video signal, which corrects degeneration due to high-frequency characteristics.

<table>
<thead>
<tr>
<th>Sub-item</th>
<th>Settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Aperture On/Off</td>
<td></td>
<td>Turns aperture correction on or off.</td>
</tr>
<tr>
<td>Level</td>
<td>-99 to ±0 to +99</td>
<td>Sets the aperture level.</td>
</tr>
</tbody>
</table>
## Skin Detail
Makes settings related to skin detail correction. Skin detail correction is processing that increases or decreases the detail level of a specified color range (skin tone range), for the purpose of obtaining attractive reproduction of skin tones.

<table>
<thead>
<tr>
<th>Sub-item</th>
<th>Settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Skin Detail</td>
<td>On/Off</td>
<td>Turns skin detail correction on or off.</td>
</tr>
<tr>
<td>Area Detection</td>
<td>Color detection</td>
<td>Detects the color to be targeted by skin detail correction.</td>
</tr>
<tr>
<td>Area Indication</td>
<td>On/Off</td>
<td>Turns on or off the function that displays a zebra pattern in the area targeted by skin detail correction.</td>
</tr>
<tr>
<td>Level</td>
<td>–99 to ±0 to +99</td>
<td>Specifies the skin detail level.</td>
</tr>
<tr>
<td>Saturation</td>
<td>–99 to ±0 to +99</td>
<td>Specifies the saturation of the color targeted by skin detail correction.</td>
</tr>
<tr>
<td>Hue</td>
<td>0 to 359</td>
<td>Specifies the hue of the color targeted by skin detail correction.</td>
</tr>
<tr>
<td>Width</td>
<td>0 to 40</td>
<td>Specifies a range for the hue of the color targeted by skin detail correction.</td>
</tr>
</tbody>
</table>

## Matrix
Makes settings related to matrix correction. Matrix correction allows you to adjust the color and vividness of the video. Depending on the effect you want, you can select one from among a number of preset matrixes, which define different parameter sets. Or you can select a user matrix with your own parameters.

<table>
<thead>
<tr>
<th>Sub-item</th>
<th>Settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Matrix</td>
<td>On/Off</td>
<td>Turns the matrix correction function on or off.</td>
</tr>
<tr>
<td>Preset Matrix</td>
<td>On/Off</td>
<td>Turns the preset matrix function on or off.</td>
</tr>
<tr>
<td>Preset Select</td>
<td>1/2/3/4/5/6</td>
<td>Selects a preset matrix.</td>
</tr>
<tr>
<td>User Matrix</td>
<td>On/Off</td>
<td>Turns the user matrix function on or off.</td>
</tr>
<tr>
<td>User Matrix R-G</td>
<td>–99 to ±0 to +99</td>
<td>Specifies a freely defined R-G user matrix.</td>
</tr>
<tr>
<td>User Matrix R-B</td>
<td>–99 to ±0 to +99</td>
<td>Specifies a freely defined R-B user matrix.</td>
</tr>
<tr>
<td>User Matrix G-R</td>
<td>–99 to ±0 to +99</td>
<td>Specifies a freely defined G-R user matrix.</td>
</tr>
<tr>
<td>User Matrix G-B</td>
<td>–99 to ±0 to +99</td>
<td>Specifies a freely defined G-B user matrix.</td>
</tr>
<tr>
<td>User Matrix B-R</td>
<td>–99 to ±0 to +99</td>
<td>Specifies a freely defined B-R user matrix.</td>
</tr>
<tr>
<td>User Matrix B-G</td>
<td>–99 to ±0 to +99</td>
<td>Specifies a freely defined B-G user matrix.</td>
</tr>
</tbody>
</table>
## Menu List

### Chapter 6  Menu and Detailed Settings

Settings in bold are the factory default values.

### PAINT

<table>
<thead>
<tr>
<th>Menu items</th>
<th>Sub-item</th>
<th>Settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Multi Matrix</td>
<td>Multi Matrix</td>
<td>On/Off</td>
<td>Turns the multi matrix correction function on or off.</td>
</tr>
<tr>
<td></td>
<td>Area Indication</td>
<td>On/Off</td>
<td>Turns on or off the function that displays a zebra pattern in the color area targeted by multi matrix correction.</td>
</tr>
<tr>
<td></td>
<td>Color Detection</td>
<td>Color detection screen</td>
<td>Detects colors targeted by multi matrix correction.</td>
</tr>
<tr>
<td></td>
<td>Axis</td>
<td>B/B+/MG−/MG+/MG+/ R/R+/YL−/YL/ ′YL+/G−/ G+/CY/CY+/B−</td>
<td>Specifies a color targeted by multi matrix correction (16-axis mode)</td>
</tr>
<tr>
<td></td>
<td>Hue</td>
<td>−99 to ±0 to +99</td>
<td>Specifies the hue of the color targeted by multi matrix correction for each 16-axis mode.</td>
</tr>
<tr>
<td></td>
<td>Saturation</td>
<td>−99 to ±0 to +99</td>
<td>Specifies the saturation of the color targeted by multi matrix correction for each 16-axis mode.</td>
</tr>
</tbody>
</table>

### Low Key Sat.

<table>
<thead>
<tr>
<th>Menu items</th>
<th>Sub-item</th>
<th>Settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Low Key Saturation</td>
<td>On/Off</td>
<td>Turns low key saturation correction on or off.</td>
</tr>
<tr>
<td></td>
<td>Level</td>
<td>−99 to ±0 to +99</td>
<td>Specifies the saturation of colors in low luminance areas.</td>
</tr>
<tr>
<td></td>
<td>Range</td>
<td>Low/L.Mid/H.Mid/High</td>
<td>Specifies the luminance level for which low key saturation is enabled.</td>
</tr>
</tbody>
</table>

### MAINTENANCE Menu

Settings in bold are the factory default values.

<table>
<thead>
<tr>
<th>Menu items</th>
<th>Sub-item</th>
<th>Settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>White Shading</td>
<td>Channel Select</td>
<td>R(Left)/G(Left)/B(Left)/ R(Right)/G(Right)/ B(Right)</td>
<td>Selects the target of white shading correction.</td>
</tr>
<tr>
<td></td>
<td>R/G/B White H Saw</td>
<td>−99 to ±0 to +99</td>
<td>Specifies a SAW white shading correction value for the horizontal direction.</td>
</tr>
<tr>
<td></td>
<td>R/G/B White H Para</td>
<td>−99 to ±0 to +99</td>
<td>Specifies a parabola white shading correction value for the horizontal direction.</td>
</tr>
<tr>
<td></td>
<td>R/G/B White V Saw</td>
<td>−99 to ±0 to +99</td>
<td>Specifies a SAW white shading correction value for the vertical direction.</td>
</tr>
<tr>
<td></td>
<td>R/G/B White V Para</td>
<td>−99 to ±0 to +99</td>
<td>Specifies a parabola white shading correction value for the vertical direction.</td>
</tr>
<tr>
<td></td>
<td>White Saw/Para</td>
<td>On/Off</td>
<td>Turns the white shading SAW and parabola correction functions on or off.</td>
</tr>
</tbody>
</table>
### MAINTENANCE

<table>
<thead>
<tr>
<th>Menu Items</th>
<th>Sub-item</th>
<th>Settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Battery</td>
<td>Info Before End</td>
<td>5%/10%/15%...95%/100%</td>
<td>Specifies a threshold value that triggers a “Battery Near End” warning when a BP-GL95A battery pack is used.</td>
</tr>
<tr>
<td></td>
<td>Info End</td>
<td>0%/1%/2%/3%/4%/5%</td>
<td>Specifies a threshold value that triggers a “Battery End” warning when a BP-GL95A battery pack is used.</td>
</tr>
<tr>
<td></td>
<td>Sony Before End</td>
<td>11.5V to 17.0V (0.1V step)</td>
<td>Specifies a threshold value that triggers a “Battery Near End” warning when a BP-L60S/L80S battery pack is used.</td>
</tr>
<tr>
<td></td>
<td>Sony End</td>
<td>11.0V to 11.5V (0.1V step)</td>
<td>Specifies a threshold value that triggers a “Battery End” warning when a BP-L60S/L80S battery pack is used.</td>
</tr>
<tr>
<td></td>
<td>Other Before End</td>
<td>11.5V to 11.8V to 17.0V (0.1V step)</td>
<td>Specifies a threshold value that triggers a “Battery Near End” warning when a non-Sony battery pack is used.</td>
</tr>
<tr>
<td></td>
<td>Other End</td>
<td>11.0V to 14.0V (0.1V step)</td>
<td>Specifies a threshold value that triggers a “Battery End” warning when a non-Sony battery pack is used.</td>
</tr>
<tr>
<td></td>
<td>DC In Before End</td>
<td>11.5V to 11.8V to 17.0V (0.1V step)</td>
<td>Specifies a threshold value that triggers a “Battery Near End” warning when an external power source is connected to the DC IN connector.</td>
</tr>
<tr>
<td></td>
<td>DC In End</td>
<td>11.0V to 14.0V (0.1V step)</td>
<td>Specifies a threshold value that triggers a “Battery End” warning when an external power source is connected to the DC IN connector.</td>
</tr>
<tr>
<td></td>
<td>Detected Battery</td>
<td>Info/Sony/Other/DC IN</td>
<td>Displays the results of automatic battery pack type detection.</td>
</tr>
</tbody>
</table>
|            | Type Detection | Auto/Other | **Auto**: Detect the battery type automatically.  
**Other**: Fix battery type detection as “Other”. |
### Battery
Makes settings related to batteries.

<table>
<thead>
<tr>
<th>Segment No.</th>
<th>Settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>10</td>
<td>11.0V to 17.0V</td>
<td>Specify voltage threshold values that cause remaining capacity segments to go off in the display of remaining battery capacity (see page 34). (The segments go off below the specified value.) These values are used when the battery type has been found to be “Other”.</td>
</tr>
<tr>
<td>9</td>
<td>11.0V to 16.0V</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>11.0V to 15.0V</td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>11.0V to 14.0V</td>
<td></td>
</tr>
<tr>
<td>6</td>
<td>11.0V to 13.5V</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>11.0V to 13.0V</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>11.0V to 12.5V</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>11.0V to 12.0V</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>11.0V to 11.5V</td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>11.0V to 11.0V</td>
<td></td>
</tr>
</tbody>
</table>

### Audio
Makes settings related to audio.

<table>
<thead>
<tr>
<th>Sub-item</th>
<th>Settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Front MIC Select</td>
<td>Mono/Stereo</td>
<td>Selects whether the front microphone is monaural (Mono) or stereo (Stereo).</td>
</tr>
<tr>
<td>Audio CH3/4 Mode</td>
<td>Ch1/2 / Switch</td>
<td>Selects the input signals for the AUDIO IN CH3/CH4 connectors. Ch1/2: The same signals as the AUDIO IN CH1/CH2 connectors. Switch: The signals selected with the AUDIO IN CH3/CH4 switches.</td>
</tr>
<tr>
<td>Front MIC CH1 Ref</td>
<td>–70dB/–60dB/–50dB/</td>
<td>Selects the reference level for channel 1 of the front microphone.</td>
</tr>
<tr>
<td></td>
<td>–40dB/–30dB/–20dB</td>
<td></td>
</tr>
<tr>
<td>Front MIC CH2 Ref</td>
<td>–70dB/–60dB/–50dB/</td>
<td>Selects the reference level for channel 2 of the front microphone.</td>
</tr>
<tr>
<td></td>
<td>–40dB/–30dB/–20dB</td>
<td></td>
</tr>
<tr>
<td>Rear MIC CH1 Ref</td>
<td>–70dB/–60dB/–50dB/</td>
<td>Selects the reference input level when the setting of the AUDIO IN CH1 switch is MIC.</td>
</tr>
<tr>
<td></td>
<td>–40dB/–30dB/–20dB</td>
<td></td>
</tr>
<tr>
<td>Rear MIC CH2 Ref</td>
<td>–70dB/–60dB/–50dB/</td>
<td>Selects the reference input level when the setting of the AUDIO IN CH2 switch is MIC.</td>
</tr>
<tr>
<td></td>
<td>–40dB/–30dB/–20dB</td>
<td></td>
</tr>
<tr>
<td>Line Input Ref</td>
<td>+4dB/0dB/–3dB/EBUL</td>
<td>Selects the reference input level when the setting of the AUDIO IN CH1 and AUDIO IN CH2 switches are set to LINE.</td>
</tr>
<tr>
<td>Min Alarm Volume</td>
<td>Off/Set</td>
<td>Selects the volume when the ALARM knob is turned all the way down. Off: Almost inaudible Set: Fairly audible</td>
</tr>
</tbody>
</table>
## Audio
Makes settings related to audio.

<table>
<thead>
<tr>
<th>Menu items</th>
<th>Sub-item</th>
<th>Settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Audio</strong></td>
<td>Speaker Attenuate</td>
<td>Off/3dB/6dB/9dB/12dB</td>
<td>Selects the volume from the monitor speaker (does not affect earphone volume).</td>
</tr>
<tr>
<td></td>
<td>Headphone Out</td>
<td>Mono/Stereo</td>
<td>Selects whether the earphones are monaural (Mono) or stereo (Stereo).</td>
</tr>
<tr>
<td></td>
<td>Reference Level</td>
<td>–20dB/–18dB/–16dB/–12dB/EBUL</td>
<td>Selects the output level of the 1 kHz test signal.</td>
</tr>
<tr>
<td></td>
<td>Reference Out</td>
<td>0dB/+4dB/–3dB/EBUL</td>
<td>Specifies the output level with respect to the reference input level.</td>
</tr>
<tr>
<td></td>
<td>CH1&amp;2 AGC Mode</td>
<td>Mono/Stereo</td>
<td>For automatic adjustment of the input level of analog audio signals recorded on channels 1 and 2, specifies whether to make the adjustments separately for each channel (Mono) or in stereo mode (Stereo).</td>
</tr>
<tr>
<td></td>
<td>CH3&amp;4 AGC Mode</td>
<td>Mono/Stereo</td>
<td>For automatic adjustment of the input level of analog audio signals recorded on channels 3 and 4, specifies whether to make the adjustments separately for each channel (Mono) or in stereo mode (Stereo).</td>
</tr>
<tr>
<td></td>
<td>AGC Spec</td>
<td>–6dB/–9dB/–12dB/–15dB/–17dB</td>
<td>Selects the AGC saturation level.</td>
</tr>
<tr>
<td></td>
<td>Limiter Mode</td>
<td>Off/–6dB/–9dB/–12dB/–15dB/–17dB</td>
<td>For manual audio level adjustments, selects the saturation level for the limiter applied to loud input signals. Select Off if you do not wish to use the limiter.</td>
</tr>
<tr>
<td></td>
<td>Output Limiter</td>
<td>On/Off</td>
<td>Turns the audio output limiter on or off.</td>
</tr>
<tr>
<td></td>
<td>CH1 Wind Filter</td>
<td>On/Off</td>
<td>Turns the channel 1 wind filter on or off.</td>
</tr>
<tr>
<td></td>
<td>CH2 Wind Filter</td>
<td>On/Off</td>
<td>Turns the channel 2 wind filter on or off.</td>
</tr>
<tr>
<td></td>
<td>CH3 Wind Filter</td>
<td>On/Off</td>
<td>Turns the channel 3 wind filter on or off.</td>
</tr>
<tr>
<td></td>
<td>CH4 Wind Filter</td>
<td>On/Off</td>
<td>Turns the channel 4 wind filter on or off.</td>
</tr>
<tr>
<td></td>
<td>Audio SG (1KHz)</td>
<td>On/Off/Auto</td>
<td>Selects whether to output (On) or not output (Off) a 1 kHz test signal in color bar mode. <strong>Auto</strong>: Output a test signal only when the AUDIO SELECT CH1 switch is set to AUTO.</td>
</tr>
<tr>
<td>Menu items</td>
<td>Sub-item</td>
<td>Settings</td>
<td>Description</td>
</tr>
<tr>
<td>------------</td>
<td>----------</td>
<td>----------</td>
<td>-------------</td>
</tr>
</tbody>
</table>
| Audio      | MIC CH1 Level | Side1/Front/Front+Side1 | For recording input audio from the front microphone on channel 1, selects the knob that adjusts the audio level.  
**Side1**: The LEVEL knob (left) on the side panel  
**Front**: The MIC LEVEL control on the front panel  
**Front+Side1**: Adjust with both the LEVEL knob (left) and the MIC LEVEL control. |
|            | MIC CH2 Level | Side2/Front/Front+Side2 | For recording input audio from the front microphone on channel 2, selects the knob that adjusts the audio level.  
**Side2**: The LEVEL knob (right) on the side panel  
**Front**: The MIC LEVEL control on the front panel  
**Front+Side2**: Adjust with both the LEVEL knob (right) and the MIC LEVEL control. |
|            | Rear1/WRR Level | Side1/Front/Front+Side1 | Selects the knob that adjusts the audio levels of a wireless microphone and a device connected to the AUDIO IN CH1 connector on the rear panel.  
**Side1**: The LEVEL knob (left) on the side panel  
**Front**: The MIC LEVEL control on the front panel  
**Front+Side1**: Adjust with both the LEVEL knob (left) and the MIC LEVEL control. |
|            | Rear2/WRR Level | Side2/Front/Front+Side2 | Selects the knob that adjusts the audio levels of a wireless microphone and a device connected to the AUDIO IN CH2 connector on the rear panel.  
**Side2**: The LEVEL knob (right) on the side panel  
**Front**: The MIC LEVEL control on the front panel  
**Front+Side2**: Adjust with both the LEVEL knob (right) and the MIC LEVEL control. |
<table>
<thead>
<tr>
<th>Menu items</th>
<th>Sub-item</th>
<th>Settings</th>
<th>Description</th>
</tr>
</thead>
</table>
| Audio      | Audio CH3 Level | Side3/Front/Front+Side3 | Selects the knob that adjusts the level of audio recorded on channel 3.  
- **Side3**: The LEVEL knob on side panel  
- **Front**: The MIC LEVEL control on the front panel  
- **Front+Side3**: Adjust with both the LEVEL knob and the MIC LEVEL control. |
| Audio      | Audio CH4 Level | Side4/Front/Front+Side4 | Selects the knob that adjusts the level of audio recorded on channel 4.  
- **Side4**: The LEVEL knob on side panel  
- **Front**: The MIC LEVEL control on the front panel  
- **Front+Side4**: Adjust with both the LEVEL knob and the MIC LEVEL control. |
| WRR Setting | WRR Valid CH Sel | All/CH1 | Selects whether to enable channels 1 and 2 of the wireless receiver (All) or channel 1 only (CH1). |
| WRR Setting | WRR CH Select | TX1/TX2 | Specifies the target channel for other sub-items.  
- **TX1**: Channel 1  
- **TX2**: Channel 2 |
| WRR Setting | WRR Delay Comp | On/Off | Enables (On) or disables (Off) delay compensation for wireless audio input. (When On is selected, the audio in all E-E output is delayed by about 8 ms.) |
| WRR Setting | TX | --- | Displays the name of the transmitter whose signals are being received on the channel selected by WRR CH SELECT. |
| WRR Setting | TX Audio Peak | ---/Peak | Displays whether the AF level of the transmitter whose signals are being received on the channel selected by WRR CH SELECT are over peak. |
| WRR Setting | TX Input Level | ---/Mic/Line | Displays whether the input level of the transmitter whose signals are being received on the channel selected by WRR CH SELECT is set to microphone (Mic) or line (Line). |
| WRR Setting | TX ATT Level | --- | Sets the ATT level of the transmitter whose signals are being received on the channel selected by WRR CH SELECT. (The setting range varies depending on the transmitter.) |
### WRR Setting
Makes settings related to the wireless tuner.

<table>
<thead>
<tr>
<th>Sub-item</th>
<th>Settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>TX LCF Freq</td>
<td>---</td>
<td>Sets the low cut filter frequency of the transmitter whose signals are being received on the channel selected by WRR CH SELECT. (The setting range varies depending on the transmitter.)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Sub-item</th>
<th>Settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>TX System Delay</td>
<td>Auto/0.0ms to 8.0ms</td>
<td>Specifies the amount of audio delay. <strong>Auto:</strong> Automatically adjusts the amount of delay so that the delay in the audio received from the wireless transmitter is zero. <strong>0.0ms to 8.0ms:</strong> Sets the amount of anticipated wireless system delay, for cases in which several wireless systems are being used over a devices such as an audio mixer.</td>
</tr>
</tbody>
</table>

### Timecode
Makes settings related to timecode.

<table>
<thead>
<tr>
<th>Sub-item</th>
<th>Settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>TC Out</td>
<td>Auto/Generator</td>
<td>Selects the source for timecode output. <strong>Auto:</strong> During recording, output values generated by the timecode generator, and during playback output values obtained by the timecode reader. <strong>Generator:</strong> Output values generated by the timecode generator during both recording and playback.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Sub-item</th>
<th>Settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DF/NDF</td>
<td>DF/NDF</td>
<td>When the Country setting is other than [PAL Area], selects drop-frame mode (DF) or non-drop-frame mode (NDF).</td>
</tr>
<tr>
<td>LTC UBIT</td>
<td>Fix/Time</td>
<td>Specifies the data recorded in LTC user bits. <strong>Fix:</strong> Record user-specified data. <strong>Time:</strong> Record the current time.</td>
</tr>
</tbody>
</table>

### Essence Mark
Makes settings related to shot marks and clip index picture thumbnails.

<table>
<thead>
<tr>
<th>Sub-item</th>
<th>Settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ret Shot Mark 1</td>
<td>On/Off</td>
<td>Specify whether to input Shot Mark1 marks using the RET button on the lens.</td>
</tr>
<tr>
<td>Ret Shot Mark 2</td>
<td>On/Off</td>
<td>Specify whether to input Shot Mark2 marks using the RET button on the lens.</td>
</tr>
</tbody>
</table>
### Camera Config
Makes settings related to various camcorder operations.

<table>
<thead>
<tr>
<th>Sub-item</th>
<th>Settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rec Tally Blink</td>
<td>On/Off</td>
<td>Turns warning flashes by the TALLY indicator on or off. The warnings alert you an almost exhausted battery pack or low remaining media capacity.</td>
</tr>
<tr>
<td>Rec Review</td>
<td>3sec/10sec/Clip</td>
<td>Selects the recording review time. <strong>Clip:</strong> Review all of the most recently recorded clip.</td>
</tr>
<tr>
<td>HD SDI Remote I/F</td>
<td>Off/Chara/G-Tally/R-Tally</td>
<td>Selects whether to use the function that enables recording control from this camcorder of an external device connected to the HD/SD SDI OUT connector (HDSDI output). When the function is used, also selects the indication that shows whether the external device is recording. <strong>Off:</strong> Do not use the remote recording control function. <strong>Chara:</strong> Indicate by the external device control indication on the viewfinder screen. <strong>R-Tally:</strong> Indicates by the recording mode/operation status indication on the viewfinder screen.</td>
</tr>
<tr>
<td>Color Bars Select</td>
<td>ARIB/100%/75%/SMPTE</td>
<td>Selects the color bar type.</td>
</tr>
<tr>
<td>RM Common Memory</td>
<td>On/Off</td>
<td>Selects whether to share (On) or not share (Off) settings between times when a remote control unit is connected and times when the camcorder is used locally.</td>
</tr>
<tr>
<td>RM Rec Start</td>
<td>RM/CAM/PARA</td>
<td>For times when a remote control unit is connected, selects whether recording start/stop buttons are enabled on the camcorder or the remote control unit. <strong>RM:</strong> Remote control unit <strong>CAM:</strong> Camcorder <strong>PARA:</strong> Both</td>
</tr>
<tr>
<td>Menu Scroll</td>
<td>Normal/Loop</td>
<td>Sets the movement when scrolling the menu. <strong>Normal:</strong> Stops at the top and bottom. <strong>Loop:</strong> Loops between top and bottom.</td>
</tr>
<tr>
<td>Menu items</td>
<td>Sub-item</td>
<td>Settings</td>
</tr>
<tr>
<td>------------------</td>
<td>----------------------</td>
<td>---------------------------------</td>
</tr>
<tr>
<td><strong>Preset White</strong></td>
<td><strong>Color Temp&lt;P&gt;</strong></td>
<td>1500K to <strong>3200K</strong> to 50000K (reference values)</td>
</tr>
<tr>
<td></td>
<td><strong>Color Temp Balance&lt;P&gt;</strong></td>
<td>–99 to ±0 to +99</td>
</tr>
<tr>
<td></td>
<td><strong>R Gain &lt;P&gt;</strong></td>
<td>–99 to ±0 to +99</td>
</tr>
<tr>
<td></td>
<td><strong>B Gain &lt;P&gt;</strong></td>
<td>–99 to ±0 to +99</td>
</tr>
<tr>
<td></td>
<td><strong>AWB Enable &lt;P&gt;</strong></td>
<td>On/Off</td>
</tr>
<tr>
<td><strong>White Filter</strong></td>
<td><strong>ND Filter C.Temp</strong></td>
<td>On/Off</td>
</tr>
<tr>
<td></td>
<td><strong>ND FLT C.Temp&lt;1&gt;</strong></td>
<td><strong>3200K/4300K/5600K/6300K</strong></td>
</tr>
<tr>
<td></td>
<td><strong>ND FLT C.Temp&lt;2-4&gt;</strong></td>
<td><strong>3200K/4300K/5600K/6300K</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Electrical CC&lt;A&gt;</strong></td>
<td><strong>3200K/4300K/5600K/6300K</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Electrical CC&lt;B&gt;</strong></td>
<td><strong>3200K/4300K/5600K/6300K</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Electrical CC&lt;C&gt;</strong></td>
<td><strong>3200K/4300K/5600K/6300K/-----</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Electrical CC&lt;D&gt;</strong></td>
<td><strong>3200K/4300K/5600K/6300K/-----</strong></td>
</tr>
</tbody>
</table>
## MAINTENANCE

### Menu items

<table>
<thead>
<tr>
<th>Sub-item</th>
<th>Settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Auto Iris 2</strong></td>
<td>Iris Window</td>
<td>Selects the type of iris detection window. Var: Variable</td>
</tr>
<tr>
<td></td>
<td>1/2/3/4/5/6/Var</td>
<td></td>
</tr>
<tr>
<td>Iris Window Ind</td>
<td>On/Off</td>
<td>Turns on or off the function that displays a frame marker for the auto iris detection window.</td>
</tr>
<tr>
<td>Iris Level</td>
<td>–99 to ±0 to +99</td>
<td>Adjusts the level of the auto iris target value.</td>
</tr>
<tr>
<td>Iris APL Ratio</td>
<td>–99 to ±0 to +99</td>
<td>Adjusts the mix ratio of auto iris detection peak value and average value (available when OPERATION &gt;TLCS &gt;Mode is set to [Standard]).</td>
</tr>
<tr>
<td>Iris Var Width</td>
<td>40 to 500 to 999</td>
<td>Adjusts the width of the detection window when the setting of Iris Window is VAR.</td>
</tr>
<tr>
<td>Iris Var Height</td>
<td>70 to 500 to 999</td>
<td>Adjusts the height of the detection window when the setting of Iris Window is VAR.</td>
</tr>
<tr>
<td>Iris Var H Position</td>
<td>–249 to 0 to +249</td>
<td>Specifies the horizontal position of the detection window when the setting of Iris Window is VAR.</td>
</tr>
<tr>
<td>Iris Var V Position</td>
<td>–249 to 0 to +249</td>
<td>Specifies the vertical position of the detection window when the setting of Iris Window is VAR.</td>
</tr>
<tr>
<td>Iris Speed</td>
<td>–99 to ±0 to +99</td>
<td>Specifies the control speed (speed of reaction to changes in the video). (Larger values specify quicker reaction times.)</td>
</tr>
<tr>
<td>Clip High Light</td>
<td>On/Off</td>
<td>Turns on or off the function that disregards highlights and forces a flatter reaction to high luminance.</td>
</tr>
</tbody>
</table>

### Flicker Reduce

In 2D mode, makes settings related to flicker reduction. Reduces the flicker that can occur when a subject is shot under a light source with a periodically varying brightness, such as fluorescent lights, due to the relationship with the camcorder's recording frame rate.

<table>
<thead>
<tr>
<th>Sub-item</th>
<th>Settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mode</td>
<td>Auto/On/Off</td>
<td>Enables or disables flicker reduction. On: Always enabled. Auto: Enabled when flicker is detected. Off: Disabled</td>
</tr>
<tr>
<td>Frequency</td>
<td>60Hz/50Hz</td>
<td>Set to the frequency of the lighting fixture that is causing the flicker. (The factory default setting is 50 Hz when the Country setting is “PAL Area”, 60 Hz when it is other than “PAL Area”.)</td>
</tr>
<tr>
<td>H Phase(HD)</td>
<td>–999 to ±0 to +999</td>
<td>Specifies the H phase of HD output when genlock is enabled.</td>
</tr>
<tr>
<td>H Phase(SD)</td>
<td>–99 to ±0 to +99</td>
<td>Specifies the H phase of SD output when genlock is enabled.</td>
</tr>
<tr>
<td>Reference</td>
<td>Internal/Genlock</td>
<td>Displays the type of reference signal used by the camcorder.</td>
</tr>
<tr>
<td>Menu items</td>
<td>Sub-item</td>
<td>Settings</td>
</tr>
<tr>
<td>---------------------</td>
<td>----------------</td>
<td>----------------</td>
</tr>
<tr>
<td><strong>ND Comp</strong></td>
<td>ND Offset Adjust</td>
<td>On/Off</td>
</tr>
<tr>
<td></td>
<td>Clear ND Offset</td>
<td>Execute/Cancel</td>
</tr>
<tr>
<td><strong>Lens</strong></td>
<td>Auto FB Adjust</td>
<td>Execute/Cancel</td>
</tr>
<tr>
<td></td>
<td>Config Start</td>
<td>Zoom/Focus/Iris/Vertical Axis/Cancel</td>
</tr>
<tr>
<td></td>
<td>Config Clear</td>
<td>Execute/Cancel</td>
</tr>
<tr>
<td></td>
<td>Config Status</td>
<td>Zoom/Focus/Iris/Vertical Axis/Cancel</td>
</tr>
<tr>
<td><strong>Network Setting</strong></td>
<td>DHCP</td>
<td>Enable/Disable</td>
</tr>
<tr>
<td></td>
<td>IP Address</td>
<td>0.0.0.0 to 255.255.255.255 (192.168.1.10)</td>
</tr>
<tr>
<td></td>
<td>Subnet Mask</td>
<td>0.0.0.0 to 255.255.255.255</td>
</tr>
<tr>
<td></td>
<td>Default Gateway</td>
<td>0.0.0.0 to 255.255.255.255</td>
</tr>
<tr>
<td></td>
<td>User Name</td>
<td>admin</td>
</tr>
<tr>
<td></td>
<td>Password</td>
<td>pmw-td300 (model name)</td>
</tr>
<tr>
<td></td>
<td>Set</td>
<td>Execute/Cancel</td>
</tr>
<tr>
<td></td>
<td>MAC Address</td>
<td>Execute/Cancel</td>
</tr>
<tr>
<td></td>
<td>Net Config Reset</td>
<td>Execute/Cancel</td>
</tr>
</tbody>
</table>

**Notes**
- The CBK-W A01 Wi-Fi Adapter is required.
- This item is disabled (displayed in grey) during recording and play.

For details on network connection, refer to the Supplement supplied in the CD-ROM (labeled “Manuals for Solid-State Memory 3D Camcorder”).
## Wi-Fi Setting

Makes settings for Wi-Fi connection.

### Notes

- The CBK-WA01 Wi-Fi Adapter is required.
- This item is disabled (displayed in grey) during recording and play.

For details on Wi-Fi connection, refer to the Supplement supplied in the CD-ROM (labeled “Manuals for Solid-State Memory 3D Camcorder”).

<table>
<thead>
<tr>
<th>Sub-item</th>
<th>Settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scan Networks</td>
<td>Execute/Cancel</td>
<td>When Wi-Fi is set to [Enable], scan the available network connection.</td>
</tr>
<tr>
<td>SSID</td>
<td>Network connection name</td>
<td>Sets the network connection name of up to 32 characters.</td>
</tr>
<tr>
<td>Network Type</td>
<td>Infra/Adhoc</td>
<td>Selects the network authentication on the wireless channel.</td>
</tr>
<tr>
<td>Ch</td>
<td>1 to 11</td>
<td>When Network Type is set to [Adhoc], set the wireless channel.</td>
</tr>
<tr>
<td>Authentication</td>
<td>Open/Shared/WPA/WPA2</td>
<td>Selects the network authentication. OPEN: Open system authentication, SHARED: Shared key authentication, WPA: WPA (Wi-Fi Protected Access) authentication, WPA2: WPA2 (Wi-Fi Protected Access 2) authentication</td>
</tr>
<tr>
<td>Encryption</td>
<td>Disable/WEP/Tkip/AES</td>
<td>Selects whether to apply data encryption and the type of data encryption. Disable: Do not apply data encryption, WEP: Apply WEP (Wired Equivalent Privacy) when Authentication is set to [Open] or [Shared], TKIP: Apply TKIP (Temporal Key Integrity Protocol) when Authentication is set to [WPA] or [WPA2], AES: Apply AES (Advanced Encryption Standard) when Authentication is set to [WPA] or [WPA2]</td>
</tr>
<tr>
<td>WEP Key Index</td>
<td>1/2/3/4</td>
<td>When Encryption is [WEP], selects the key index.</td>
</tr>
<tr>
<td>Input Select</td>
<td></td>
<td>Selects the input format depending on the network key (or security key). ASCII15: Five characters ASCII format, ASCII13: 13 characters ASCII format, HEX10: 10 hexadecimal digits, HEX26: 26 hexadecimal digits, ASCII8-63, HEX64: 8 to 63 characters ASCII 8-bit format, HEX64: 64 hexadecimal digits (characters)</td>
</tr>
<tr>
<td>Key</td>
<td></td>
<td>Sets the network key (or security key).</td>
</tr>
</tbody>
</table>
## Wi-Fi Setting
Makes settings for Wi-Fi connection.

### Notes
- The CBK-WA01 Wi-Fi Adapter is required.
- This item is disabled (displayed in grey) during recording and play.

For details on Wi-Fi connection, refer to the Supplement supplied in the CD-ROM (labeled “Manuals for Solid-State Memory 3D Camcorder”).

### Settings
- **Wi-Fi Status**: Displays “Connecting” while connection is being attempted. Displays black squares to show the connection status by the number of squares when the camcorder is connected to a computer or a LAN.
- **Wireless Mode**: Displays an IEEE802.11 standard.
- **Wi-Fi Enable/Disable**: Selects whether to enable or disable Wi-Fi connection.

### Clock Set
Sets the internal clock.

- **Date/Time**: Sets the current date and time.
  - **12H/24H**: Selects the 12-hour format (12H) or the 24-hour format (24H) for display of times.
- **Date Mode**: Selects the display format for dates.
  - **YYMMDD/MMDDYY/DDMMYY**

### Language
Selects the language for messages.

- **Language**: Selects the language for messages from English or Chinese.
- **English/Chinese**

### Hours Meter
Makes settings related to the digital hours meter.

- **Hours(Sys)**: Displays the cumulative hours of use (cannot be reset).
- **Hours(Reset)**: Displays the hours of use (can be reset).
- **Reset**: Resets Hours(Reset) to 0. (Execute by selecting Execute.)

### Version
Displays the version of the camcorder, and updates the camcorder.

- **Version**: Displays the software version of the camcorder (Vx.xx).
- **Version Up**: Updates the camcorder (execute by selecting Execute.).

### Note
This cannot be selected unless an SxS memory card is inserted.
## FILE Menu

Settings in bold are the factory default values.

<table>
<thead>
<tr>
<th>FILE Menu items</th>
<th>Sub-item</th>
<th>Settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>All</strong></td>
<td>Display Mode</td>
<td>Date&amp;Time/Model Name</td>
<td>Selects the items to be displayed in the list box that appears when a file is saved or loaded.</td>
</tr>
<tr>
<td></td>
<td>All File Load</td>
<td>Execute/Cancel</td>
<td>Loads an ALL file (execute by selecting Execute).</td>
</tr>
<tr>
<td></td>
<td>All File Save</td>
<td>Execute/Cancel</td>
<td>Stores an ALL file (execute by selecting Execute).</td>
</tr>
<tr>
<td></td>
<td>File ID</td>
<td>Execute/Cancel</td>
<td>Assigns a name to a file. Names can be up to 16 characters in length.</td>
</tr>
<tr>
<td></td>
<td>All Preset</td>
<td>Execute/Cancel</td>
<td>Return all items to their preset values (execute by selecting Execute).</td>
</tr>
<tr>
<td></td>
<td>Store All Preset</td>
<td>Execute/Cancel</td>
<td>Store the current settings of all items as the preset values (execute by selecting Execute).</td>
</tr>
<tr>
<td></td>
<td>Clear All Preset</td>
<td>Execute/Cancel</td>
<td>Clear the preset values of all items (execute by selecting Execute).</td>
</tr>
<tr>
<td></td>
<td>3Sec Clr Preset</td>
<td>On/Off</td>
<td>Turns on or off the function that clears each preset value when the MENU CANCEL/PRST/ESCAPE switch is pushed up and held for three seconds on the CANCEL/PRST side.</td>
</tr>
<tr>
<td></td>
<td>Network Data</td>
<td>Off/On</td>
<td>Selects whether to load (On) or not load (Off) network settings when loading an ALL file.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Scene Menu items</th>
<th>Sub-item</th>
<th>Settings</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Scene</strong></td>
<td>1</td>
<td>Standard</td>
<td>File number and file ID</td>
</tr>
<tr>
<td></td>
<td>2</td>
<td>Standard</td>
<td>File number and file ID</td>
</tr>
<tr>
<td></td>
<td>3</td>
<td>Standard</td>
<td>File number and file ID</td>
</tr>
<tr>
<td></td>
<td>4</td>
<td>Standard</td>
<td>File number and file ID</td>
</tr>
<tr>
<td></td>
<td>5</td>
<td>Standard</td>
<td>File number and file ID</td>
</tr>
<tr>
<td></td>
<td>Standard</td>
<td>Date&amp;Time/Model Name</td>
<td>Selects the items to be displayed in the list box that appears when a file is saved or loaded.</td>
</tr>
<tr>
<td></td>
<td>Scene Recall Mem</td>
<td>Execute/Cancel</td>
<td>Loads a file from internal memory (execute by selecting Execute).</td>
</tr>
<tr>
<td></td>
<td>Scene Store Mem</td>
<td>Execute/Cancel</td>
<td>Stores a file in internal memory (execute by selecting Execute).</td>
</tr>
<tr>
<td></td>
<td>Scene Recall SxS</td>
<td>Execute/Cancel</td>
<td>Loads a file from an SxS memory card (execute by selecting Execute).</td>
</tr>
<tr>
<td></td>
<td>Scene Store SxS</td>
<td>Execute/Cancel</td>
<td>Stores a file to an SxS memory card (execute by selecting Execute).</td>
</tr>
<tr>
<td></td>
<td>File ID</td>
<td>Execute/Cancel</td>
<td>Assigns a name to a file. Names can be up to 16 characters in length.</td>
</tr>
<tr>
<td>Menu items</td>
<td>Sub-item</td>
<td>Settings</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>-------------------</td>
<td>------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Reference</td>
<td>Reference Store</td>
<td>Execute/Cancel</td>
<td>Stores the current settings of reference file items in the reference file that is maintained in internal memory (execute by selecting Execute).</td>
</tr>
<tr>
<td></td>
<td>Reference Clear</td>
<td>Execute/Cancel</td>
<td>Clear the reference file (execute by selecting Execute).</td>
</tr>
<tr>
<td></td>
<td>Reference Load</td>
<td>Execute/Cancel</td>
<td>Load a reference file from an SxS memory card (execute by selecting Execute).</td>
</tr>
<tr>
<td></td>
<td>Reference Save</td>
<td>Execute/Cancel</td>
<td>Store a reference file to an SxS memory card (execute by selecting Execute).</td>
</tr>
<tr>
<td></td>
<td>File ID</td>
<td></td>
<td>Assigns a name to a file. Names can be up to 16 characters in length.</td>
</tr>
<tr>
<td></td>
<td>Scene White Data</td>
<td>On/Off</td>
<td>Selects whether to load (On) or not load (Off) white balance data when Scene &gt;Scene Recall or Scene &gt;Standard is executed.</td>
</tr>
</tbody>
</table>
Assigning Functions to Assignable Switches

Using the Assignable SW item of the OPERATION menu, you can assign user-specified functions to the ASSIGN. 0 to 3 switches, the ASSIGNABLE 4 and 5 switches, the COLOR TEMP. button, ASSIGN. 6 switch and the RET button.

The following tables lists the functions that are assigned when the camcorder is shipped from the factory.

<table>
<thead>
<tr>
<th>Switch or button</th>
<th>Function</th>
<th>Assignable SW setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>ASSIGN. 0 switch</td>
<td>No assignment</td>
<td>Off</td>
</tr>
<tr>
<td>ASSIGN. 1 switch</td>
<td>Execute EZ mode, according to the setting of OPERATION &gt;TLCS.</td>
<td>EZ Mode</td>
</tr>
<tr>
<td>ASSIGN. 2 switch</td>
<td>No assignment</td>
<td>Off</td>
</tr>
<tr>
<td>ASSIGN. 3 switch</td>
<td>No assignment</td>
<td>Off</td>
</tr>
<tr>
<td>ASSIGNABLE 4 switch</td>
<td>No assignment</td>
<td>Off</td>
</tr>
<tr>
<td>ASSIGNABLE 5 switch</td>
<td>No assignment</td>
<td>Off</td>
</tr>
<tr>
<td>ASSIGN. 6 switch</td>
<td>Turn on or off the grid display in the viewfinder.</td>
<td>Grid(VF)</td>
</tr>
<tr>
<td>RET button</td>
<td>During recording or playback: Write a shot mark. In the other states: Conduct a recording review (if playback is allowed).</td>
<td>Lens RET</td>
</tr>
<tr>
<td>COLOR TEMP. button</td>
<td>Adjust the white balance with the preset white balance value of 5600K.</td>
<td>Color Temp SW 5600K</td>
</tr>
</tbody>
</table>

Functions that can be Assigned to the ASSIGN. 0 Switch

<table>
<thead>
<tr>
<th>Assignable switch setting</th>
<th>Function</th>
<th>State when camcorder is next powered on</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td>No assignment</td>
<td>—</td>
</tr>
<tr>
<td>Marker</td>
<td>Turn the display of all markers on or off.</td>
<td>Setting retained</td>
</tr>
<tr>
<td>ATW Hold</td>
<td>Hold the white balance setting in the ATW (auto-tracking white balance) mode</td>
<td>—</td>
</tr>
<tr>
<td>Picture Cache</td>
<td>Turn the picture cache function on or off.</td>
<td>Setting retained</td>
</tr>
<tr>
<td>Freeze Mix</td>
<td>Execute the freeze mix function.</td>
<td>—</td>
</tr>
<tr>
<td>Focus Mag</td>
<td>Turn the focus magnification function on or off.</td>
<td>Setting not retained</td>
</tr>
<tr>
<td>Zebra</td>
<td>Turn zebra display on or off.</td>
<td>Setting not retained</td>
</tr>
<tr>
<td>Shot Mark1</td>
<td>Write Shot Mark1.</td>
<td>—</td>
</tr>
<tr>
<td>Shot Mark2</td>
<td>Write Shot Mark2.</td>
<td>—</td>
</tr>
<tr>
<td>OK Mark</td>
<td>Add or delete an OK mark.</td>
<td>—</td>
</tr>
</tbody>
</table>
### Functions that can be Assigned to the ASSIGN. 2 Switch

**Note**
Immediately after you assign a function to the ASSIGN. 2 switch or you switch the recording format, the setting of the switch at that point may not match the camcorder’s internal state. After assigning a function, switch the ASSIGN. 2 switch or power the camcorder off and on again.

<table>
<thead>
<tr>
<th>Assignable switch setting</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td>No assignment</td>
</tr>
<tr>
<td>Front Mic</td>
<td>Switch between stereo and monaural when a stereo microphone is connected.</td>
</tr>
<tr>
<td>Marker</td>
<td>Turn the display of all markers on or off.</td>
</tr>
<tr>
<td>Picture Cache a)</td>
<td>Turn the picture cache function on or off.</td>
</tr>
<tr>
<td>Zebra</td>
<td>Turn zebra display on or off.</td>
</tr>
</tbody>
</table>

a) Immediately after you assign a function The OPERATION >Rec Function item in the setup menu is disabled (displayed in grey) and cannot be set when the Picture Cache function is turned on.

### Functions that can be Assigned to the ASSIGN. 1 and 3 Switches, the ASSIGNABLE 4 and 5 Switches, and the COLOR TEMP. Button

<table>
<thead>
<tr>
<th>Assignable switch setting</th>
<th>Function</th>
<th>State when camcorder is next powered on</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td>No assignment</td>
<td>—</td>
</tr>
<tr>
<td>Front Mic</td>
<td>Switch between stereo (On) and monaural (Off) when a stereo microphone is connected.</td>
<td>Setting retained</td>
</tr>
<tr>
<td>Marker</td>
<td>Turn the display of all markers on or off.</td>
<td>Setting retained</td>
</tr>
<tr>
<td>Last Clip Delete</td>
<td>Delete the most recently recorded clip.</td>
<td>—</td>
</tr>
<tr>
<td>ATW</td>
<td>Turn ATW (auto tracing white balance) mode on or off.</td>
<td>Setting not retained</td>
</tr>
<tr>
<td>ATW Hold</td>
<td>Hold the white balance setting in the ATW mode.</td>
<td>—</td>
</tr>
<tr>
<td>EZ Mode</td>
<td>Execute EZ mode according to the setting of OPERATION &gt;TLCS.</td>
<td>Setting retained</td>
</tr>
<tr>
<td>Turbo Gain</td>
<td>Execute Turbo Gain according to the setting of OPERATION &gt;Gain Switch &gt;Gain Turbo.</td>
<td>Setting not retained</td>
</tr>
<tr>
<td>Rec Review</td>
<td>Conduct a recording review.</td>
<td>—</td>
</tr>
<tr>
<td>Rec</td>
<td>Start or stop recording.</td>
<td>—</td>
</tr>
<tr>
<td>Picture Cache</td>
<td>Turn the picture cache function on or off.</td>
<td>Setting retained</td>
</tr>
<tr>
<td>Freeze Mix</td>
<td>Execute the freeze mix function.</td>
<td>Setting not retained</td>
</tr>
<tr>
<td>Spotlight</td>
<td>Turn the spotlight function in auto iris mode on or off.</td>
<td>Setting retained</td>
</tr>
<tr>
<td>Backlight</td>
<td>Turn the backlight function in auto iris mode on or off.</td>
<td>Setting retained</td>
</tr>
<tr>
<td>EVF Mode</td>
<td>Switch the viewfinder screen between B&amp;W (On) and color (Off).</td>
<td>Setting retained</td>
</tr>
<tr>
<td>BRT Disp</td>
<td>Turn the display of the brightness level on or off.</td>
<td>Setting retained</td>
</tr>
<tr>
<td>Histogram</td>
<td>Turn the histogram display on or off.</td>
<td>Setting retained</td>
</tr>
<tr>
<td>Lens Info</td>
<td>Switch the depth of field indication between off, displayed in meters, and displayed in feet.</td>
<td>Setting retained</td>
</tr>
<tr>
<td>Assignable switch setting</td>
<td>Function</td>
<td>State when camcorder is next powered on</td>
</tr>
<tr>
<td>---------------------------</td>
<td>----------</td>
<td>---------------------------------------</td>
</tr>
<tr>
<td>Zoom Tele/Wide</td>
<td>Assign the Zoom Tele function to ASSIGNABLE 4, and assign the Zoom Wide function to ASSIGNABLE 5 (displayed only when &lt;4&gt; and &lt;5&gt; are set).</td>
<td>—</td>
</tr>
<tr>
<td>Zoom Wide/Tele</td>
<td>Assign the Zoom Wide function to ASSIGNABLE 4, and assign the Zoom Tele function to ASSIGNABLE 5 (displayed only when &lt;4&gt; and &lt;5&gt; are set).</td>
<td>—</td>
</tr>
<tr>
<td>Manual Focus Assist</td>
<td>Turn the manual focus assist function on or off.</td>
<td>Setting retained</td>
</tr>
<tr>
<td>Focus Mag</td>
<td>Turn the focus magnification function on or off.</td>
<td>Setting not retained</td>
</tr>
<tr>
<td>Zebra</td>
<td>Turn zebra display on or off.</td>
<td>Setting not retained</td>
</tr>
<tr>
<td>Lens RET</td>
<td>During recording or playback: Write a shot mark. In the other states: Conduct a recording review (if playback is allowed).</td>
<td>—</td>
</tr>
<tr>
<td>Shot Mark1</td>
<td>Write Shot Mark1.</td>
<td>—</td>
</tr>
<tr>
<td>Shot Mark2</td>
<td>Write Shot Mark2.</td>
<td>—</td>
</tr>
<tr>
<td>OK Mark</td>
<td>Add or delete an OK mark.</td>
<td>—</td>
</tr>
<tr>
<td>Color Temp SW 3200K</td>
<td>Adjust the white balance with a 3200K preset value.</td>
<td>Setting retained</td>
</tr>
<tr>
<td>Color Temp SW 4300K</td>
<td>Adjust the white balance with a 4300K preset value.</td>
<td>Setting retained</td>
</tr>
<tr>
<td>Color Temp SW 5600K</td>
<td>Adjust the white balance with a 5600K preset value.</td>
<td>Setting retained</td>
</tr>
<tr>
<td>Color Temp SW 6300K</td>
<td>Adjust the white balance with a 6300K preset value.</td>
<td>Setting retained</td>
</tr>
<tr>
<td>Electrical CC</td>
<td>Function that switches the electrical CC filter (3200K/4300K/5600K/6300K) applied to white balance adjustment values. Each press of the switch or button switches in the order 3200K→4300K→5600K→6300K. These can also be applied from a menu (apply with Electrical CC&lt;a&gt;&lt;b&gt;&lt;c&gt;&lt;d&gt;).</td>
<td>Setting retained</td>
</tr>
<tr>
<td>Note</td>
<td>This function is not available when White Filter &gt;ND Filter C.Temp in the Maintenance menu is set to On. If you set ND Filter C.Temp to On after assigning the function, the assignable switch ceases to function.</td>
<td>—</td>
</tr>
<tr>
<td>CC5600K</td>
<td>Apply a 5600K electrical CC filter to white balance adjustment values.</td>
<td>Setting retained</td>
</tr>
<tr>
<td>Slot Select</td>
<td>Switch memory card slot (A or B).</td>
<td>—</td>
</tr>
<tr>
<td>Grid(VF)</td>
<td>Turn the grid display in the viewfinder on or off.</td>
<td>Setting retained</td>
</tr>
<tr>
<td>Convergence a)</td>
<td>Record the convergence point distance when Convergence is assigned to the assignable switch, and set the convergence point to the recorded distance when the assignable switch is used. You can record different convergence point distances in multiple assignable switches.</td>
<td>—</td>
</tr>
<tr>
<td>Conv. Near/Far</td>
<td>Assign the Convergence Near function to ASSIGNABLE switch 4, and assign the Convergence Far function to ASSIGNABLE switch 5 (displayed only when setting “&lt;4&gt;” and “&lt;5&gt;”).</td>
<td>—</td>
</tr>
</tbody>
</table>
a) When changing the convergence point distance recorded in an assignable switch, first assign a function other than Convergence to the assignable switch, then change the convergence point distance and reassign the Convergence function to the assignable switch.

## Functions that can be Assigned to the ASSIGN. 6 Switch

<table>
<thead>
<tr>
<th>Assignable switch setting</th>
<th>Function</th>
<th>State when camcorder is next powered on</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td>No assignment</td>
<td>—</td>
</tr>
<tr>
<td>Grid(VF)</td>
<td>Turn the grid display in the viewfinder on or off.</td>
<td>Setting retained</td>
</tr>
<tr>
<td>Depth Warning</td>
<td>Turn the display of the 3D depth warning on or off.</td>
<td>Setting retained</td>
</tr>
<tr>
<td>Grid &amp; Depth Warn.</td>
<td>Perform one of the following, depending on the viewfinder settings.</td>
<td>Setting retained</td>
</tr>
<tr>
<td></td>
<td><strong>L+R, L-R, R, or Anaglyph:</strong> Turn the grid display on or off.</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Left (L) display:</strong> Turn the 3D depth warning display on or off.</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>3D display:</strong> No change</td>
<td></td>
</tr>
</tbody>
</table>

## Functions that can be Assigned to the RET Button

<table>
<thead>
<tr>
<th>Assignable switch setting</th>
<th>Function</th>
<th>State when camcorder is next powered on</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td>No assignment</td>
<td>—</td>
</tr>
<tr>
<td>Lens RET</td>
<td><strong>During recording or playback:</strong> Write a shot mark.</td>
<td>—</td>
</tr>
<tr>
<td></td>
<td><strong>In the other states:</strong> Conduct a recording review (if playback is allowed).</td>
<td></td>
</tr>
<tr>
<td>Rec Review</td>
<td>Execute recording review.</td>
<td>—</td>
</tr>
<tr>
<td>Shot Mark1</td>
<td>Write Shot Mark1.</td>
<td>—</td>
</tr>
<tr>
<td>Shot Mark2</td>
<td>Write Shot Mark2.</td>
<td>—</td>
</tr>
<tr>
<td>OK Mark</td>
<td>Add or delete an OK mark.</td>
<td>—</td>
</tr>
<tr>
<td>Focus Mag</td>
<td>Turn the focus magnification function on or off.</td>
<td>Setting not retained</td>
</tr>
</tbody>
</table>
Assigning Functions to the Lens Dials

You can assign functions to each of the three dials (outer, mid, inner) on the lens unit. Note that the same function cannot be assigned to more than one dial. The functions are assigned to the dials using OPERATION >Lens Dial >Inner, Mid, or Outer in the setup menu.

You can also change the direction of rotation of the dial for each function.

Functions that can be Assigned to the Lens Dials

You can assign the following functions to the lens dials.

- Zoom
- Focus
- Convergence
- Iris

Setting the Direction of Rotation of the Dials

You can change the direction of rotation of the dial for each function assigned. The factory default settings for the direction of rotation of the dials are shown in the following table. You change the operation of the dial by assigning functions to the clockwise direction using the Focus Clockwise, Zoom Clockwise, Conv. Clockwise, and Iris Clockwise commands from OPERATION >Dial Operation in the setup menu.

<table>
<thead>
<tr>
<th>Function</th>
<th>Clockwise</th>
<th>Counterclockwise</th>
</tr>
</thead>
<tbody>
<tr>
<td>Focus</td>
<td>Near (Shifts focus closer)</td>
<td>Far (Shifts focus further away)</td>
</tr>
<tr>
<td>Zoom</td>
<td>Tele (Telephoto zoom-in)</td>
<td>Wide (Wide angle zoom-out)</td>
</tr>
<tr>
<td>Convergence</td>
<td>Near (Shifts convergence closer)</td>
<td>Far (Shifts convergence further away)</td>
</tr>
<tr>
<td>Iris</td>
<td>Open (Opens the iris aperture)</td>
<td>Close (Closes the iris aperture)</td>
</tr>
</tbody>
</table>

Note

The inner dial provides coarse adjustment for small movements of the dial. Consequently, fine adjustment may be difficult to achieve, depending on the assigned function.
Saving and Loading Settings

You can save setup menu settings in the camcorder’s internal memory and on SxS memory cards. This allows you to quickly recall an appropriate set of menu settings for the current situation.

Setting data is saved in the following categories.

**ALL files**: ALL files save the setting data of all menus. You can save up to 64 ALL files on an SxS memory card.

**Scene files**: Scene file save adjustments to PAINT menu items for the purpose of shooting a particular scene. You can save up to five scene files in the camcorder’s internal memory and up to 64 scene files on an SxS memory card.

**Reference files**: Reference files save the reference values that are set when you execute FILE >Scene >Standard in the setup menu. You can save one reference file in the camcorder’s internal memory and one on an SxS memory card.

The first settings stored in a file are called “preset” values.

Even after loading files to set up the camcorder, and overwriting original files with new settings, you can still recover preset values and reset files to their initial states (see page 148).

Cards in the left memory card slots are used when saving settings to or recalling settings from SxS memory cards.

### Saving Setting Data

This section explains how to save setting data in an ALL file.

Before starting, insert a writable SxS memory card into a left-side memory card slot.

See “Basic Setup Menu Operations” (page 101) for information about menu operations.

1. **Select FILE >All in the setup menu.**
   
   **To assign a name to the data before saving it**
   
   Assign a name before proceeding to step 2.
   
   For details, see “To assign names to files” (page 148).

2. **Select All File Save >Execute.**
   
   An ALL file list box appears.
   
   File numbers where “No File” is displayed are empty file numbers. File numbers with a file name or a date and time are the number of files that already contain data.

3. **Turn the MENU knob to select the desired file number.**

4. **Press the MENU knob.**
   
   A confirmation message appears.

5. **To execute the save, select [Execute], and then press the MENU knob.**

   **To cancel the save, select [Cancel], and then press the MENU knob.**

   If you choose to execute the save, the ACCESS lamp lights (in blue on the right-side panel and in orange in the card slot section). A completion message appears and the ACCESS lamp goes out when the data has been saved to the SxS memory card.

   **If an error message appears**

   One of the following error messages may appear during execution of the save, or as soon as you select [Execute]. In this case, the file is not saved to the SxS memory card.
To assign names to files

Assigning a name before you save data in an ALL file can make it easier to distinguish your files. The following characters can be used in file names.

- Alphanumeric characters (a–z, A–Z, 0–9)
- Special characters (! # $ % & ' ( ) * + , - . / : ; > ? @ [ \ ] ~)

1. Select FILE > All > File ID in the setup menu.
2. Turn the MENU knob to select a character, and then press the MENU knob.
3. Repeat step 3.
4. When you have finished entering characters, press the MENU knob to move the cursor to “SET”, and then press the MENU knob.
   - The specified name is displayed.
   - When you save the file (see page 147), the data will be saved under this name.

Loading Setting Data

Note

When you load a file from an SxS memory card, the data saved in the camcorder’s internal memory is overwritten.

See “Basic Setup Menu Operations” (page 101) for information about menu operations.

1. Select FILE > All in the setup menu.
2. Select [All Preset], and then press the MENU knob.
3. To execute the reset, select [Execute], and then press the MENU knob.
   - The specified file is reset to preset values.

Error message | Problem | What to do
---|---|---
NG: Cannot Save | No recordable media is inserted. | Insert recordable media.
NG: Media Full | The media is full. | Use media with free capacity remaining.

Resetting a File after Changing Its Contents

See “Basic Setup Menu Operations” (page 101) for information about menu operations.

1. Select FILE > All in the setup menu.
2. Select [All Preset], and then press the MENU knob.
3. To execute the reset, select [Execute], and then press the MENU knob.
   - If you choose to execute the reset, all settings in the ALL file are reset to preset values.
Saving and Loading Scene Files

Scene files allow you to save the following types of data.
- Values set in the PAINT menu
- Shutter speeds set in standard mode or ECS mode
- White balance data

The data that is saved and loaded depends on the setting of FILE >Reference >Scene White Data in the setup menu.

Saving Scene Files

To save a scene file to an SxS memory card, insert the card into a left-side memory card slot and then proceed as follows.

1. Select FILE >Scene in the setup menu.

To assign a name to the data before saving it
Assign a name before proceeding to step 2.
For details, see “To assign names to files” (page 148).

2. Select Scene Store Mem or Scene Store SxS.
Select Scene Store Mem if you want to save the data in the camcorder’s internal memory, and select Scene Store SxS if you want to save the data on an SxS memory card.

3. Press the MENU knob.
A list box of scene files appears. File numbers where “No File” is displayed are empty file numbers.

4. Select the file number under which you want to save the data, and then press the MENU knob.
A confirmation message appears.

5. To execute the save, select [Execute], and then press the MENU knob.
To cancel the save, select [Cancel], and then press the MENU knob.
If you selected Scene Store SxS in step 2, the ACCESS lamp lights when you execute the save (in blue on the right-side panel and in orange in the card slot section). When the data has been saved to the SxS memory card, a completion message appears and the ACCESS lamp goes out.

Loading Scene Files

To load a scene file from an SxS memory card, insert the SxS memory card into a left-side memory card slot, and then proceed as follows.

See “Basic Setup Menu Operations” (page 101) for information about menu operations.

1. Select FILE >Scene in the setup menu.

2. Select Scene Recall Mem or Scene Recall SxS.
Select Scene Recall Mem if you want to load the file from the camcorder’s internal memory, and select Scene Recall (SxS) if you want to load the file from an SxS memory card.

3. Press the MENU knob.
A list box of scene files appears. File numbers where “No File” is displayed are empty file numbers.

4. Select the desired file number, and then press the MENU knob.
A confirmation message appears.

5. To execute the load, select [Execute], and then press the MENU knob.
To cancel the load, select [Cancel], and then press the MENU knob.
If you selected Scene Recall SxS in step 2, the ACCESS lamp lights when you execute the load (in blue on the right-side panel and in orange in the card slot section). When the data has been loaded from the SxS memory card, a completion message appears and the ACCESS lamp goes out.
Note

The settings data (ALL file, scene file, reference file) of this camcorder and the PMW-350 are not compatible.
You can connect an RM-B150/B750 Remote Control Unit and operate this camcorder. For connection and operation of the RM-B150/B750, refer to the Supplement supplied in the CD-ROM (labeled “Manuals for Solid-State Memory 3D Camcorder”).

### Connecting External Monitors

Select the output signal and use an appropriate cable for the monitor to be connected.

![Diagram of connecting external monitors]

Regardless of whether the signal is HD or SD, the same status information and menus can be displayed on the external monitor as those on the viewfinder screen.

**Note**

SD signals down-converted for output have the following restrictions:

- Images of 50P/50i/25P are output as PAL signals, those of 59.94P/59.94i/29.97P are output as NTSC signals, and those of 23.98P are output as 2-3 pulled-down NTSC signals.
**HD/SD SDI OUT connectors (BNC)**

The two HD/SD SDI OUT connectors (left and right) can be used to connect to a monitor, switcher, VTR, or other recording device that supports SDI. They can output 3D or 2D signals. In 3D output mode, the left and right signals are output independently from the left and right connectors. In addition, the HD/SD SDI OUT (L) connector supports 3G-SDI, and can output both left and right signals. HD SDI side-by-side output is also supported using either the left or right connector.

The output signal from these connectors can be turned on or off using OPERATION > Output > SDI Output(L) and SDI Output(R) in the setup menu. Also, the output format from these connectors can be set using OPERATION > Output > SDI Signal(L) and SDI Signal(R) in the setup menu.

For connection, use a BNC cable (not supplied).

**HDMI connector**

The HDMI connector can be used to connect to a monitor, VTR, or other recording device that supports HDMI. It can output 3D or 2D signals. 3D signals are output in side-by-side format. If a monitor that does not support 3D is connected, the left side images are displayed.

The output from this connector can be turned on and off using OPERATION > Output > HDMI Output in the setup menu (see page 106). The output format from this connector can be set using OPERATION > Output > HDMI Signal in the setup menu.

For connection, use an HDMI cable (not supplied).

**VIDEO OUT connector**

The VIDEO OUT connector can be used to connect to a monitor, VTR, or other recording device that supports analog composite signals. It can output 2D signals.

The output signal from this connector varies depending on the setting of OPERATION > Output > Signal Format in the setup menu. When OPERATION > Output > Signal Format is set to SD, an analog composite signal matching the output signal from the HD/SD SDI OUT connector is output (the output signal is encoded in NTSC or PAL according to the setting of OPERATION > Format > Country in the setup menu (see page 104)). When OPERATION > Output > Signal Format is set to HD, a Y-format signal matching the output signal from the HD/SD SDI OUT connector is output.

To input the VIDEO OUT connector output signal to an external analog composite device, it may be necessary to change the input signal setting of that external device to be matched with the analog composite signal setting for the VIDEO OUT connector.

To input camcorder output audio to an external device such as a monitor or VTR or other recording device, connect the audio output of the AUDIO OUT connector to the audio input of that external device.

For connection, use a BNC cable (not supplied).
Operating Clips with a Computer

The clips recorded on SxS memory cards with this camcorder can be controlled on a computer or edited using the optional nonlinear editing software. For these purposes, the clips on an SxS memory card can be operated by directly loading the card in a computer or by connecting the camcorder or the optional SBAC-US10 SxS Memory Card USB Reader/Writer to the computer, using an USB cable as shown below.

Using the ExpressCard Slot of a Computer

If the computer is equipped with an ExpressCard/34 or ExpressCard/54 slot, you can directly insert the SxS memory card containing clips recorded with this camcorder and access to the files.

For the operating requirements for the computer, see “Using the Software” (page 17).

Note

The SxS Device Driver Software and SxS UDF driver software on the CD-ROM supplied with the camcorder must be installed on your computer. Before installation, be sure to read the enclosed SxS Device Driver Software End-User License Agreement.

For information on installation of the driver software, refer to the ReadMe on the supplied CD-ROM.

For support information for the driver software, visit the following URL:
http://www.sony.net/SxS-Support/

With a Windows computer
Check that a Removable Disk appears in My Computer. This indicates normal status.

With a Macintosh computer
An icon is displayed on the menu bar.

USB Connection with a Computer

Preparations

When you connect the camcorder to a computer using a USB cable (not supplied), the memory cards in the left slots are acknowledged as extended drives by the computer. When memory cards are inserted in left slots A and B, they are acknowledged as two independent extended drives by the computer.

Notes

- When connecting the USB cable to the computer, be careful to check the form and direction of the PC connector.
- The camcorder does not work on the bus power from the computer.

To start USB connection

When you connect a computer to the USB connector with a USB cable (not supplied), the message “Connect USB Now?” is displayed to prompt you to confirm that you wish to enable the USB connection. If you select “Cancel” or push the MENU CANCEL/PRST/ESCAPE down to the ESCAPE
side or if you disconnect the USB cable, the message “Connect USB Now?” disappears.

If you select “Execute” and press the MENU knob, the USB connection is enabled and this camcorder is recognized as an extension drive. You can carry out the same operations by using the arrow buttons (↑, ↓, ←, →) (see page 28).

If the USB connection is enabled during recording/playback operation, the operation is stopped and the message “USB Connecting” appears on the viewfinder screen. At this time, the output signal from the VIDEO OUT connector, HDMI connector, and HD/SD SDI OUT connector changes to a black signal.

Notes
- The camcorder cannot be operated for recording, playback, and so on while the message “USB Connecting” is displayed.
- When the computer accesses the media loaded in the camcorder, do not try to carry out the following operations.
  - Operating the camcorder (turning the power on/off, switching the operation mode, etc.)
  - Removing or loading a media from an active slot (being accessed from the computer)
  - Removing or connecting the USB cable

Disabling the USB connection
To disable the USB connection, follow the same procedure as that for removing a device from the computer.
To enable the USB connection again, first disconnect the USB cable and then reconnect it. The message “Connect USB Now?” appears again.

To remove an SxS memory card

Windows
1. Click on the icon of “Safely Remove Hardware” on the task bar of the computer.
2. Select “Safely remove SxS Memory Card - Drive(X:)” from the displayed menu.
3. Check that the Safe To Remove Hardware message appears then remove the card.

Macintosh
Drag the SxS memory card icon on the desktop to Trash.
If the SxS memory card icon is located on Finder, click on the eject icon on its side.

To use the supplied application software
To copy clips to the local disk of your computer and perform other management tasks, install the application software on the supplied CD-ROM.
Install the application software on the supplied CD-ROM to your computer.
Although the data regarding recorded materials are stored over multiple files and folders, you can easily handle the clips without considering such data and directory structure by using the application software.

Note
If you operate, e.g. copy the clips on the SxS memory card by using the Explorer (Windows) or Finder (Macintosh), the subsidiary data contained by the clips may not be maintained. To avoid such a problem, use the application software.

For the operating requirements, installation and operations, refer to the “XDCAM EX web sites” (page 12) or User’s Guide contained in the CD-ROM.

For support information on the application software, visit the web sites shown in “XDCAM EX web sites” (page 12) or on the cover page of the supplied CD-ROM.
To use a nonlinear editing system

For a nonlinear editing system, optional editing software that corresponds to the recording formats used with this camcorder is required. Store the clips to be edited on the HDD of your computer in advance, using the supplied application software. Some editing software may not operate properly. Be sure to confirm before use that it conforms to the recording formats used with this camcorder.

Editing 3D Clips using MPES-3D01

You can adjust, convert, or perform other image processing functions on 3D clips shot by the camcorder using MPES-3D01 Stereo Image Processor software. To edit using MPES-3D01 software, connect the HD/SD SDI OUT connector of the camcorder to the input connector of an MPE-200 Multi Image Processor running MPES-3D01 software, using a BNC cable (sold separately).
Check the functions of the camcorder before setting out for a shooting session, preferably by recording and playing back video and audio signals.

**Note**

Never use organic solvents such as thinners.

**Cleaning the Viewfinder**

Use a dust blower to clean the lens, the LCD screen, and mirror inside the viewfinder barrel.

**Note about the Battery Terminal**

The battery terminal of this unit (the connector for battery packs and AC adaptors) is a consumable part. Power may not be supplied to the unit properly if the pins of the battery terminal are bent or deformed by shock or vibrations, or if they become corroded due to prolonged outdoor use. Periodic inspections are recommended to keep the unit working properly and to prolong its usable lifetime. Contact a Sony service or sales representative for more information about inspections.
Adjusting Left/Right Lens Errors

If any errors occur between the left and right lenses, you can adjust the right lens to minimize the differences between it and the left lens. The following parameters are adjustable.

- Vertical optical axis
- Zoom (focal length)
- Focus
- Iris

The camcorder provides two correction methods: a single-point correction method when shooting and a slower multi-point correction method.

Note

Subjecting the camcorder to severe shocks may cause longitudinal errors in the left and right images.

Correcting at a Single Point

This method corrects the left/right lens error at a single point.

1. Press and hold the Shift button, and then press the ASSIGN. 6 switch. Or select OPERATION >Lens Adjust(R) in the setup menu. The camcorder switches to LENS ADJUST mode.

2. Select the parameter (vertical optical axis, zoom, focus, iris) to adjust using the MENU knob, and then press the MENU knob.

The display switches to the adjustment screen for the selected parameter and displays the correction value on the bottom of the screen.

3. Adjust the setting by turning the MENU knob, and then press the MENU knob.

4. After adjusting each parameter, press the MENU knob. The adjustment settings are saved.

Correcting at Multiple Points

This method corrects the zoom, focus, and other parameters at multiple points while changing the iris position.

Adjusting

1. Select MAINTENANCE >Lens >Start Config in the setup menu.

2. Select the parameter to adjust (zoom, focus, iris, vertical axis) by turning the MENU knob, and then press the MENU knob.

This description describes an example of adjusting the vertical axis parameter. The display switches to the adjustment screen and displays a vertical optical axis point (P1 to P10) and its correction value on the bottom of the screen.

3. Rotate the ZOOM dial and adjust the zoom to the desired position. The correction point display on the bottom of the screen automatically updates as the zoom position changes.

4. Turn the MENU knob, while watching the screen, and adjust the setting until the vertical axis error disappears. Turning the MENU knob adjusts the right lens image only.

5. Repeat steps 3 and 4 to adjust the zoom for other points as desired.

6. After adjusting for all points, press the MENU knob. The vertical axis correction values are fixed, and the display returns to the Start Config screen.

7. Select other parameters you wish to correct using the MENU knob, and repeat the same procedure.
To cancel
Hold down CANCEL/PRST/ESCAPE on the CANCEL/PRST side of the switch to cancel the correction function.

Clearing the correction values
Select MAINTENANCE >Lens >Clear Config >Execute in the setup menu.
The correction values for all parameters are cleared.

Checking the correction values
Select MAINTENANCE >Lens >Config Status in the setup menu, and then select the parameter to check.
The correction values for each point for the selected parameter are displayed. Rotate the MENU knob to scroll the display.

Adjusting the Flange Focal Length
If the lens does not stay in focus properly as you zoom from telephoto to wide angle, adjust the flange focal length (the distance from the plane of the lens mounting flange to the imaging plane). When carrying out the adjustment, use the supplied flange focal length adjustment chart as the subject.

Carrying out the adjustment
With the camcorder, zoom and focus operations automatically adjust the flange focal length.

1 Open the iris, position the supplied flange focal length adjustment chart approximately 3 meters (10 ft) away from the camcorder, and arrange the lighting to obtain a satisfactory video output.

2 Select MAINTENANCE >Lens >Auto FB Adjust >Execute in the setup menu.
The flange focal length adjustment starts.

During adjustment
The message “AUTO FB Adjust EXECUTING” appears on the viewfinder screen.

If the adjustment completes correctly
The message on the viewfinder screen changes to “Auto FB Adjust: OK”.

If the flange focal length adjustment does not complete correctly
Check the subject and lighting conditions, and repeat the adjustment.

Notes
- Subjecting the camcorder to severe shocks and large temperature variations may result in flange back errors.
- If you use a subject with insufficient contrast, or move the camcorder or subject during adjustment, this will cause an adjustment error.
- Place the subject (the flange focal length adjustment chart) so that it appears at the center of the screen at the telephoto end. Arrange so that no nearby object (no object closer to the camera than the chart) enters the screen at the wide-angle end.
Operation Warnings

If a problem occurs when the camcorder is powered or is being operated, a warning is issued by various visible and audible indicators. These visible and audible indicators are:

- Error/warning message (“A” in the “Layout of the table of warning messages” below)
- WARNING indicator (“B”), warning sound from the speaker and earphones (“C”), tally/REC indication (“D”), and battery remaining indicator (“E”).

A warning message, and the REC indication appear on the viewfinder screen. The volume of the warning sound can be adjusted with the ALARM knob. Set the ALARM knob to the minimum position to suppress the sound.

### Layout of the table of warning messages

<table>
<thead>
<tr>
<th>WARNING indicator</th>
<th>Warning sound</th>
<th>Tally/REC</th>
<th>Battery remaining</th>
</tr>
</thead>
<tbody>
<tr>
<td>B</td>
<td>C</td>
<td>D</td>
<td>E</td>
</tr>
<tr>
<td>Problem</td>
<td>Operation in the recorder module</td>
<td>Action to take</td>
<td></td>
</tr>
</tbody>
</table>

- The operation of the WARNING indicator, the tally/REC indication, and the battery indicator is represented by graphic symbols as follows.
  - **: Continuous
  - 1 flash/s
  - 4 flashes/s
- The warning sounds are represented by graphic symbols as follows.
  - : Continuous beep
  - 1 beep/s

### Error Indication

<table>
<thead>
<tr>
<th>WARNING indicator</th>
<th>Warning sound</th>
<th>Tally/REC</th>
<th>Battery remaining</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Problem</td>
<td>Operation in the recorder module</td>
<td>Action to take</td>
<td></td>
</tr>
</tbody>
</table>

The camcorder is abnormal.

Recording stops.

Turn off the power and confirm whether an error occurs on the connected devices, the cables, and the media or not. (If power cannot be turned off by setting the POWER switch to OFF, remove the battery pack or the AC power source.) If the problem continues after the camcorder is restarted, contact your Sony service representative.
## Warning Indication

<table>
<thead>
<tr>
<th>WARNING indicator</th>
<th>Warning sound</th>
<th>Tally/REC</th>
<th>Battery remaining</th>
</tr>
</thead>
<tbody>
<tr>
<td>![warning_indicator]</td>
<td>![warning_sound]</td>
<td>![tally_rec]</td>
<td>—</td>
</tr>
</tbody>
</table>

### Problem
Operation in the recorder module

### Action to take
- **Free space on the SxS memory card has become insufficient.**
  - In 3D mode, this calculates the remaining capacity based on the memory required for 3D recording and displays a warning for active slots.
  - Recording continues.
  - Replace it with another at the earliest opportunity.

<table>
<thead>
<tr>
<th>WARNING indicator</th>
<th>Warning sound</th>
<th>Tally/REC</th>
<th>Battery remaining</th>
</tr>
</thead>
<tbody>
<tr>
<td>![warning_indicator]</td>
<td>![warning_sound]</td>
<td>![tally_rec]</td>
<td>—</td>
</tr>
</tbody>
</table>

### Problem
Operation in the recorder module

### Action to take
- **No space is left on the SxS memory card.**
  - Recording and clip copying cannot be performed.
  - In 3D mode, this calculates the remaining capacity based on the memory required for 3D recording and displays a warning for active slots.
  - Recording stops.
  - Replace it with another.

<table>
<thead>
<tr>
<th>WARNING indicator</th>
<th>Warning sound</th>
<th>Tally/REC</th>
<th>Battery remaining</th>
</tr>
</thead>
<tbody>
<tr>
<td>![warning_indicator]</td>
<td>![warning_sound]</td>
<td>![tally_rec]</td>
<td>![battery_remaining]</td>
</tr>
</tbody>
</table>

### Problem
Operation in the recorder module

### Action to take
- **The battery power will be exhausted soon.**
  - Recording continues.
  - Charge the battery pack at the earliest opportunity.
<table>
<thead>
<tr>
<th><strong>WARNING indicator</strong></th>
<th><strong>Warning sound</strong></th>
<th><strong>Tally/REC</strong></th>
<th><strong>Battery remaining</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Battery End</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Problem</td>
<td>Operation in the recorder module</td>
<td>Action to take</td>
<td></td>
</tr>
<tr>
<td>The battery pack is exhausted. Recording cannot be performed.</td>
<td>Recording stops.</td>
<td>Connect a power source via the DC IN connector or stop operation to charge the battery pack.</td>
<td></td>
</tr>
<tr>
<td><strong>Temperature High</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Problem</td>
<td>Operation in the recorder module</td>
<td>Action to take</td>
<td></td>
</tr>
<tr>
<td>The internal temperature has risen above a safe operation limit.</td>
<td>Recording continues.</td>
<td>Suspend operation, turn off the power, and wait until the temperature falls.</td>
<td></td>
</tr>
<tr>
<td><strong>Voltage Low</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Problem</td>
<td>Operation in the recorder module</td>
<td>Action to take</td>
<td></td>
</tr>
<tr>
<td>The DC IN voltage has become low (stage 1).</td>
<td>Recording continues.</td>
<td>Check the power supply.</td>
<td></td>
</tr>
<tr>
<td><strong>Insufficient Voltage</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Problem</td>
<td>Operation in the recorder module</td>
<td>Action to take</td>
<td></td>
</tr>
<tr>
<td>The DC IN voltage is too low (stage 2). Recording cannot be performed.</td>
<td>Recording stops.</td>
<td>Connect other power source.</td>
<td></td>
</tr>
<tr>
<td><strong>Battery Error</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Problem</td>
<td>Operation in the recorder module</td>
<td>Action to take</td>
<td></td>
</tr>
<tr>
<td>An error was detected with the battery pack.</td>
<td>Recording stops.</td>
<td>Replace the battery pack with a normal one.</td>
<td></td>
</tr>
<tr>
<td><strong>Backup Battery End</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Problem</td>
<td>Operation in the recorder module</td>
<td>Action to take</td>
<td></td>
</tr>
<tr>
<td>The remaining power of the backup battery is insufficient.</td>
<td>Recording continues.</td>
<td>Refer to a Sony service representative to replace the battery with a new one.</td>
<td></td>
</tr>
<tr>
<td>Problem</td>
<td>Action to take</td>
<td></td>
<td></td>
</tr>
<tr>
<td>------------------------------------------------------------------------</td>
<td>--------------------------------------------------------------------------------</td>
<td></td>
<td></td>
</tr>
<tr>
<td>A partitioned memory card or one that contains recorded clips exceeding the number permitted with this camcorder is loaded.</td>
<td>Recording continues. This card cannot be used with this camcorder. Remove it and load a compatible card.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>The maximum number of clips for a single memory card is reached. No more clip can be recorded on the card.</td>
<td>Recording stops. Replace it with another card.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>An error occurred with the memory card. The card requires restoration.</td>
<td>Recording stops. Remove the card, load it again, and restore it.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Recording cannot be done, as the memory card is defective.</td>
<td>Recording stops. As playback may be possible, it is recommended to replace it with another card after copying the clips, as required.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Neither recording nor playback can be done, as the memory card is defective.</td>
<td>Recording stops. It cannot be operated with this camcorder. Replace it with another card.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>WARNING indicator</td>
<td>Warning sound</td>
<td>Tally/REC</td>
<td>Battery remaining</td>
</tr>
<tr>
<td>-------------------</td>
<td>---------------</td>
<td>----------</td>
<td>-----------------</td>
</tr>
<tr>
<td>Problem</td>
<td>Operation in the recorder module</td>
<td>Action to take</td>
<td></td>
</tr>
<tr>
<td>Cannot Use Media(A)1) Unsupported File System</td>
<td>A card of a different file system was inserted.</td>
<td>Recording stops.</td>
<td>It cannot be used with this camcorder. Replace it with another card.</td>
</tr>
<tr>
<td>Problem</td>
<td>Operation in the recorder module</td>
<td>Action to take</td>
<td></td>
</tr>
<tr>
<td>Media Error</td>
<td>An error occurred in reading data from the memory card, and playback cannot be continued.</td>
<td>Recording stops.</td>
<td>If this frequently occurs, change the memory card after copying the clips, as required.</td>
</tr>
<tr>
<td>Problem</td>
<td>Operation in the recorder module</td>
<td>Action to take</td>
<td></td>
</tr>
<tr>
<td>Media(A)1) Error</td>
<td>Recording cannot be done, as an error occurred with the memory card.</td>
<td>Recording stops.</td>
<td>If this frequently occurs, change the memory card.</td>
</tr>
<tr>
<td>Problem</td>
<td>Operation in the recorder module</td>
<td>Action to take</td>
<td></td>
</tr>
<tr>
<td>Not Enough Capacity</td>
<td>There is not enough capacity for copying.</td>
<td>Recording continues (disallowing copy).</td>
<td>Replace the card in slot A with another one.</td>
</tr>
<tr>
<td>Problem</td>
<td>Operation in the recorder module</td>
<td>Action to take</td>
<td></td>
</tr>
<tr>
<td>Reached Duplication Limit</td>
<td>The card has already ten clips having the same name as that you tried to duplicate.</td>
<td>Recording continues (disallowing copy).</td>
<td>Replace the card in slot A with another one.</td>
</tr>
<tr>
<td>Problem</td>
<td>Operation in the recorder module</td>
<td>Action to take</td>
<td></td>
</tr>
<tr>
<td>Will Switch Slots Soon</td>
<td>Will switch to other slot soon.</td>
<td>Recording continues.</td>
<td>Make sure that a memory card is loaded in the other slot.</td>
</tr>
<tr>
<td>Problem</td>
<td>Action to take</td>
<td></td>
<td></td>
</tr>
<tr>
<td>---------</td>
<td>----------------</td>
<td></td>
<td></td>
</tr>
<tr>
<td>No Clip</td>
<td>There is no clip to be displayed.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>No OK Clip</td>
<td>There is no clip with the OK mark.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Same File Already Exists</td>
<td>The card has already clips having the same name as that you tried to duplicate.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Media Reached Rewriting Limit</td>
<td>The memory card comes to the end of its service life.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Unsupported Clip Included</td>
<td>The inserted memory card contains clips recorded in a format that is not supported by this camcorder.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Record Only Left/Right Side</td>
<td>WARNING indicator</td>
<td>Warning sound</td>
<td>Tally/REC</td>
</tr>
<tr>
<td>----------------------------</td>
<td>-------------------</td>
<td>---------------</td>
<td>-----------</td>
</tr>
<tr>
<td></td>
<td>—</td>
<td>—</td>
<td>✪</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Problem</th>
<th>Operation in the recorder module</th>
<th>Action to take</th>
</tr>
</thead>
<tbody>
<tr>
<td>In 3D mode, clips are recording to memory cards on one side only.</td>
<td>Recording continues.</td>
<td>Insert recordable media in slots on both sides, as required.</td>
</tr>
</tbody>
</table>

1) (B) for the card in slot B
Appendix

Important Notes on Operation

Use and storage

Do not subject the camcorder to severe shocks
• The dual, fixed lens system is designed with very high precision. Do not subject to severe shocks.
• The internal mechanism may be damaged or the body warped.
• If an accessory mounted on the accessory shoe is subjected to severe shock, the accessory shoe may be damaged. In such a case, stop using it and contact your dealer or a Sony service representative.

Do not cover the camcorder while operating
Putting a cloth, for example, over the camcorder can cause excessive internal heat build-up.

After use
Always turn off the POWER switch.

Before storing the camcorder for a long period
Remove the battery pack.

Shipping
• Remove the media before transporting the camcorder.
• If sending the camcorder by truck, ship, air or other transportation service, pack it in the shipping carton of the camcorder.

Care of the camcorder
Remove dust and dirt from the surfaces of the lenses or optical filters using a blower.
If the body of the camcorder is dirty, clean it with a soft, dry cloth. In extreme cases, use a cloth steeped in a little neutral detergent, then wipe dry. Do not use organic solvents such as alcohol or thinners, as these may cause discoloration or other damage to the finish of the camcorder.

In the event of operating problems
If you should experience problems with the camcorder, contact a Sony service representative.

Use and storage locations
Store in a level, ventilated place. Avoid using or storing the camcorder in the following places.
• In excessive heat or cold (operating temperature range: 0 °C to 40 °C (32 °F to 104 °F))
• Remember that in summer in warm climates the temperature inside a car with the windows closed can easily exceed 50 °C (122 °F).
• In damp or dusty locations
• Locations where the camcorder may be exposed to rain
• Locations subject to violent vibration
• Near strong magnetic fields
• Close to radio or TV transmitters producing strong electromagnetic fields.
• In direct sunlight or close to heaters for extended periods

To prevent electromagnetic interference from portable communications devices
The use of portable telephones and other communications devices near this camcorder can result in malfunctions and interference with audio and video signals.
It is recommended that the portable communications devices near this camcorder be powered off.

Note on laser beams
Laser beams may damage the CMOS image sensors.
If you shoot a scene that includes a laser beam, be careful not to let the laser beam be directed into the lens of the camcorder.

Viewfinder
Do not leave the camcorder with the eyepiece pointing directly at the sun.
The eyepiece lens can concentrate the sun’s rays and melt the interior of the viewfinder.
About the LCD panels

The LCD panel fitted to this unit is manufactured with high precision technology, giving a functioning pixel ratio of at least 99.99%. Thus a very small proportion of pixels maybe “stuck”, either always off (black), always on (red, green, or blue), or flashing. In addition, over a long period of use, because of the physical characteristics of the liquid crystal display, such “stuck” pixels may appear spontaneously. These problems are not a malfunction. Note that any such problems have no effect on recorded data.

Phenomena specific to CMOS image sensors

The following phenomena that may appear in images are specific to CMOS (Complementary Metal Oxide Semiconductor) image sensors. They do not indicate malfunctions.

White flecks

Although the CMOS image sensors are produced with high-precision technologies, fine white flecks may be generated on the screen in rare cases, caused by cosmic rays, etc. This is related to the principle of CMOS image sensors and is not a malfunction. The white flecks especially tend to be seen in the following cases:

- when operating at a high environmental temperature
- when you have raised the master gain (sensitivity)
- when operating in Slow-Shutter mode

The problem may be alleviated by executing automatic black balance adjustment.

Aliasing

When fine patterns, stripes, or lines are shot, they may appear jagged or flicker.

Flicker

If recording is made under lighting produced by discharge tubes, such as fluorescent, sodium, or mercury-vapor lamps, the screen may flicker, colors may vary, or horizontal stripes may appear distorted.

In such cases, set the flicker-reduction function to auto mode (2D mode only) (see page 136). If the frame rate selected for recording is close to the power-supply frequency, flicker may not be reduced sufficiently even if you activate the Flicker-Reduction function. In such cases, use the electronic shutter.

Focal plane

Owing to the characteristics of the pickup elements (CMOS image sensors) for reading video signals, subjects that quickly move across the screen may appear slightly skewed.

Flash band

The luminance at the top and bottom of the screen may change when shooting a flashlight beam or a light source that quickly flashes. You can use the supplied application software to correct clips that contain frames with flash bands.

Note on data compatibility with other XDCAM EX-series products

When you use a PMW-EX1/EX3/EX30 to play materials recorded on the camcorder, any media in which clips of formats not supported by the PMW-EX1/EX3/EX30 have been recorded cannot be used.

The PMW-EX1/EX3/EX30 cannot divide a clip recorded on this camcorder, even if the clip is in a video format supported by the PMW-EX1/EX3/EX30.
Fragmentation
If pictures cannot be recorded/reproduced properly, try formatting the recording medium. While repeating picture recording/playback with a certain recording medium for an extended period, files in the medium may be fragmented, disabling proper recording/storage. In such a case, make a backup of clips in the medium then perform formatting of the medium using OPERATION >Format Media (see page 105) in the setup menu.

Exchanging the Battery of the Internal Clock

The camcorder’s internal clock is powered by a lithium battery. If the message “BackUp Battery End” appears in the viewfinder, this battery must be exchanged. Contact a Sony service representative.
Specifications

General

Power requirements
12 V DC (11 V to 17.0 V)

Power consumption
Approx. 32 W
Main unit (camcorder) + LCD viewfinder + microphone
During recording, power source: battery pack

Notes
• Do not use a video light with power consumption of over 50 W.
• When connecting a device to the DC OUT connector, use one with current consumption of 0.5 A or more.

Operating temperature
0 °C to 40 °C (32 °F to 104 °F)

Storage temperature
–20 °C to +60 °C (–4 °F to 140 °F)

Recording/playback formats

Video
HD HQ Mode: MPEG-2 MP@HL, 35 Mbps/ VBR
1920 × 1080/59.94i, 50i, 29.97P, 25P, 23.98P
1440 × 1080/59.94i, 50P, 29.97P, 25P, 23.98P
HD SP Mode: MPEG-2 MP@H-14, 25 Mbps/ CBR
1440 × 1080/59.94i, 50i

Audio
LPCM (16 bits, 48 kHz, 4 channels)

Recording/playback time
With one SBP-16
SP mode: Approx. 70 min.
HQ mode: Approx. 50 min.
With one SBP-32 or SBS-32G1A
SP mode: Approx. 140 min.
HQ mode: Approx. 100 min.
With one SBS-64G1A
SP mode: Approx. 280 min.
HQ mode: Approx. 200 min.

Note
The actual recording/playback time may differ slightly from the values shown here, depending on usage conditions, memory characteristics, etc.

Continuous operation time
With the BP-GL95A
Approx. 170 min.

Mass
5.5 kg (12 lb 2 oz)
Camcorder + LCD viewfinder + microphone + lens hood

Dimensions
See page 172.

Supplied accessories
See page 171.

Camera Block

Pickup device
1/2-type, CMOS image sensor × 2
Effective picture elements: 1920 (H) × 1080 (V)

Format
3-chip RGB

Optical system
F1.6 prism system

ND filters
1: Clear
2: 1/4ND
3: 1/16ND
4: 1/64ND

Sensitivity
F10 (System frequency: 59.94i)
F11 (System frequency: 50i)
(2000 lx, 89.9% reflection)

Minimum illumination
0.133 lx (F2.6, +24 dB, 64-frame accumulation)
### Specifications

**Video S/N**
- 54 dB

**Horizontal resolution**
- 1000 TV lines or more

**Gain**
- –3, 0, 3, 6, 9, 12, 18, 24 dB, AGC

**Shutter speed**
- 59.94i/P, 50i/P: 1/60 to 1/2000 sec.
- 29.97P: 1/40 to 1/2000 sec.
- 23.94P: 1/32 to 1/2000 sec.

**Slow shutter**
- 2 to 8 frames (3D mode)
- 2 to 8, 16, 32, 64 frames (2D mode)

### Audio Block

**Sampling frequency**
- 48 kHz

**Quantization**
- 16 bits

**Headroom**
- 20 dB (the factory default setting)
- (20, 18, 16, 12 dB)

**Frequency response**
- MIC: 50 Hz to 20 kHz (within ±3 dB)
- LINE: 20 Hz to 20 kHz (within ±3 dB)
- WRR Analog: 50 Hz to 20 kHz (within ±3 dB)
- WRR Digital: 20 Hz to 20 kHz (within ±3 dB)

**Dynamic range**
- 90 dB (typical)

**Distortion**
- 0.08% max. (with input level 40 dBu)

**Built-in speaker**
- Monaural
- Output: 300 mW

### Display

**Viewfinder (supplied)**

**Screen size**
- 8.8 cm diagonal (3.5-inch)

**Aspect ratio**
- 16:9

**Picture elements**
- 854 (H) × 3 × 480 (V)

### Media Block

**Card slots**
- Type: Express Card34
- Number of slots: 4
- Connector: Conforms to PCMCIA Express Card Standard

**Writing rate**
- 50 Mbps or more

**Reading rate**
- 50 Mbps or more

### Inputs/Outputs

**Input/Output connectors**

**Signal inputs**
- AUDIO IN CH1/CH2: XLR type, 3-pin, female
  - –60 dBu/–4 dBu (0 dBu=0.775 Vrms)
- MIC IN: XLR type, 5-pin, female
  - –60 dBu
- GENLOCK IN: BNC type
  - 1.0 Vp-p, 75 Ω, unbalanced
- TC IN: BNC type
  - 0.5 V to 18 Vp-p, 10 kΩ

**Signal outputs**
- VIDEO OUT: BNC type
- HDMI: Type A, 19-pin
- HD/SD SDI OUT(L): BNC type, Dual stream output compatible
- HD/SD SDI OUT(R): BNC type
- AUDIO OUT: XLR type, 5-pin, male
  - 0 dBu
- TC OUT: BNC type
  - 1.0 Vp-p, 75 Ω
- EARPHONE (stereo minijack)
  - 8 Ω, –∞ to –18 dBs variable
Specifications

Appendix

Power supply and related equipment

- DC IN: XLR type, 4-pin, male
  11 to 17 V DC
- DC OUT: 4-pin
  11 to 17 V DC, maximum rated current: 0.5 A
- REMOTE: 8-pin
- LIGHT: 2-pin
- USB: 4-pin
- VF: 26-pin, rectangular, 20-pin round
  For wireless receiver: D-sub 15-pin
- REMOTE FOCUS: 6-pin
- REMOTE ZOOM: 8-pin
- REMOTE CONVERGEENCE: 7-pin

Viewfinder and Related Equipment

- Viewfinder (1)
- Viewfinder hood (1)
- Shoulder strap (1)
- Stereo microphone (1)
- Wind screen (1)
- Cold shoe kit (1 set)
- Lens hood (1)
- Lens cap (1)
- Flange back adjustment chart
- Operating Instructions
  - English version (1)

CD-ROM
- Utility Software for XDCAM (application software, device driver software)
- Manuals for Solid-State Memory 3D Camcorder (PDF Operating Instructions and Supplement) (1)

Recommended Additional Equipment

- AC Adaptor
  - AC-DN10/DN2B
- Battery Pack
  - BP-GL95A/L80S/L60S
- Battery Charger
  - BC-L160/L500/L70

Viewfinder and Related Equipment

- Viewfinder
  - CBK-VF01
  - DXF-20W/51/C50W
- Viewfinder Rotation Bracket
  - BKW-401

Note

The BKW-401 can be used with the CBK-VF01 and DXF-20W viewfinders, as well as the supplied viewfinder.

Others

- DC IN: XLR type, 4-pin, male
  11 to 17 V DC
- DC OUT: 4-pin
  11 to 17 V DC, maximum rated current: 0.5 A
- REMOTE: 8-pin
- LIGHT: 2-pin
- USB: 4-pin
- VF: 26-pin, rectangular, 20-pin round
  For wireless receiver: D-sub 15-pin
- REMOTE FOCUS: 6-pin
- REMOTE ZOOM: 8-pin
- REMOTE CONVERGEENCE: 7-pin

Lens Block

Focal length

- 7.5 mm (5/16 inches) to 52.5 mm (2 1/8 inches)
  (equivalent to 40.6 mm (1 5/8 inches) to 284 mm
  (11 1/4 inches) on 35 mm (1 7/16 inches) lens)

Zoom

- Auto/Manual selectable

Zoom ratio

- 7×

Maximum relative aperture

- 1:2.6

Iris

- Auto/Manual selectable
- F2.6 to F16 and C (close)

Focus

- Auto/Manual selectable
- Ranges: 0.9 m (35 1/2 inches) to ∞

Inter-Axial Distance (IAD)

- 45 mm (1 13/16 inches) (fixed)

Convergence distance

- Approx. 1.2 m (4 ft) (lens surface reference) to ∞ (infinity)

Filter thread

- M105 mm, pitch 1 mm

Supplied Accessories

- Viewfinder (1)
- Viewfinder hood (1)
- Shoulder strap (1)
- Stereo microphone (1)
- Wind screen (1)
- Cold shoe kit (1 set)
- Lens hood (1)
- Lens cap (1)
- Flange back adjustment chart
- Operating Instructions
  - English version (1)

CD-ROM
- Utility Software for XDCAM (application software, device driver software)
- Manuals for Solid-State Memory 3D Camcorder (PDF Operating Instructions and Supplement) (1)
Equipment for remote control

Remote Control Unit
RM-B150/B750
RCP-1000/1500/1530
RCP-751/921
RCP-1001/1501

Note
The command network unit (CNU) is not supported.

Wi-Fi Adapter
CBK-WA01

Media
SxS Memory Card
SxS PRO SBP-16 (16 GB)
SxS PRO SBP-32 (32 GB)
SxS-1 SBS-32G1A (32 GB)
SxS-1 SBS-64G1A (64 GB)

Media Adaptor
MEAD-MS01 (for “Memory Stick PRO-HG Duo HX” series)
MEAD-SD01 (for SDHC card)

Mobile Storage Unit
PXU-MS240

Audio equipment
Microphone
ECM-678/674/673/680S

Microphone Holder
CAC-12

Wireless Microphone
DWR-S01D
WRR-855S/860C/861/862

Other peripheral devices
Tripod adaptor
VCT-14/U14

Video Light
UC-D200A (PROTECH)
Ultralight (Anton Bauer)

Pad
CBK-SP01 Soft Type Shoulder Pad

Equipment for maintenance and easier handling
Hard Carrying Case
LC-H300

Soft Carrying Case
LC-DS300SFT

Maintenance Manual

Dimensions

Note
Always make a test recording, and verify that it was recorded successfully.
SONY WILL NOT BE LIABLE FOR DAMAGES OF ANY KIND INCLUDING, BUT NOT LIMITED TO, COMPENSATION OR REIMBURSEMENT ON ACCOUNT OF FAILURE OF THIS UNIT OR ITS RECORDING MEDIA, EXTERNAL STORAGE SYSTEMS OR ANY OTHER MEDIA OR STORAGE SYSTEMS TO RECORD CONTENT OF ANY TYPE.

Always verify that the unit is operating properly before use. SONY WILL NOT BE LIABLE FOR DAMAGES OF ANY KIND INCLUDING, BUT NOT LIMITED TO, COMPENSATION OR REIMBURSEMENT ON ACCOUNT OF THE LOSS OF PRESENT OR PROSPECTIVE PROFITS DUE TO FAILURE OF THIS UNIT, EITHER DURING THE WARRANTY PERIOD OR AFTER EXPIRATION OF THE WARRANTY, OR FOR ANY OTHER REASON WHATSOEVER.
a) The carrying case is large enough to hold the camcorder with microphone mounted. However, remove the microphone if it protrudes more than 25 cm (9 7/8 inches) from the front of the main unit.
ANY USE OF THIS PRODUCT OTHER THAN CONSUMER PERSONAL USE IN ANY MANNER THAT COMPLIES WITH THE MPEG-2 STANDARD FOR ENCODING VIDEO INFORMATION FOR PACKAGED MEDIA IS EXPRESSLY PROHIBITED WITHOUT A LICENSE UNDER APPLICABLE PATENTS IN THE MPEG-2 PATENT PORTFOLIO, WHICH LICENSE IS AVAILABLE FROM MPEG LA, L.L.C., 250 STEELE STREET, SUITE 300, DENVER, COLORADO 80206.

“PACKAGED MEDIA” means any storage media storing MPEG-2 video information such as DVD movie which are sold/distributed to general consumers. Disc replicators or sellers of the PACKAGED MEDIA need to obtain licenses for their own business from MPEG LA. Please contact MPEG LA for any further information. MPEG LA, L.L.C., 250 STEELE STREET, SUITE 300, DENVER, COLORADO 80206 http://www.mpegla.com

This product uses RICOH Bitmap Fonts produced and sold by Ricoh Company, Ltd.
About OpenSSL

Because it uses the OpenSSL Toolkit, this product uses software developed by the OpenSSL Project (http://www.openssl.org/).

OpenSSL License
--------------

/* ====================================================================
 * Copyright (c) 1998-2008 The OpenSSL Project. All rights reserved.
 *
 * Redistribution and use in source and binary forms, with or without
 * modification, are permitted provided that the following conditions
 * are met:
 *
 * 1. Redistributions of source code must retain the above copyright
 *    notice, this list of conditions and the following disclaimer.
 *
 * 2. Redistributions in binary form must reproduce the above copyright
 *    notice, this list of conditions and the following disclaimer in
 *    the documentation and/or other materials provided with the
 *    distribution.
 *
 * 3. All advertising materials mentioning features or use of this
 *    software must display the following acknowledgment:
 *    "This product includes software developed by the OpenSSL Project
 *    for use in the OpenSSL Toolkit. (http://www.openssl.org/)"
 *
 * 4. The names "OpenSSL Toolkit" and "OpenSSL Project" must not be used to
 *    endorse or promote products derived from this software without
 *    prior written permission. For written permission, please contact
 *    openssl-core@openssl.org.
 *
 * 5. Products derived from this software may not be called "OpenSSL"
 *    nor may "OpenSSL" appear in their names without prior written
 *    permission of the OpenSSL Project.
 *
 * 6. Redistributions of any form whatsoever must retain the following
 *    acknowledgment:
 *    "This product includes software developed by the OpenSSL Project
 *    for use in the OpenSSL Toolkit (http://www.openssl.org/)"
 *
 * THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT ``AS IS'' AND ANY
 * EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
 * IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
 * PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE OpenSSL PROJECT OR
 * ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
 * SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT
* NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;
* LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)
* HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT,
* STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
* ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED
* OF THE POSSIBILITY OF SUCH DAMAGE.

*===================================================================
*
* This product includes cryptographic software written by Eric Young
* (eay@cryptsoft.com). This product includes software written by Tim
* Hudson (tjh@cryptsoft.com).
* *
* Original SSLeay License

"---

/* Copyright (C) 1995-1998 Eric Young (eay@cryptsoft.com)
* All rights reserved.
* *
* This package is an SSL implementation written
* by Eric Young (eay@cryptsoft.com).
* The implementation was written so as to conform with Netscapes SSL.
* *
* This library is free for commercial and non-commercial use as long as
* the following conditions are aheared to. The following conditions
* apply to all code found in this distribution, be it the RC4, RSA,
* lhash, DES, etc., code; not just the SSL code. The SSL documentation
* included with this distribution is covered by the same copyright terms
* except that the holder is Tim Hudson (tjh@cryptsoft.com).
* *
* Copyright remains Eric Young’s, and as such any Copyright notices in
* the code are not to be removed.
* If this package is used in a product, Eric Young should be given attribution
* as the author of the parts of the library used.
* This can be in the form of a textual message at program startup or
* in documentation (online or textual) provided with the package.
* *
* Redistribution and use in source and binary forms, with or without
* modification, are permitted provided that the following conditions
* are met:
* 1. Redistributions of source code must retain the copyright
*    notice, this list of conditions and the following disclaimer.
* 2. Redistributions in binary form must reproduce the above copyright
*    notice, this list of conditions and the following disclaimer in the
*    documentation and/or other materials provided with the distribution.
* 3. All advertising materials mentioning features or use of this software
*    must display the following acknowledgement:
*    "This product includes cryptographic software written by
*    Eric Young (eay@cryptsoft.com)"
*    The word 'cryptographic' can be left out if the rouines from the library
*    being used are not cryptographic related :-).
* 4. If you include any Windows specific code (or a derivative thereof) from
*    the apps directory (application code) you must include an acknowledgement:
*    "This product includes software written by Tim Hudson (tjh@cryptsoft.com)"
*    
*    THIS SOFTWARE IS PROVIDED BY ERIC YOUNG ``AS IS'' AND
*    ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
*    IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
*    ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHOR OR CONTRIBUTORS BE LIABLE
*    FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
*    DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS
*    OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)
*    HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT
*    LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY
*    OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF
*    SUCH DAMAGE.
*    
*    The licence and distribution terms for any publically available version or
*    derivative of this code cannot be changed. i.e. this code cannot simply be
*    copied and put under another distribution licence
*    [including the GNU Public Licence.]
Index

Numerics

2D 52
3D 52
3D depth warning 87
3D shooting guide 87

A

AC power 38
ACCESS lamps 26, 29
Accessories (optional) 173
Accessory fitting shoe 19
ALARM knob 24
Application software 154
Area setting 44
Arrow buttons (←, →, ↑, ↓) 28
ASSIGN. 0 switch 24
ASSIGN. 1/2/3 switches 23
ASSIGN. 6 switch 21
ASSIGNABLE 4/5 switches 29
Assignable switches, assigning functions 142
ATW (Auto Tracing White Balance) 25
Audio control section 27
AUDIO IN CH1/CH2 connectors 31
AUDIO IN CH-1/CH-2/CH-3/CH-4 switches 28
AUDIO IN selectors 31
Audio input system 45
Audio level
   adjusting 63
   adjusting playback level 24
   meters 36
AUDIO OUT connector 31
AUDIO SELECT CH-1/CH-2 switches 28
AUTO CONVERGENCE button 21, 62
Auto focus 60
AUTO W/B BAL switch 23

B

BACKLIGHT button 27
Battery
   attachment shoe 18
   of the internal clock, exchanging 168
   pack 37
   remaining 34
BKW-401 41
Black balance, adjusting 53
BRIGHT control 32

C

Clip(s)
   batch copy 96
   copying 96
   cue up 92
   defining names 85
   deleting 77, 97
   displaying properties 95
   operating with a computer 153
   operations 89
   playing 76, 91
   selecting 91
Clock setting 45
Color LCD 26
COLOR TEMP. button 23
Color temperature 34
Computer, connecting 153
Connection 151
   computer 153
   monitors 151
   using USB 153
CONTRAST control 32
CONVERGENCE dial 21, 61
Convergence distance 36
Convergence point 14
Cover 25

D

Date, setting 45
DC IN connector 18
DC OUT 12V connector 18
DCC (Dynamic Contrast Control) 24
Depth of field 35
Diopter adjustment ring 32
DISPLAY switches 27, 33
EARPHONE jack 30
EJECT buttons 29
Electric color temperature filter 36
ESSENCE MARK button 28
EXPAND button 27
EXPAND FOCUS button 20
Expand thumbnail screen
displaying 98
to increase the number of divisions 98
External device connector 29
External devices 151
control 35
External power source 34
Eyecup 32

F
F FWD button/indicator 26
F REV button/indicator 26
Filter position 36
Fitting for optional microphone holder 19
Flange focal length, adjusting 158
Focus
adjusting 60
adjustment mode 35
position 34
FOCUS dial 21, 60
FOCUS switch 22
Frame Rec 80
Framing shots 83
Freeze Mix 83
F-RUN/SET/R-RUN switch 28

G
GAIN selector 24
Gain value 36
GENLOCK IN connector 30
Green tally 34
Grid 88

H
HD/SD SDI OUT connector 31
HDMI output connector 29
Histogram 36
HOLD button 27

I
Index picture
changing 99
Initial value 103
Internal clock 45
Interval Rec 79
Iris
position 36
IRIS dial 21

L
LCD panel 26
LEVEL CH-1/CH-2/CH-3/CH-4 knobs 28
LIGHT connector 19
LIGHT switch 18

M
Maintenance 156
Manual focus 60
Media
remaining capacity 32, 36
status 34
MENU button 28
MENU CANCEL/PRST/ESCAPE switch 25
MENU knob 23
MENU ON/OFF switch 25
MF assist function 61
MIC IN (+48 V) connector 19
MIC LEVEL control 23
Microphone holder 33
fitting 19
Microphone, connecting 45
MIRROR switch 33
MONITOR knob 24
MONITOR switches 24
Monitor, connecting 151
Monochrome LCD Panel 31

N
ND filter 21
ND SELECT switch 21
NEXT button 27
Nonlinear editing 155
Number of system lines 34
OK mark(s) 90, 95
  adding 96
  deleting 96
  setting 77
One-push auto focus 61
Operation status 34
Optional components 173
OUTPUT/DCC switch 24

Parallax 15
PEAKING control 32
Picture Cache 78
Planning metadata 84
PLAY/PAUSE button/indicator 26
Plug 32
Power source voltage/battery remaining capacity 34
Power supply 37
POWER switch 18
Preset values, resetting 148
PRESET/REGEN/CLOCK switch 28
PREV button 26
PUSH AF button 22

REC START button 22
Recording
  from pre-stored video 78
  remaining time 73
  review 75
time-lapse video 79
Recording mode 34
  special settings indication 35
Recording status 35
REMOTE connector 31
REMOTE CONVERGENCE connector 20
REMOTE FOCUS connector 20
REMOTE ZOOM connector 20
Reset 103, 148
RESET/RETURN button 27

Scene files
  loading 149
  saving 149
Search
  with the expand thumbnail screen 92
  with the shot mark thumbnail screen 92
SET button 28
Setup menu 100
  basic operations 101
  FILE menu 140
  MAINTENANCE menu 127
  menu list 104
  OPERATION menu 104
  PAINT menu 122
SHIFT button 21, 28
Shooting 70
  basic operations 75
  stop motion animations 80
  with Slow & Quick motion 82
Shot mark thumbnail screen 98
Shot mark(s)
  adding 99
  adding during playback 92
  defining names 86
  deleting 99
  recording 77
Shoulder pad 19
  adjusting the position 50
Shoulder strap fitting 19
Shoulder strap, using 49
Shutter
  setting 56
  speed 56
SHUTTER selector 22
Slot cover 29
SLOT SELECT button 29
Speaker 26
Specifications 169
Status information 68
STATUS ON/SEL/OFF switch 25
Status screens 68
  ASSIGN SWITCH 68
  AUDIO 68
  BATTERY/MEDIA 69
  CAMERA 68
  VIDEO 68
STOP button 27
Stopper 32
Subject distance range 35
SxS memory card slots 29
SxS memory cards 70
ejecting 72
formatting 73
loading 71
restoring 74
selecting 72

T
TALLY indicators 30
Tally indicators 32
TALLY switch 30, 32
TC IN connector 30
TC OUT connector 30
Testing 156
THUMBNAIL button 27
THUMBNAIL indicator 27
THUMBNAIL menu 93
operations 94
Thumbnail screen 89
displaying OK clip thumbnails only 94
displaying the all clips thumbnail 94
Thumbnail(s)
changing the screen type 94
operations 93
Time, setting 45
Timecode 35
setting 65
synchronizing 66
TLCS automatic adjustment 58
TLCS control mode 35
Tripod mount 19
Tripod, mounting 48

U
UHF portable tuner, attaching 47
USB connection 153
USB connector 29
User bits setting 66
User setting data
loading 148
saving 147

V
VF connector (20-pin, round) 19
VF connector (26-pin, rectangular) 19
VF DISPLAY SELECT switch 21
Video format 35, 95
setting 51
Video level indication 35
Video light, connecting 49
VIDEO OUT connector 30
Viewfinder 32
adjusting focus 41
adjusting position 39
adjusting screen 41
adjusting the angle 39
attaching 38
attaching a 5-inch viewfinder 43
cable 33
changing display 62
cleaning 156
connectors 19
fitting shoe 19
hood 41
positioning knob 19
positioning lever 19
positioning ring 19
raising up the barrel and eyepiece 39
screen display 33
Voltage capacity 34

W
WARNING indicator 26
Warnings 159
WHITE BAL switch 24
White balance memory 36
White balance, adjusting 54
Wi-Fi adapter 29
Wireless microphone reception level 34
Write protect 32, 71

X
XDCAM EX web sites 12

Z
ZEBRA switch 32
Zoom 59
position 34
ZOOM dial 21, 59